
Simulink® Test™

User’s Guide

R2016b



How to Contact MathWorks

Latest news: www.mathworks.com

Sales and services: www.mathworks.com/sales_and_services

User community: www.mathworks.com/matlabcentral

Technical support: www.mathworks.com/support/contact_us

Phone: 508-647-7000

The MathWorks, Inc.
3 Apple Hill Drive
Natick, MA 01760-2098

Simulink® Test™ User's Guide
© COPYRIGHT 2015–2016 by The MathWorks, Inc.
The software described in this document is furnished under a license agreement. The software may be used
or copied only under the terms of the license agreement. No part of this manual may be photocopied or
reproduced in any form without prior written consent from The MathWorks, Inc.
FEDERAL ACQUISITION: This provision applies to all acquisitions of the Program and Documentation
by, for, or through the federal government of the United States. By accepting delivery of the Program
or Documentation, the government hereby agrees that this software or documentation qualifies as
commercial computer software or commercial computer software documentation as such terms are used
or defined in FAR 12.212, DFARS Part 227.72, and DFARS 252.227-7014. Accordingly, the terms and
conditions of this Agreement and only those rights specified in this Agreement, shall pertain to and
govern the use, modification, reproduction, release, performance, display, and disclosure of the Program
and Documentation by the federal government (or other entity acquiring for or through the federal
government) and shall supersede any conflicting contractual terms or conditions. If this License fails
to meet the government's needs or is inconsistent in any respect with federal procurement law, the
government agrees to return the Program and Documentation, unused, to The MathWorks, Inc.

Trademarks

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. See
www.mathworks.com/trademarks for a list of additional trademarks. Other product or brand
names may be trademarks or registered trademarks of their respective holders.
Patents

MathWorks products are protected by one or more U.S. patents. Please see
www.mathworks.com/patents for more information.
Revision History

March 2015 Online only New for Version 1.0 (Release 2015a)
September 2015 Online only Revised for Version 1.1 (Release 2015b)
October 2015 Online only Rereleased for Version 1.0.1 (Release

2015aSP1)
March 2016 Online only Revised for Version 2.0 (Release 2016a)
September 2016 Online only Revised for Version 2.1 (Release 2016b)

https://www.mathworks.com
https://www.mathworks.com/sales_and_services
https://www.mathworks.com/matlabcentral
https://www.mathworks.com/support/contact_us
http://www.mathworks.com/trademarks
http://www.mathworks.com/patents


Contents

Test Strategies
1

Link Tests to Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2
Requirements Traceability Considerations . . . . . . . . . . . . . . 1-2
Establish Requirements Traceability for Testing . . . . . . . . . . 1-3

Test Harness
2

Test Harness and Model Relationship . . . . . . . . . . . . . . . . . . 2-2
Test Harness Description . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Harness — Model Relationship for a Model Component . . . . 2-3
Harness — Model Relationship for a Top-Level Model . . . . . . 2-4
Resolving Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-5

Considerations and Limitations . . . . . . . . . . . . . . . . . . . . . . . 2-6
Test Harness . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-6
Test Sequence Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-6

Select Test Harness Properties . . . . . . . . . . . . . . . . . . . . . . . . 2-8
Create a Test Harness . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8
Considerations for Selecting Test Harness Properties . . . . . . 2-8
Harness Name . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-9
Save Test Harnesses Externally . . . . . . . . . . . . . . . . . . . . . . 2-9
Choosing Sources and Sinks . . . . . . . . . . . . . . . . . . . . . . . . . 2-9
Use Separate Assessment Block . . . . . . . . . . . . . . . . . . . . . . 2-9
Open Harness After Creation . . . . . . . . . . . . . . . . . . . . . . . 2-10
Initial Harness Configuration . . . . . . . . . . . . . . . . . . . . . . . 2-10
Initialize/Terminate/Reset Behavior . . . . . . . . . . . . . . . . . . 2-11
Verification Modes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-11
Change Harness Properties . . . . . . . . . . . . . . . . . . . . . . . . . 2-12

iii



Test Harness Parameters and Signals . . . . . . . . . . . . . . . . . 2-13
Test Harness Generation Without Compilation . . . . . . . . . . 2-13
Signal Conversion Subsystem . . . . . . . . . . . . . . . . . . . . . . . 2-13

Refine, Test, and Debug a Subsystem . . . . . . . . . . . . . . . . . . 2-15
Model and Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-15
Create a Harness for the Controller . . . . . . . . . . . . . . . . . . 2-17
Inspect and Refine the Controller . . . . . . . . . . . . . . . . . . . . 2-19
Add a Test Case and Test the Controller . . . . . . . . . . . . . . . 2-19
Debug the Controller . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-20

Manage Test Harnesses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-23
Internal and External Test Harnesses . . . . . . . . . . . . . . . . 2-23
Manage External Test Harnesses . . . . . . . . . . . . . . . . . . . . 2-23
Convert Between Internal and External Test Harnesses . . . 2-24
Preview and Open a Test Harness . . . . . . . . . . . . . . . . . . . 2-26
Find Test Cases Associated with a Test Harness . . . . . . . . . 2-27
Export Test Harnesses to Separate Models . . . . . . . . . . . . . 2-27
Clone and Export a Test Harness to a Separate Model . . . . 2-28
Delete Test Harnesses Programmatically . . . . . . . . . . . . . . 2-30

Synchronize Changes Between Test Harness and Model . . 2-33
Maintain SIL or PIL Block Fidelity . . . . . . . . . . . . . . . . . . . 2-33
Synchronize Changes to the Component Under Test . . . . . . 2-33
Rebuild Test Harness . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-34
Update Parameters from Test Harness to Model . . . . . . . . . 2-34

Test Library Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-38
Library Testing Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . 2-38
Library and Linked Subsystem Test Harness . . . . . . . . . . . 2-39
Edit Library Block from a Test Harness . . . . . . . . . . . . . . . 2-40

Test Sequences and Assessments
3

Introduction to Test Sequences . . . . . . . . . . . . . . . . . . . . . . . . 3-2
Structure of a Test Sequence . . . . . . . . . . . . . . . . . . . . . . . . 3-2
Test Sequence Hierarchy . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
Step Transitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
Create a Basic Test Sequence . . . . . . . . . . . . . . . . . . . . . . . . 3-3

iv Contents



Organize Test Sequences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8

Test Sequence Action and Transition Operations . . . . . . . . 3-11
Transition Between Steps Using Temporal or Signal

Conditions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-11
Link a Test Assessment to an Active Test Sequence Step . . 3-12
Temporal Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-13
Transition Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-15
Use Messages in Test Sequences . . . . . . . . . . . . . . . . . . . . . 3-16

Generate Function-Based Test Signals . . . . . . . . . . . . . . . . . 3-21
Output Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-22

Assess Simulation Using Logical Statements . . . . . . . . . . . . 3-25
verify . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-25
assert . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-27
Assessment Statements . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-28
Logical Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-29
Relational Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-29

Programmatically Create a Test Sequence . . . . . . . . . . . . . 3-31

Syntax for Test Sequences and Assessments . . . . . . . . . . . . 3-36
Assessment Statements . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-28
Temporal Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-13
Transition Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-15
Output Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-22
Logical Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-29
Relational Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-29

Debug a Test Sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-44
View Test Step Execution During Simulation . . . . . . . . . . . 3-44
Set Breakpoints to Enable Debugging . . . . . . . . . . . . . . . . . 3-44
View Data Values During Simulation . . . . . . . . . . . . . . . . . 3-45
Step Through Simulation . . . . . . . . . . . . . . . . . . . . . . . . . . 3-46

Test a Model Component Using Signal Functions . . . . . . . . 3-47
Create a Test Sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-47
Simulate the Test Harness . . . . . . . . . . . . . . . . . . . . . . . . . 3-48

Test Downshift Points of a Transmission Controller . . . . . 3-50

v



Reuse Test Assessments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-56
Reuse Test Assessments Using a Library . . . . . . . . . . . . . . 3-56

View Graphical Results From Model Verification Library . 3-60

Test Harness Software- and Processor-in-the-Loop
4

SIL Verification for a Subsystem . . . . . . . . . . . . . . . . . . . . . . 4-2
Create a SIL Verification Harness for a Controller . . . . . . . . 4-3
Configure and Simulate a SIL Verification Harness . . . . . . . 4-5
Compare the SIL Block and Model Controller Outputs . . . . . 4-5

Simulink Test Manager Introduction
5

Introduction to the Test Manager . . . . . . . . . . . . . . . . . . . . . . 5-2
Test Manager Description . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-2
Test Creation and Hierarchy . . . . . . . . . . . . . . . . . . . . . . . . . 5-2
Test Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-3
Share Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-3

Test Manager Test Cases
6

Manage Test File Dependencies . . . . . . . . . . . . . . . . . . . . . . . 6-2
Package a Test File Using Simulink Projects . . . . . . . . . . . . 6-2
Find Test File Dependencies and Impact . . . . . . . . . . . . . . . 6-4
Share a Test File with Dependencies . . . . . . . . . . . . . . . . . . 6-8

Test Model Output Against a Baseline . . . . . . . . . . . . . . . . . . 6-9
Create the Test Case . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-9
Run the Test Case and View Results . . . . . . . . . . . . . . . . . 6-10

vi Contents



Test a Simulation for Run-Time Errors . . . . . . . . . . . . . . . . 6-13
Configure the Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-13
Create the Test Case . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-14
Run the Test Case . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-14
View Test Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-15

Generate Test Cases from Model Components . . . . . . . . . . . 6-16
Generate the Test Cases . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-16
Synchronize Test Cases . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-18
Generate Test for a Subsystem . . . . . . . . . . . . . . . . . . . . . . 6-20

Use External Inputs in Test Cases . . . . . . . . . . . . . . . . . . . . 6-24
Use MAT-File for Inputs . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-24
Use Microsoft Excel File for Inputs . . . . . . . . . . . . . . . . . . . 6-24

Automate Tests Programmatically . . . . . . . . . . . . . . . . . . . . 6-27
List of Functions and Classes . . . . . . . . . . . . . . . . . . . . . . . 6-27
Create and Run a Baseline Test Case . . . . . . . . . . . . . . . . . 6-28
Create and Run an Equivalence Test Case . . . . . . . . . . . . . 6-29
Run a Test Case and Collect Coverage . . . . . . . . . . . . . . . . 6-30
Create and Run Test Case Iterations . . . . . . . . . . . . . . . . . 6-31

Run Multiple Combinations of Tests Using Iterations . . . . 6-33
Create Table Iterations . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-33
Create Scripted Iterations . . . . . . . . . . . . . . . . . . . . . . . . . . 6-36
Sweep Through a Set of Parameters . . . . . . . . . . . . . . . . . . 6-39

Collect Coverage in Tests . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-41

Run Tests Using Parallel Execution . . . . . . . . . . . . . . . . . . . 6-47
Use Parallel Execution . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-47
When Will Tests Benefit from Using Parallel Execution? . . . 6-47

How Tolerances Are Applied to Test Criteria . . . . . . . . . . . 6-49
Modify Criteria Tolerances . . . . . . . . . . . . . . . . . . . . . . . . . 6-49

Test Manager Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-50
Simulation Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-50
Callback Scripts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-50
Protected Models . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-50
Parameter Overrides . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-51
Breakpoints . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-51
Highlight in Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-51

vii



Test Sections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-52
Tags . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-53
Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-53
Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-54
System Under Test . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-54
Parameter Overrides . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-55
Callbacks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-56
Inputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-57
Outputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-57
Configuration Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-57
Simulation 1 and Simulation 2 . . . . . . . . . . . . . . . . . . . . . . 6-57
Equivalence Criteria . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-58
Baseline Criteria . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-58
Custom Criteria . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-59
Iterations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-59
Coverage Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-59

Test Models Using Inputs Generated by Simulink Design
Verifier . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-60

Overall Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-60
Test Case Generation Example . . . . . . . . . . . . . . . . . . . . . . 6-60

Apply Custom Criteria to Test Cases . . . . . . . . . . . . . . . . . . 6-63
MATLAB Testing Framework . . . . . . . . . . . . . . . . . . . . . . . 6-63
Define a Custom Criteria Script . . . . . . . . . . . . . . . . . . . . . 6-64
Reuse Custom Criteria and Debug Using Breakpoints . . . . . 6-64
Assess the Damping Ratio of a Flutter Suppression System . 6-67
Custom Criteria Programmatic Interface Example . . . . . . . 6-72

Test Models Using MATLAB Unit Test . . . . . . . . . . . . . . . . . 6-74
Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-74
Basic Workflow Using MATLAB® Unit Test . . . . . . . . . . . . 6-74
Comparison of Test Nomenclature . . . . . . . . . . . . . . . . . . . 6-76
Test a Model for Continuous Integration Systems . . . . . . . . 6-77

Filter Test Execution and Results . . . . . . . . . . . . . . . . . . . . . 6-83
Add Tags . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-83
Filter Tests and Results . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-83
Run Filtered Tests . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-83

viii Contents



Test Manager Results and Reports
7

View Test Case Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-2
View Results Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-2
Visualize Test Case Simulation Output and Criteria . . . . . . . 7-4

Export Test Results and Generate Reports . . . . . . . . . . . . . . 7-9
Export Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-9
Create a Test Results Report . . . . . . . . . . . . . . . . . . . . . . . 7-10
Generate Reports Using Templates . . . . . . . . . . . . . . . . . . . 7-10

Customize Generated Reports . . . . . . . . . . . . . . . . . . . . . . . . 7-14
Inherit the Report Class . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-14
Method Hierarchy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-14
Modify the Class . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-16
Generate a Report Using the Custom Class . . . . . . . . . . . . . 7-18

Results Sections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-20
Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-21
Test Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-21
Iteration Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-22
Errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-22
Logs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-22
Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-22
Parameter Overrides . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-22
Coverage Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-22

Real-Time Testing
8

Test Models in Real Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-2
Overall Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-2
Real-Time Testing Considerations . . . . . . . . . . . . . . . . . . . . . 8-3
Complete Basic Model Testing . . . . . . . . . . . . . . . . . . . . . . . 8-3
Set up the Target Computer . . . . . . . . . . . . . . . . . . . . . . . . . 8-3
Configure the Model or Test Harness . . . . . . . . . . . . . . . . . . 8-4
Add Test Cases for Real-Time Testing . . . . . . . . . . . . . . . . . 8-6
Assess Real-Time Execution Using verify Statements . . . 8-11

ix



Verification and Validation
9

Test Model Against Requirements and Report Results . . . . . 9-2
Requirements Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-2
Test a Cruise Control Safety Requirement . . . . . . . . . . . . . . 9-2

Analyze a Model for Standards Compliance and Design
Errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-6

Standards and Analysis Overview . . . . . . . . . . . . . . . . . . . . . 9-6
Check Model for Style Guideline Violations and Design

Errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-6

Perform Functional Testing and Analyze Test Coverage . . . 9-9
Functional Testing and Coverage Analysis Overview . . . . . . 9-9
Incrementally Increase Test Coverage Using Test Case

Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-9

Analyze Code and Test Software-in-the-Loop . . . . . . . . . . . 9-16
Code Analysis and Testing Software-in-the-Loop Overview . 9-16
Analyze Code for Defects, Metrics, and MISRA C:2012 . . . . 9-16

Module Verification and Testing Processor-in-the-Loop . . 9-25
Module Verification and Testing Processor-in-the-Loop

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-25

Test a Model in Real Time . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-26
Real-Time Testing and Testing Production Models Overview 9-26

x Contents



1

Test Strategies



1 Test Strategies

Link Tests to Requirements

In this section...

“Requirements Traceability Considerations” on page 1-2
“Establish Requirements Traceability for Testing” on page 1-3

Since requirements specify behavior in response to particular conditions, you can develop
test inputs, expected outputs, and assessments from the model requirements.

Requirements Traceability Considerations

Consider the following limitations working with requirements links in test harnesses:

• Some blocks and subsystems are recreated during test harness rebuild operations.
Requirements linking is not supported for these blocks and subsystems in a test
harness:

• Conversion subsystems between the component under test and the sources or
sinks
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• Test Sequence blocks that schedule function calls
• Blocks that drive control input signals to the component under test
• Blocks that drive Goto or From blocks that pass component under test signals
• Data Store Read and Data Store Write blocks

• If you use external requirements storage, performing the following operations
requires re-establishing requirements links to model objects inside test harnesses:

• Cut/paste or copy/paste a subsystem with a test harness
• Clone a test harness
• Move a test harness from a linked block to the library block

Establish Requirements Traceability for Testing

If you have a Simulink® Test™ and a Simulink Verification and Validation™ license,
you can link requirements to test harnesses, test sequences, and test cases. Before
adding links, review “Supported Requirements Document Types” and “Requirements
Traceability” in the Simulink Verification and Validation documentation.

Requirements Traceability for Test Harnesses

When you edit requirements links to the component under test, the links immediately
synchronize between the test harness and the main model. Other changes to the
component under test, such as adding a block, synchronize when you close the test
harness. If you add a block to the component under test, close and reopen the harness to
update the main model before adding a requirement link.

To view items with requirements links, select Analysis > Requirements Traceability
> Highlight Model.

Requirements Traceability for Test Sequences

In test sequences, you can link to test steps. To create a link, first find the model item,
test case, or location in the document you want to link to. Right-click the test step, select
Requirements Traceability, and add a link or open the link editor.

To highlight or unhighlight test steps that have requirements links, toggle the

requirements links highlighting button  in the Test Sequence Editor toolstrip.
Highlighting test steps also highlights the model block diagram.
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Requirements Traceability for Test Cases

If you use many test cases with a single test harness, link to each specific test case to
distinguish which blocks and test steps apply to it. To link test steps or test harness
blocks to test cases,

1 Open the test case in the Test Manager.
2 Highlight the test case in the test browser.
3 Right-click the block or test step, and select Requirements Traceability > Link to

Current Test Case.

Requirements Traceability Example

This example demonstrates adding requirements links to a test harness and test
sequence. The model is a component of an autopilot roll control system. This example
requires Simulink Test and Simulink Verification and Validation.

1 Open the test file, the model, and the harness.

open AutopilotTestFile.mldatx,

open_system RollAutopilotMdlRef,

sltest.harness.open('RollAutopilotMdlRef/Roll Reference',...

'RollReference_Requirement1_3')

2 In the test harness, select Analysis > Requirements Traceability > Highlight
Model.

The test harness highlights the Test Sequence block, component under test, and Test
Assessment block.
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3 Add traceability to the Discrete Derivative block.

a Right-click the Discrete Derivative block and select Requirements
Traceability > Open Link Editor.

b In the Requirements tab, click New.
c Enter the following to establish the link:

• Description: DD link
• Document type: Text file
• Document: RollAutopilotRequirements.txt
• Location: 1.3 Roll Hold Reference

d Click OK. The Discrete Derivative block highlights.
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4 To trace to the requirements document, right-click the Discrete Derivative block, and
select Requirements Traceability > DD Link. The requirements document opens
in the editor and highlights the linked text.

5 Open the Test Sequence block. Add a requirements link that links the
InitializeTest step to the test case.

a In the Test Manager, highlight Requirement 1.3 Test in the test browser.
b Right-click the InitializeTest step in the Test Sequence Editor. Select

Requirements Traceability > Link to Current Test Case.

When the requirements link is added, the Test Sequence Editor highlights the
step.
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Related Examples
• “Organize Test Sequences” on page 3-8
• “Reuse Test Assessments” on page 3-56
• “Requirements-Based Testing for Model Development”
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• “Test Harness and Model Relationship” on page 2-2
• “Considerations and Limitations” on page 2-6
• “Select Test Harness Properties” on page 2-8
• “Test Harness Parameters and Signals” on page 2-13
• “Refine, Test, and Debug a Subsystem” on page 2-15
• “Manage Test Harnesses” on page 2-23
• “Synchronize Changes Between Test Harness and Model” on page 2-33
• “Test Library Blocks” on page 2-38
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Test Harness and Model Relationship

In this section...

“Test Harness Description” on page 2-2
“Harness — Model Relationship for a Model Component” on page 2-3
“Harness — Model Relationship for a Top-Level Model” on page 2-4
“Resolving Parameters” on page 2-5

Test Harness Description

A test harness is a model block diagram that you can use to develop, refine, or debug a
Simulink model or component. In the main model, you associate a harness with a model
component or the top-level model. The test harness contains a separate model workspace
and configuration set, yet it persists with the main model and can be accessed via the
model canvas.

You build the test harness model around the component under test, which links the
harness to the main model. If you edit the component under test in the harness, the main
model updates when you close the harness. You can generate a test harness for:

• A model component, such as a subsystem. The test harness isolates the component,
providing a separate simulation environment from the main model.

• A top-level model. The component under test is a Model block referencing the main
model.
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Harness — Model Relationship for a Model Component

When you associate a test harness with a model component, the harness model
workspace contains copies of parameters associated with the component.

This example shows a test harness for a component that contains a Gain block. The
harness model workspace contains a copy of the parameter g because g defines a part of
the component.

The parameter h is the gain of a gain block in the harness, outside the component under
test (CUT). h exists only in the harness model workspace.
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Harness — Model Relationship for a Top-Level Model

When you associate a harness with the top level of the main model, the harness model
workspace does not contain copies of parameters relevant to the component. The
component under test is a Model block referencing the main model, and parameters
remain in the main model workspace. In this example, the component under test
references the main model, and the variable g exists in the main model workspace. The
variable h is the value of the Gain block in the harness. It exists only in the harness
model workspace.
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Resolving Parameters

Parameters in the test harness resolve to the most local workspace. Parameters resolve
to the harness model workspace, then the system model workspace, then the base
MATLAB® workspace.

More About
• “Componentization Guidelines”

2-5



2 Test Harness

Considerations and Limitations

In this section...

“Test Harness” on page 2-6
“Test Sequence Block” on page 2-6

Consider these behaviors and limitations when working with a test harness or Test
Sequence block.

Test Harness

• You can open only one test harness at a time per main model.
• Models in MDL format do not support test harness creation. Convert MDL models to

SLX format to use test harnesses. Also, SLX models cannot be saved in MDL format.
See “Upgrade Model Files to SLX and Preserve Revision History” in the Simulink
documentation.

• Do not comment out the component under test in the test harness. Commenting out
the component under test can cause unexpected behavior.

• If a subsystem has a test harness, you cannot expand the subsystem. Delete all test
harnesses before expanding the subsystem.

• Test harnesses are not supported for blocks underneath a Stateflow® object.
• Test harnesses do not support asynchronous sample times.
• Upgrade advisor and XML differencing are not supported for test harness models.
• A test harness with a Signal Builder block source does not support:

• Frame-based signals
• Complex signals
• Variable-dimension signals

• For a test harness with a Test Sequence block source, all inputs to the component
under test must operate with the same sample time.

Test Sequence Block

• HDL code generation is not supported for the Test Sequence block.
• The Test Sequence Editor changes the following syntax automatically:
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• Duplicate test step names. For example, if step_1 already exists, and you change
another step name to step_1, the step name you change automatically changes to
step_2.

• Increment and decrement operations to use MATLAB as the action language, such
as a++ and a--. For example, a++ is changed to a=a+1.

• Assignment operations to use MATLAB as the action language, such as a+=expr,
a–=expr, a*=expr, and a/=expr. For example, a+=b is changed to a=a+b.

• Evaluation operations to use MATLAB as the action language, such as a!=expr
and !a. For example, a!=b is changed to a~=b.

• The editor inserts explicit casts for literal constant assignments. For example, if y
is defined as type single, then y=1 is changed to y=single(1).
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Select Test Harness Properties

In this section...

“Create a Test Harness” on page 2-8
“Considerations for Selecting Test Harness Properties” on page 2-8
“Harness Name” on page 2-9
“Save Test Harnesses Externally” on page 2-9
“Choosing Sources and Sinks” on page 2-9
“Use Separate Assessment Block” on page 2-9
“Open Harness After Creation” on page 2-10
“Initial Harness Configuration” on page 2-10
“Initialize/Terminate/Reset Behavior” on page 2-11
“Verification Modes” on page 2-11
“Change Harness Properties” on page 2-12

Create a Test Harness

To create a test harness for the top-level model, select Analysis > Test Harness >
Create for Model. To create a test harness for a subsystem, select the subsystem and
select Analysis > Test Harness > Create for <subsystem name>. Set test harness
properties using the Create Test Harness dialog box.

Considerations for Selecting Test Harness Properties

Before selecting test harness properties, consider the following:

• What data source you want to use for your test case input
• How you want to view or store test output
• Whether you want to copy parameters and workspaces from the main model to the

harness
• Whether you plan to edit the component under test
• How you want to synchronize changes between the test harness and model
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Except for sources and sinks, you can change harness properties later using the harness
properties dialog box. To change sources and sinks after harness creation, manually
remove the blocks from the test harness and replace them with new sources and sinks.

Harness Name

Test harnesses must use valid MATLAB filenames.

Save Test Harnesses Externally

This option controls how the model stores test harnesses. A model stores all its test
harnesses either internally or externally. If a model already has test harnesses, this item
states the harness storage type as Harnesses saved <internally|externally>.

• When cleared, the model saves test harnesses as part of the model SLX file.
• When selected, the model saves test harnesses in separate SLX files to the current

working folder, and adds a harness information XML file to the model folder. The
harness information file must remain in the same folder as the model.

See “Manage Test Harnesses” on page 2-23.

Choosing Sources and Sinks

In the Create Test Harness dialog box, under Sources and Sinks, select the source and
sink from the respective menus. The menus provide common sources and sinks, and you
can also use custom sources and sinks from the Simulink Sources or Sinks library. Select
Custom source or sink, and enter the path to the custom block, such as:

simulink/Sources/Sine Wave

simulink/Sinks/Terminator

Custom sources and sinks build the test harness with one block per port.

Use Separate Assessment Block

Select Add separate assessment block to include a separate Test Assessment block in
the test harness.

A Test Assessment block is a separate Test Sequence block configured with properties
commonly used for verifying the component under test. If you use a Test Sequence block
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source, you can also author assessments directly in the Test Sequence block. See “Reuse
Test Assessments” on page 3-56.

Open Harness After Creation

Clear Open Harness After Creation to create the test harness without subsequently
opening it. This can be useful if you need to create a number of test harnesses in
succession.

Initial Harness Configuration

You can select a preconfigured set of test harness properties for common tasks.

• Prototyping: Choose this configuration if your model is early in development. You
can edit the component under test in the test harness, and control when the harness
is rebuilt from the main model. You can use this configuration if your main model
does not compile.

• Refinement/Debugging: Choose this configuration if you want the test harness to
include the configuration set, conversion subsystems, and model parameters for the
component under test. This configuration can be useful for a nearly complete model,
when you expect limited changes to the design.

• Verification: Choose this configuration if you require tight synchronization
between the main model and the test harness, which is common for model
verification. The test harness prevents you from editing the component under
test, and the test harness rebuilds every time you open it. In addition to a normal
subsystem, you can choose a SIL or PIL block as the component under test (requires
Embedded Coder®). See “Verification Modes” on page 2-11.

You can also select a custom combination of harness properties. When you select Custom,
these options become available:

Property Description Additional Information

Create without
compiling the
model

When you select this property,
the main model does not compile
when generating the test harness.
The test harness does not contain
conversion subsystems, configuration
parameters, or model workspace data
for the component under test.

The test harness can
require additional
modification for it to
compile, such as adding
signal conversion blocks.
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Property Description Additional Information

Rebuild harness on
open

When you select this property, the
test harness rebuilds every time you
open it.

For details on the rebuild
process, see “Synchronize
Changes Between Test
Harness and Model” on
page 2-33.

Update
Configuration
Parameters and
Model Workspace
data on rebuild

When you select this property,
configuration parameters and model
workspace data update when you
rebuild the harness.

For details on the rebuild
process, see “Synchronize
Changes Between Test
Harness and Model” on
page 2-33.

Enable component
editing in harness
model

When you select this property, you
can edit the component under test in
the test harness.

 

Initialize/Terminate/Reset Behavior

Generate scheduler for Initialize, Reset, and Terminate tasks

Testing a model with initialize, terminate, or reset behavior can require calling Initialize,
Terminate, or Reset subsystems to set the desired state. You can use the Test Sequence
block to schedule function calls using the send() command and function-call outputs.

You can automatically create a Test Sequence block configured to schedule function
calls to Initialize, Terminate, or Reset inputs. When you create a test harness, select
Generate scheduler for Initialize, Reset, and Terminate tasks in the Advanced
Properties tab of the create harness dialog box. After test harness creation, the Test
Sequence block contains template function calls for use in your test sequence.

Verification Modes

The test harness verification mode determines the type of block generated in the test
harness.

• Normal: A Simulink block diagram.
• Software-in-the-Loop (SIL): The component under test references generated code,

operating as software-in-the-loop. Requires Embedded Coder.
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• Processor-in-the-Loop (PIL): The component under test references generated code
for a specific processor instruction set, operating as processor-in-the-loop. Requires
Embedded Coder.

Note: Keep the SIL or PIL code in the test harness synchronized with the latest
component design. If you select SIL or PIL verification mode without selecting Rebuild
harness on open, your SIL or PIL block code might not reflect recent updates to the
main model design. Regenerate code for the SIL or PIL block in the test harness by
selecting Analysis > Test Harness > Rebuild Harness from Main Model.

Change Harness Properties

Click the badge  in the test harness block diagram and click Test harness
properties... to open the harness properties dialog box.

See Also
Test Sequence | “Synchronize Changes Between Test Harness and Model” on page
2-33
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Test Harness Parameters and Signals

In this section...

“Test Harness Generation Without Compilation” on page 2-13
“Signal Conversion Subsystem” on page 2-13

Test Harness Generation Without Compilation

You can generate a test harness without compiling the main model. For example, this
option can be useful if you are prototyping a design that cannot yet compile. If the main
model is not compiled when generating a test harness:

• Parameters are not copied to the test harness workspace.
• The main model configuration is not copied to the test harness.
• The test harness does not contain conversion subsystems.

To execute these processes, you can rebuild the harness when you are ready to compile
the main model. For more information, see “Synchronize Changes Between Test Harness
and Model” on page 2-33.

Signal Conversion Subsystem

A signal conversion subsystem
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• Contains signal specification blocks to check signal properties to and from the
component under test. These properties include data type, sample time, bus
properties, dimension, and complexity.

• Contains blocks that simplify signal routing in the test harness block diagram, such
as Goto and Function-Call Split blocks.

Signal types must match the signal specification for test harnesses to compile. If you get
a compile error related to the signal conversion subsystem, check the signal properties
and consider modifying the test harness design. For example:

• Add conversion blocks to your test harness outside the conversion subsystem.
• Edit the conversion subsystem. The subsystem is locked by default. To unlock

it, right-click the subsystem, select Block Parameters, then set Read/Write
permissions to ReadWrite.

Note: When you rebuild the test harness, the signal conversion subsystems are
rebuilt. If you modify a conversion subsystem, disable automatic test harness rebuild
to avoid losing your modifications when you open the test harness. See “Select Test
Harness Properties” on page 2-8.
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Refine, Test, and Debug a Subsystem

In this section...

“Model and Requirements” on page 2-15
“Create a Harness for the Controller” on page 2-17
“Inspect and Refine the Controller” on page 2-19
“Add a Test Case and Test the Controller” on page 2-19
“Debug the Controller” on page 2-20

Test harnesses provide a development and testing environment that leaves the main
model design intact. You can test a functional unit of your model in isolation without
altering the main model. This example demonstrates refining and testing a controller
subsystem using a test harness. The main model is a controller-plant model of an air
conditioning/heat pump unit. The controller must operate according to several simple
requirements.

Model and Requirements

1 Access the model. Enter

cd(fullfile(docroot,'toolbox','sltest','examples'))

2 Copy this model file and supporting files to a writable location on the MATLAB path:

sltestHeatpumpExample.slx

sltestHeatpumpBusPostLoadFcn.mat

PumpDirection.m

3 Open the model.

open_system('sltestHeatpumpExample')
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In the example model:

• The controller accepts the room temperature and the set temperature inputs.
• The controller output is a bus with signals controlling the fan, heat pump, and the

direction of the heat pump (heat or cool).
• The plant accepts the control bus. The heat pump and the fan signals are Boolean,

and the heat pump direction is specified by +1 for cooling and -1 for heating.

The test covers four temperature conditions. Each condition corresponds to one operating
state with fan, pump, and pump direction signal outputs.
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Temperature condition System state Fan
command

Pump
command

Pump
direction

|Troom - Tset| < DeltaT_fan idle 0 0 0
DeltaT_fan <= |Troom

- Tset| < DeltaT_pump

fan only 1 0 0

|Troom - Tset| >=

DeltaT_pump and Tset < Troom

cooling 1 1 -1

|Troom - Tset| >=

DeltaT_pump and Tset > Troom

heating 1 1 1

Create a Harness for the Controller

1 Right-click the Controller subsystem and select Test Harness > Create for
‘Controller’.

2 Set the harness properties:

In the Basic Properties tab:

• Name: devel_harness_1
• Sources and Sinks: None and Scope
• Clear Add separate assessment block
• Select Open harness after creation.

In the Advanced Properties tab:

• Initial harness configuration: Refinement/Debugging
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3 Click OK to create the test harness.

2-18



 Refine, Test, and Debug a Subsystem

Inspect and Refine the Controller

1 In the test harness, double-click Controller to open the subsystem.

2 Connect the chart to the inports.

3 In the test harness, click save to save the test harness and model.

Add a Test Case and Test the Controller

1 Navigate to the top level of devel_harness_1.
2 Create a test input for the harness with a constant Tset and a time-varying Troom.

Connect a Constant block to the Tset input and set the value to 75.
3 Add a Sine Wave block to the harness model to simulate a temperature signal.

Connect the Sine Wave block to the conversion subsystem input Troom_in.
4 Double-click the Sine Wave block and set the parameters:

• Amplitude: 15
• Bias: 75
• Frequency: 2*pi/3600
• Phase (rad): 0
• Sample time: 1
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• Select Interpret vector parameters as 1–D.
5 Connect Inport blocks to the Data Store Write inputs.

6 In the Configuration Parameters dialog box, in the Data Import/Export pane,
select Input and enter u. u is an existing structure in the MATLAB base workspace.

7 In the Solver pane, set Stop time to 3600.
8 Open the three scopes in the harness model.
9 Simulate the harness.

Debug the Controller

1 Observe the controller output. fan_cmd is 1 during the IDLE condition where |
Troom - Tset| < DeltaT_fan.

This is a bug. fan_cmd should equal 0 at IDLE. The fan_cmd control output must be
changed for IDLE.
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2 In the harness model, open the Controller subsystem.
3 Open controller_chart.
4 In the IDLE state, fan_cmd is set to return 1. Change fan_cmd to return 0. IDLE is

now:

IDLE

entry:

fan_cmd = 0;

 pump_cmd = 0;

 pump_dir = 0;

5 Simulate the harness model again and observe the outputs.

6 fan_cmd now meets the requirement to equal 0 at IDLE.
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Related Examples
• “Test a Model Component Using Signal Functions” on page 3-47
• “Test Downshift Points of a Transmission Controller” on page 3-50
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Manage Test Harnesses

In this section...

“Internal and External Test Harnesses” on page 2-23
“Manage External Test Harnesses” on page 2-23
“Convert Between Internal and External Test Harnesses” on page 2-24
“Preview and Open a Test Harness” on page 2-26
“Find Test Cases Associated with a Test Harness” on page 2-27
“Export Test Harnesses to Separate Models” on page 2-27
“Clone and Export a Test Harness to a Separate Model” on page 2-28
“Delete Test Harnesses Programmatically” on page 2-30

Internal and External Test Harnesses

You can save test harnesses internally as part of your model SLX file, or externally in
separate SLX files. A model stores all test harnesses either internally or externally; it
is not possible to use both types of harness storage in one model. You select internal
or external test harness storage when you create the first test harness. If your model
already has test harnesses, you can convert between the harness storage types.

If you store your model in a change control system, consider using external test
harnesses. External test harnesses enable you to create or change a harness without
changing the model file. If you plan to share your model often, consider using internal
test harnesses to simplify file management. Creating or changing an internal test
harness changes your model SLX file. Both internal and external test harnesses offer the
same synchronization, push, rebuild, and badge interface functionality.

See “Select Test Harness Properties” on page 2-8.

Manage External Test Harnesses

Harnesses stored externally use a separate SLX file for each harness, and a
<modelName>_harnessInfo.xml file containing metadata linking the model and the
harnesses. Changing test harnesses can change the harnessInfo.xml file.

Follow these guidelines for external test harnesses:
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Warning Do not delete the harnessInfo.xml file. Deleting the harnessInfo.xml
file terminates the relationship between the model and harnesses, which cannot be
regenerated from the model.

• Keep the harnessInfo.xml file in the same folder as the main model. If the
harnessInfo.xml file and the model are in separate folders, the main model opens
but does not present the test harnesses.

• Directories containing test harness SLX files must be on the MATLAB path.
• If you convert internal test harnesses to external test harnesses, the new SLX files

save to the current working folder.
• If you convert external test harnesses to internal test harnesses, the external SLX

files can be anywhere on the MATLAB path.
• If your model uses external test harnesses, only create a copy of your model using

File > Save As from the model menu. Using File > Save As copies external
test harnesses to the destination folder of the new model and keeps the harness
information current.

Copying the model file on disk will not copy external harnesses associated with the
model.

• Only change or delete test harnesses using the Simulink UI or commands:

• To delete test harnesses, use the thumbnail UI or the sltest.harness.delete
command.

• To rename test harnesses, use the harness properties UI or the
sltest.harness.set command.

• To make a copy of an externally saved test harness, use the
sltest.harness.clone command or save the test harness to a new name using
File > Save As.

Deleting or renaming harness files outside of Simulink causes an inaccurate
harnessInfo.xml file and problems loading test harnesses.

Convert Between Internal and External Test Harnesses

You can change how your model stores test harnesses at different phases of your model
lifecycle. For example:
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• Develop your model using internal test harnesses so that you can more easily share
the model for review. When you complete your design and place the model under
change control, convert to external harnesses.

• Use the change-controlled model as the starting point for a new design. Test the
existing model with external harnesses to avoid modifying it. Then, create a copy of
the existing model. Convert to internal harnesses for the new development phase.

To change the test harness storage to external (or internal):

1 Navigate to the top of the main model.
2 Select Analysis > Test Harness > Convert To External (Internal) Harnesses.
3 A dialog box provides information on the conversion procedure and the affected test

harnesses. Click Yes to continue.

The harnesses are converted.
4 The conversion to external test harnesses creates an SLX file for each test harness

and a harness information XML file <modelName>_harnessInfo.xml.

Inversely, conversion to internal test harnesses moves the test harness SLX files and
the harnessInfo.xml file.
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Preview and Open a Test Harness

When a model component has a test harness, a badge appears in the lower right of the
block. Click the badge to preview test harnesses, and click a thumbnail image to open the
harness.

When a model block diagram has a test harness, click the pullout icon in the model
canvas to preview the test harnesses. To open the harness, click a thumbnail.
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Find Test Cases Associated with a Test Harness

To list open test cases that refer to the test harness, click the badge  in the test
harness canvas. You can click a test case name and navigate to the test case in the Test
Manager.

Export Test Harnesses to Separate Models

You can export test harnesses to separate models, which is useful for archiving test
harnesses or sharing a test harness design without sharing the model.

• To export an individual test harness:
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1 From the test harness menu, select Analysis > Test Harness > Detach and
Export Harness.

2 A dialog box confirms the harness export. Click OK.
3 Enter a file name for the separate model.

The harness converts to a separate model. Converting removes the harness from
the main model and breaks the relationship to the main model.

• To export all harnesses in a model:

1 Navigate to the top level of the test harness.
2 Select no blocks.
3 From the model menu, select Analysis > Test Harness > Detach and Export

Harnesses.
4 A dialog box confirms the harness export. Click OK.

The harnesses convert to separate models. Converting removes the harnesses
from the main model and breaks the relationships to the main model.

See sltest.harness.export.

Clone and Export a Test Harness to a Separate Model

This example demonstrates cloning an existing test harness and exporting the cloned
harness to a separate model. This can be useful if you want to create a copy of a test
harness as a separate model, but leave the test harness associated with the model
component.

High-level Workflow

1 If you don't know the exact properties of the test harness you want to clone, get them
using sltest.harness.find. You need the harness owner ID and the harness name.

2 Clone the test harness using sltest.harness.clone.
3 Export the test harness to a separate model using sltest.harness.export. Note that

there is no association between the exported model and the original model. The
exported model stands alone.

Open the Model and Save a Local Copy

model = 'sltestTestSequenceExample';
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open_system(model)

Save the local copy in a writable location on the MATLAB path.

Get the Properties of the Source Test Harness

properties = sltest.harness.find([model '/shift_controller'])

properties = 

  struct with fields:

               model: 'sltestTestSequenceExample'

                name: 'controller_harness'

         description: ''

                type: 'Testing'

         ownerHandle: 13.0013

       ownerFullPath: 'sltestTestSequenceExample/shift_controller'

           ownerType: 'Simulink.SubSystem'

              isOpen: 0

         canBeOpened: 1

            lockMode: 0

    verificationMode: 0
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      saveExternally: 0

       rebuildOnOpen: 0

    rebuildModelData: 0

           graphical: 0

             origSrc: 'Test Sequence'

            origSink: 'Test Assessment'

Clone the Test Harness

Clone the test harness using sltest.harness.clone, the ownerFullPath and the name
fields of the harness properties structure.

sltest.harness.clone(properties.ownerFullPath,properties.name,'ControllerHarness2')

Save the Model

Before exporting the harness, save changes to the model.

save_system(model)

Export the Test Harness to a Separate Model

Export the test harness using sltest.harness.export. The exported model name is
ControllerTestModel.

sltest.harness.export([model '/shift_controller'],'ControllerHarness2',...

    'Name','ControllerTestModel')

clear('model')

clear('properties')

close_system('sltestTestSequenceExample',0)

Delete Test Harnesses Programmatically

This example shows how to delete test harnesses programmatically. Deleting with % the
programmatic interface can be useful when your model has multiple test harnesses at
different hierarchy levels. This example demonstrates creating four test harnesses, then
deleting them.

1. Open the model

open_system('sltestCar');
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2. Create two harnesses for the transmission subsystem, and two harnesses for the
transmission ratio subsystem.

sltest.harness.create('sltestCar/transmission');

sltest.harness.create('sltestCar/transmission');

sltest.harness.create('sltestCar/transmission/transmission ratio');

sltest.harness.create('sltestCar/transmission/transmission ratio');

3. Find the harnesses in the model.

test_harness_list = sltest.harness.find('sltestCar')

test_harness_list = 

  1×4 struct array with fields:

    model

    name

    description

    type

    ownerHandle

    ownerFullPath

    ownerType
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    isOpen

    canBeOpened

    lockMode

    verificationMode

    saveExternally

    rebuildOnOpen

    rebuildModelData

    graphical

    origSrc

    origSink

4. Delete the harnesses.

for k = 1:length(test_harness_list)

     sltest.harness.delete(test_harness_list(k).ownerFullPath,...

     test_harness_list(k).name)

end

close_system('sltestCar',0);

See Also

Functions
sltest.harness.clone | sltest.harness.create | sltest.harness.delete
| sltest.harness.export | sltest.harness.find | sltest.harness.load |
sltest.harness.open
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Synchronize Changes Between Test Harness and Model

In this section...

“Maintain SIL or PIL Block Fidelity” on page 2-33
“Synchronize Changes to the Component Under Test” on page 2-33
“Rebuild Test Harness” on page 2-34
“Update Parameters from Test Harness to Model” on page 2-34

A test harness lets you synchronize changes between the test harness and the main
model. You can transfer a configuration set and model workspace variables, update the
component design, and rebuild the harness to reflect the latest model design. These
abilities provide an advantage over isolating a model component in a separate Simulink
model.

Maintain SIL or PIL Block Fidelity

If you use a software-in-the-loop (SIL) or processor-in-the-loop (PIL) block in the test
harness, regularly rebuild your test harness so that the generated code referenced by
the SIL/PIL block reflects the current main model. You can set a test harness to rebuild
every time it opens. Open the test harness properties dialog box by clicking the test

harness badge  in the harness model and select Rebuild harness on open.

To minimize compilation, you can manually rebuild the test harness if you have a large
or complex main model. You can check the SIL/PIL block equivalence to determine
whether to rebuild the harness. In the harness model, from the menu bar, select
Analysis > Test Harness > Compare Checksums, which compares the checksum
of the component in the model to the checksum archived during the SIL/PIL block
generation. If the result is different, rebuild the harness by clicking Analysis > Test
Harness > Rebuild Harness from Main Model.

For information about running multiple simulations with unchanged generated code, see
“Prevent Code Changes in Multiple Simulations”.

Synchronize Changes to the Component Under Test

The component in the harness or the main model updates to the latest design when you
open or close a test harness:
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• Design changes from model to harness — The component under test updates when
you open the harness.

• Design changes from harness to model — The component in the model updates when
you close the harness.

Note: If you create a test harness in SIL or PIL mode for a Model block, the block mode
in the test harness is changed to SIL or PIL, respectively. This mode is not updated to
the main model when you close the test harness.

Rebuild Test Harness

You can rebuild a test harness to reflect the latest state of the main model. In the test
harness, select Analysis > Test Harness > Rebuild Harness from Main Model. This
operation rebuilds conversion subsystems in the test harness. If the test harness does not
have conversion subsystems, this process adds them.

Depending on your test harness settings, harness rebuild can also copy parameters and
the active model configuration set. For example, suppose that you update the component
design to use a new parameter. When you rebuild the harness, the harness model
workspace receives a copy of the parameter.

To copy parameters and the model configuration set, when you create or modify the
properties of a test harness, select Update Configuration Parameters and Model
Workspace data on rebuild.

Rebuilding can disconnect signal lines. For example, if signal names changed in the main
model, signal lines in the test harness can be disconnected. If lines are disconnected,
reconnect signal lines to the component under test or conversion subsystems.

Also see “Select Test Harness Properties” on page 2-8 and sltest.harness.rebuild.

Update Parameters from Test Harness to Model

When working in the test harness, you can add a workspace item to the harness model
workspace or change the test harness configuration set. To update the configuration
set and workspace in the main model, select Analysis > Test Harness > Push
Parameters to Main Model. This operation:

• Copies the active configuration set from the harness model to the main model, and
makes it the active configuration set in the main model.
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• Copies workspace contents to the main model, if the contents are relevant to the
component under test.

This example shows how to push a new workspace variable to the main model.

1 Access the model. Enter

cd(fullfile(docroot,'toolbox','sltest','examples'))

2 Copy this model file and supporting files to a writable location on the MATLAB path:

sltestHeatpumpExample.slx

sltestHeatpumpBusPostLoadFcn.mat

PumpDirection.m

3 Open the model.

open_system('sltestHeatpumpExample')

4 Right-click the Controller subsystem and select Test Harness > Create Test
Harness.

5 In the Create Test Harness dialog box, click OK to create a test harness with default
properties. The test harness model opens.

6 In the test harness model, select Tools > Model Explorer to open the Model
Explorer. Expand the items under the test harness name and select Model
Workspace.

7 Select  Add > MATLAB Variable. Set the variable name to H and the value to 1.
8 In the top level of the test harness, double-click Controller to open the subsystem.

Add a Gain block and set the value to H. Connect it as shown.
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9 Select Analysis > Test Harness > Push Parameters to Main Model.
10 In the Model Explorer, expand the main model and select Model Workspace. H

appears as a variable in the workspace.
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Related Examples
• “SIL Verification for a Subsystem” on page 4-2
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Test Library Blocks

In this section...

“Library Testing Workflow” on page 2-38
“Library and Linked Subsystem Test Harness” on page 2-39
“Edit Library Block from a Test Harness” on page 2-40

You can use a library subsystem to help facilitate component reuse. Design and test
workflows can require testing of a reusable component source and each instance of the
component. For libraries, you can set up tests for the library subsystem during your
design. Once the library subsystem meets your requirements, you can create linked
blocks in larger models and test the subsystem instances.

Library Testing Workflow

Library testing broadly divides between testing the source library subsystem, and testing
each instance of the library subsystem. Testing the library subsystem checks the design
in isolation, while testing each instance checks the component in the context of the larger
system. Test harnesses can move from the source to the instance and the instance to the
source.

This procedure outlines an example workflow for testing library subsystems and linked
subsystems.

1 Create a test case and a test harness for the library subsystem. Use this test case to
perform requirements-based tests.

2 Test the library subsystem. If it fails your requirements, edit the model and run the
test case again.

3 Lock the library after the subsystem meets the requirements.
4 In your model, create a linked subsystem and retain the library test harnesses.
5 Compare the output of the linked instance to that of the library block using an

equivalence test case.
6 Create additional test cases and test harnesses for the linked instance.
7 Promote a test harness from the linked subsystem to the library if you want to

include the test harness with future linked subsystems.
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Library and Linked Subsystem Test Harness

A test harness for a library subsystem has specific properties, compared to test harnesses
for a subsystem in a model.

• Libraries do not compile, so a test harness for a library subsystem does not contain
compiled attributes.

• A test harness for a library subsystem does not generate conversion subsystems for
the block inputs and outputs.

• A library subsystem test harness does not use push or rebuild operations, because
libraries do not use configuration parameters.

When you create a linked subsystem from a library subsystem, test harnesses copy to
the linked instance. If you do not need the test harnesses, you can delete them. For
instructions on deleting all test harnesses from a model, see “Manage Test Harnesses” on
page 2-23.

When you create a test harness for a linked subsystem, the harness associates with the
linked subsystem, not the library subsystem. You can move a test harness from a linked
subsystem to the library subsystem. This linked subsystem has three test harnesses. To
move the Requirements_Tests1 test harness,

1 On the linked subsystem, click the harness badge.
2 Click the Harness Operations  icon on the test harness you want to promote.
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3 Select Move to Library.
4 A dialog box informs you that moving the harness removes it from the linked

subsystem.
5 After confirmation, the harness appears on the library subsystem.

Edit Library Block from a Test Harness

You can apply an iterative design and test workflow to libraries by testing a library block
in a test harness and updating the component under test. Changes to the component
under test synchronize to the library when you close the test harness.

If you have a library block whose design is complete, set your test harnesses to prevent
changes to the component under test. You can set this property when you create the test
harness or after harness creation. See “Select Test Harness Properties” on page 2-8.

Related Examples
• “Testing a Library and a Linked Block”
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• “Introduction to Test Sequences” on page 3-2
• “Organize Test Sequences” on page 3-8
• “Test Sequence Action and Transition Operations” on page 3-11
• “Generate Function-Based Test Signals” on page 3-21
• “Assess Simulation Using Logical Statements” on page 3-25
• “Programmatically Create a Test Sequence” on page 3-31
• “Syntax for Test Sequences and Assessments” on page 3-36
• “Debug a Test Sequence” on page 3-44
• “Test a Model Component Using Signal Functions” on page 3-47
• “Test Downshift Points of a Transmission Controller” on page 3-50
• “Reuse Test Assessments” on page 3-56
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Introduction to Test Sequences
In this section...

“Structure of a Test Sequence” on page 3-2
“Test Sequence Hierarchy” on page 3-2
“Step Transitions” on page 3-2
“Create a Basic Test Sequence” on page 3-3

You can use the Test Sequence block to specify test steps, actions, and transitions. With
timeseries inputs, you supply time-defined test vectors. However, the test sequences
you create can react to signal and temporal conditions. You can also use them to assess
simulation.

Structure of a Test Sequence

A test sequence consists of test steps arranged in a hierarchy. You can use transitions to
define the test sequence progression within a hierarchy level.

A test step contains actions and transitions you define using MATLAB as the action
language. Actions execute at the beginning of the step. You use actions to define
commands for each test step, such as setting signal levels, verifying logical conditions, or
setting variables. You use test step transitions to define conditions that determine when
the test sequence exits the current step and enters another step.

A standard transition occurs on a condition that you specify. Once the step exits, the next
step that you specify executes.

Test Sequence Hierarchy

Arrange the test sequence hierarchy using parent steps and substeps. Substeps can
activate only if the parent step is active. A group of steps in the same hierarchy level
shares a common transition type. When you create a test step, the step becomes a
transition option for other steps in the same group.

Step Transitions

In a test sequence, the top hierarchy level uses a standard transition. Test sequence
execution begins with the top step in the group, and proceeds according to the transition
conditions and next steps.
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You can change lower-level groups to switch between steps based on signal conditions
defined in the step. This switching condition is called a When decomposition. In this
case, the parent step evaluates, and then the substeps execute based on their associated
conditions. The conditions determine the order in which the substeps execute. For
example, the first substep in the table does not necessarily execute first. If multiple steps
in a When decomposition group have conditions that are true, the highest step with the
true condition is active.

Create a Basic Test Sequence

In this example, you create a simple test sequence for a transmission shift logic
controller.

1 Open the model. At the command line, enter

sltestTestSequenceExample

2 Right-click the shift_controller subsystem and select Test Harness > Create
for ‘shift_controller’.

3 In the Create Test Harness dialog box, under Sources and Sinks, change Inport
to Test Sequence.

The schematic displays the closed-loop configuration between the Test Sequence
block and the component under test.
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4 Click OK. The test harness for the shift_controller subsystem opens. Double-
click the Test Sequence block.

The Test Sequence Editor opens and displays action and transition tips. Click the X
to close the tips. The first line in a Step cell defines the step name.

5 Create the test sequence.

a Rename the first step Accelerate and add the step actions:

speed = 10*ramp(et);

throttle = 100;

b Rename the second step Stop and add the step actions:
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throttle = 0;

speed = 0;

c Right-click Accelerate and select Add sub-step. Create a total of four
substeps for Accelerate.

These steps check the component under test during the test sequence.
d Add a constant to the block. In the Symbols pane, hover over Constant and

click Add. Enter Limit for the constant name.
e Hover over Limit and click Edit. In the Initial value field, enter 2. Click OK.
f In the Transition column, enter the transition condition for Accelerate. This

condition uses the duration operator and transitions to the next step when the
system is in fourth gear for 2 seconds.

duration(gear == 4) >= Limit

In the Next Step column, select Stop.
g Change the Accelerate group to a When decomposition sequence. Right-click

Accelerate and select When decomposition.
h Enter the names and actions for the substeps.

Check1st when gear == 1

verify(speed < 45)

Check2nd when gear == 2

verify(speed < 75)

Check3rd when gear == 3

verify(speed < 105)

Else

The fourth step Else takes no action. Else handles conditions that make no
other when statement valid.
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6 Add a scope to the harness and connect the speed, throttle, and gear signals to
the scope.

7 Set the model simulation time to 15 seconds and simulate the test harness.
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See Also
Test Sequence

Related Examples
• “Syntax for Test Sequences and Assessments” on page 3-36
• “Programmatically Create a Test Sequence” on page 3-31
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Organize Test Sequences

Compared to using timeseries data, using the Test Sequence block to define your test
inputs has these advantages:

• You can organize test scenarios in test step groups, and use hierarchy levels to isolate
test scenario execution.

• You can isolate model functionality by separating signal commands into distinct test
steps.

• Steps can execute in response to the model, using logical conditions.
• You can author assessments for specific test conditions.
• You can concisely express signal patterns, such as waveforms, using output

commands.

Before creating test steps, consider the test sequence organization. Clear organization
helps communicate the test sequence intent and structure.

Consider the case of verifying a simple subsystem. The subsystem consists of a switch
controlled by the Engage signal.

The goal of the test is to complete a simple verification of the switch function. The test
does not cover all objectives for full verification, but covers a simple design check. Check
that the output equals Input 1 when the control is engaged, and Input 2 when the
control is not engaged. You organize a test sequence into an initialization step and
two test scenarios. Each scenario sets Input 1 and Input 2, then sets Engage, then
assesses the switch output:

1 Initialize the signals
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2 Scenario 1

a Set the signal levels
b Engage the control
c Assess the result

3 Scenario 2

a Set the signal levels
b Engage the control
c Assess the result

In the test sequence editor, the step hierarchy follows the hierarchy of the scenario
outline:
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Note: To execute test steps sequentially without using a logical transition condition, use
the condition true. true moves the sequence to the next step after the current step.
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Test Sequence Action and Transition Operations

In this section...

“Transition Between Steps Using Temporal or Signal Conditions” on page 3-11
“Link a Test Assessment to an Active Test Sequence Step” on page 3-12
“Temporal Operators” on page 3-13
“Transition Operators” on page 3-15
“Use Messages in Test Sequences” on page 3-16

Transition Between Steps Using Temporal or Signal Conditions

The Test Sequence block uses MATLAB as the action language. You can transition
between test steps by evaluating the component under test. You can use conditional logic,
temporal operators, and event operators.

Consider a simple test sequence that outputs a sine wave at three frequencies. The test
sequence transitions between steps:

• From Initialize to Sine when Switch changes
• From Sine to Sine8 when Switch changes from the value 1
• From Sine8 to Sine16 when Switch changes to the value 13.344
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Link a Test Assessment to an Active Test Sequence Step

If you use a separate Test Assessment block, you can link test assessments to the active
test step in a Test Sequence block. You link the two blocks with data monitoring the
active step:

1 Open the Model Explorer by selecting View > Model Explorer > Model Explorer.
2 Select the Test Sequence block in the Model Hierarchy.
3 In the properties, select Create data to monitor the active step.

This creates a new enumerated data output. Enter a name for the enumeration.

4 Create a data input for the Test Assessment block.

a Open the Test Assessment block.
b In the Symbols sidebar, next to Input, click the Add data icon. Name the

input.
5 In the test harness, connect the Test Sequence block step output to the Test

Assessment block step input.
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6 In the test assessments, use the enumeration in actions and transitions.

For example, this Test Assessment block verifies that when the test step down_4_3
is active, gear ~= 2.

Temporal Operators

To create an expression that evaluates the simulation time, use temporal operators.
Variables used in signal conditions must be inputs, parameters, or constants in the Test
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Sequence block. The table lists common temporal operators. Syntax in the table uses
these arguments:

TimeUnits

The units of time

Value: sec|msec|usec

Examples:

msec

SignalCondition

Logical expression triggering the operator. Variables used in duration can be inputs,
parameters, or constants, with at most one local or output data.

Examples:

u > 0

x <= 1.56

Operator Syntax Description Example

et et(TimeUnits) The elapsed time of the
test step in TimeUnits.
Omitting TimeUnits
returns the value in
seconds.

The elapsed time of the test
sequence step in milliseconds:

et(msec)

t t(TimeUnits) The elapsed time of
the simulation in
TimeUnits. Omitting
TimeUnits returns the
value in seconds.

The elapsed time of the
simulation in microseconds:

t(usec)

after after(n,

TimeUnits)

Returns true if n
specified units of time
in TimeUnits elapse
since the beginning of the
current test step.

After 4 seconds:

after(4,sec)

before before(n,

TimeUnits)

Returns true until n
specified units of time
in TimeUnits elapse,

Before 4 seconds:

before(4,sec)
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Operator Syntax Description Example

beginning with the
current test step.

duration ElapsedTime =

duration(SignalCondition,

TimeUnits)

Returns ElapsedTime
in TimeUnits after
SignalCondition

becomes true, within the
statement test step.

Return true if the time in
milliseconds since Phi > 1 is
greater than 550:

duration(Phi > 1,msec) > 550

Transition Operators

To create expressions that evaluate signal events, use transition operators. Common
transition operators include:

Operator Syntax Description Example

hasChanged hasChanged(u) Returns true if u
changes in value
since the beginning
of the test step,
otherwise returns
false.

u must be an input
data symbol.

Transition when h
changes:

hasChanged(h)

hasChangedFrom hasChangedFrom(u,A)Returns true if u
changes from the
value A, otherwise
returns false.

u must be an input
data symbol.

Transition when h
changes from 1:

hasChangedFrom(h,1)

hasChangedTo hasChangedTo(u,B) Returns true if u
changes to the value
B, otherwise returns
false.

u must be an input
data symbol.

Transition when h
changes to 0:

hasChangedTo(h,0)
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Use Messages in Test Sequences

Messages carry data between Test Sequence blocks and other blocks such as Stateflow®
charts. Messages can be used to model asynchronous events. A message is queued until
you evaluate it, which removes it from the queue. You can use messages and message
data inside a test sequence. The message remains valid until you forward it, or the time
step ends. For more information, see Messages in the Stateflow® documentation.

Receive Messages and Access Message Data

If your Test Sequence block has a message input, you can use queued messages in test
sequence actions or transitions. Use the receive command before accessing message
data or forwarding a message.

To create a message input, hover over Input in the Symbols sidebar, click the add
message icon, and enter the message name.

receive(M) determines whether a message is present in the input queue M, and
removes the message from the queue. receive(M) returns true if a message is in the
queue, and false if not. Once the message is received, you can access the message data
using the dot notation, M.data, or forward the message. The message is valid until it is
forwarded or the current time step ends.

The order of message removal depends on the queue type. Set the queue type using the
message properties dialog box. In the Symbols sidebar, click the edit icon next to the
message input, and select the Queue type. For more information see Queuing Behavior
of Stateflow Messages.

Send Messages

To send a message, create a message output and use the send command. To create a
message output, hover over Output in the Symbols sidebar, click the add message icon,
and enter the message name.
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You can assign data to the message using the dot notation M.data, where M is the
message output of the Test Sequence block. send(M) sends the message.

Forward Messages

You can forward a message from an input message queue to an output port. To forward a
message:

1 Receive the message from the input queue using receive.
2 Forward the message using the command forward(M,M_out) where M is the

message input queue and M_out is the message output.

Compare Test Sequences Using Data and Messages

This example demonstrates message inputs and outputs, sending, and receiving a
message. The model compares two pairs of test sequences. Each pair is comprised of a
sending and receiving test sequence block. The first pair sends and receives data, and the
second sends and receives a message.

Set the following path and model name variables.

filePath = fullfile(matlabroot,'examples','simulinktest');

model = 'sltest_testsequence_data_vs_message';

Open the model.

open_system(fullfile(filePath,model))
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Test Sequences Using Data

The DataSender block assigns a value to a data output M.

The DataReceiver block waits 3 seconds, then transitions to step S2. Step S2 transitions
to step S3 using a condition comparing M to the expected value, and does the same for S3
to S4.

Test Sequences Using Messages

The MessageSender block assigns a value to the message data of a message output
M_out, then sends the message to the MessageReceiver block.
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The MessageReceiver block waits 3 seconds, then transitions to step S2. Step S2's
transition evaluates the queue M with receive(M), removing the message from the
queue. receive(M) returns true since the message is present. M.data == 3.5
compares the message data to the expected value. The statement is true, and the
sequence transitions to step S3.

When step S3's transition condition evaluates, no messages are present in the queue.
Therefore, S3 does not transition to S4.

Run the test and observe the output comparing the different behaviors of the test
sequence pairs.

open_system([model '/Scope'])
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sim(model)

See Also
“Syntax for Test Sequences and Assessments” on page 3-36 | Test Sequence

Related Examples
• “Generate Function-Based Test Signals” on page 3-21
• “Assess Simulation Using Logical Statements” on page 3-25
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Generate Function-Based Test Signals

The Test Sequence block uses MATLAB as the action language. You can use functions to
generate signal outputs to the component under test.

1 Define an output data symbol in the Data Symbols pane.
2 Use the output name with a signal generation function in the test step action.

In this test sequence, the step Sine outputs a sine wave with a period of 10 seconds,
specified by the argument et*2*pi/10. The step Random outputs a random number in
the interval -0.5 to 0.5.

You can also define a function in a script on the MATLAB path, and call the function
in the Test Sequence block. In this test sequence, the ReducedSine step reduces
SignalOut using the function Attenuate.

function[y] = Attenuate(x)

y = 0.65*x;

end
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Output Functions

Generate test signals using output functions. The temporal operator et returns the
elapsed time of the test step in seconds.

Note: Function outputs are not constrained to provide a defined pattern. Scaling,
rounding, and other approximations of argument values can affect function outputs.

Common output functions include:

Function Syntax Description Example

square square(x) Represents a square
wave output with a
period of 1 and range –1
to 1.

Within the interval 0
<= x < 1, square(x)
returns the value 1 for 0
<= x < 0.5and –1 for
0.5 <= x < 1.

Output a square wave
with a period of 10 sec:

square(et/10)

sawtooth sawtooth(x) Represents a sawtooth
wave output with a

Output a sawtooth wave
with a period of 10 sec:

sawtooth(et/10)
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Function Syntax Description Example

period of 1 and range –1
to 1.

Within the interval 0 <=
x < 1, sawtooth(x)
increases.

triangle triangle(x) Represents a triangle
wave output with a
period of 1 and range –1
to 1.

Within the interval 0 <=
x < 0.5, triangle(x)
increases.

Output a triangle wave
with a period of 10 sec:

triangle(et/10)

ramp ramp(x) Represents a ramp signal
of slope 1, returning the
value of the ramp at time
x.

ramp(et) effectively
returns the elapsed time
of the test step.

Ramp one unit for every
5 seconds of test step
elapsed time:

ramp(et/5)

heaviside heaviside(x) Represents a heaviside
step signal, returning 0
for x < 0 and 1 for x >=
0.

Output a heaviside signal
after 5 seconds:

heaviside(et–5)

latch latch(x) Returns the current
value of x and holds that
value during the current
test step.

Latch b to the value of
torque:

b = latch(torque)

sin sin(x) Returns the sine of x,
where x is in radians.

A sine wave with a period
of 10 sec:

sin(et*2*pi/10)
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Function Syntax Description Example

cos cos(x) Returns the cosine of x,
where x is in radians.

A cosine wave with a
period of 10 sec:

cos(et*2*pi/10)

rand rand Uniformly distributed
pseudorandom number.

Generate values from the
uniform distribution on
the interval [a, b].

a + (b–a)*rand

randn randn Normally distributed
pseudorandom number.

Generate values from a
normal distribution with
mean 1 and standard
deviation 2.

1 + 2*randn(100,1)

exp exp(x) Returns the natural
exponential function, e

x .
An exponential signal
progressing at one tenth of
the test step elapsed time:

exp(et/10)

See Also
“Syntax for Test Sequences and Assessments” on page 3-36 | Test Sequence

Related Examples
• “Test Sequence Action and Transition Operations” on page 3-11
• “Assess Simulation Using Logical Statements” on page 3-25
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Assess Simulation Using Logical Statements

In this section...

“verify” on page 3-25
“assert” on page 3-27
“Assessment Statements” on page 3-28
“Logical Operators” on page 3-29
“Relational Operators” on page 3-29

A verify statement sends results to the Test Manager and allows simulation to run
even when the logical condition fails. An assert statement stops simulation. You can
use verify and assert statements to assess your model.

verify

The verify keyword assesses a logical expression inside a Test Sequence or Test
Assessment block. Optional arguments label results in the Test Manager and diagnostic
viewer. The keyword and arguments constitute a verify statement. Use the logical
expression to define a verification constraint on the system under test.

For each simulation step, the verify statement reports whether the logical expression
fails, passes, or is untested. For an overall test, a verify statement returns an overall
fail, pass, or untested result. Any failure at a simulation step results in an overall
failure. If the verify statement never fails, and at any time the statement passes, the
overall result passes. Otherwise, the statement is never tested, and the overall result is
untested. Review results in the Verify Statements section of the Test Manager.

Syntax

A verify statement uses syntax of these forms

verify(expression)

verify(expression,errorMessage)

verify(expression,identifier,errorMessage)

The simplest verify statement uses only a logical expression. To make results easier
to interpret, use additional arguments to define an error message and a statement
identifier. Error messages display in the diagnostic viewer. You can use error messages
to display key values at the time the statement fails.
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For example, if verify evaluates an expression containing variables x and y, you can
display the values of x and y using the string

'x and y values are %d, %d',x,y

An identifier labels the verify results in the Test Manager. The identifier uses a string
of the form 'prefix:suffix'. prefix and suffix are alphanumeric strings. For
example:

'SimulinkTest:x_equals_y'

Continuous-Time Considerations

verify is not supported in Test Sequence blocks that use continuous-time updating.
Test Sequence block data can depend on factors such as the solver step time. Continuous-
time updating can cause differences in when block data and verify statements update,
which can lead to unexpected verify statement results.

If your model uses continuous time and you use verify statements in a Test Sequence
or Test Assessment block, consider explicitly setting a discrete block sample time.

Example

In this comparison of two values, the parent step uses verify statements to assess two
local variables x and y during the simulation. The substeps set two conditions.

• verify(x >= y) passes overall because it is true for the entire test sequence.
• verify(x == y) and verify(x ~= y) fail because they fail in step_1_2 and

step_1_1, respectively.

The Test Manager displays the results.
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assert

assert evaluates a logical argument, but unlike verify, assert stops simulation.
assert does not return fail, pass, or untested results. Failures appear as errors.
Consider using assert statements to avoid executing a bad test. For example, if
a component under test outputs two signals h and k, and the test requires h and k
initialized to 0, use assert to stop the test if the signals do not initialize.

To make results easier to interpret, add an optional message that evaluates when the
assertion fails. This example demonstrates an assert statement that returns a message
if the logical condition fails.
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Code is not generated for assert statements in the Test Sequence block.

Assessment Statements

Use assessment statements to verify simulation, stop simulation, and return verification
results. The syntax uses these arguments.

expression

Logical statement assessed

Examples:

h > 0 && k == 0

identifier

Label applied to results in the Test Manager

Value: String of the form aaa:bbb:...:zzz, with at least two colon-separated MATLAB
identifiers aaa, bbb, and zzz.

Examples:

'SimulinkTest:greaterThan'

errorMessage

Label applied to messages in the diagnostic viewer

Value: String

Examples:

'x and y values are %d, %d',x,y

Keyword Statement Syntax Description Example

verify verify(expression)

verify(expression,

errorMessage)

verify(expression,

identifier,

errorMessage)

Assesses a logical
expression. Optional
arguments label
results in the Test
Manager and
diagnostic viewer.

verify(x > y,...

'SimulinkTest:greaterThan',...

'x and y values are %d, %d',x,y)
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Keyword Statement Syntax Description Example

assert assert(expression)

assert(expression,

errorMessage)

Evaluates a logical
expression. Failure
stops simulation and
returns an error.
Optional arguments
return an error
message.

assert(h == 0 && k == 0,...

'h and k must initialize to 0')

Logical Operators

You can use logical connectives in actions, transitions, and assessments. In these
examples, p and q represent Boolean signals or logical expressions.

Operation Syntax Description Example

Negation ~p not p verify(~p)

Conjunction p && q p and q verify(p && q)

Disjunction p || q p or q verify(p || q)

Implication ~p || q if p, q. Logically
equivalent to
implication p → q.

verify(~p || q)

Biconditional (p && q) || (~p

&& ~q)

p and q, or not p
and not q. Logically
equivalent to
biconditional p ↔ q.

verify((p && q)

|| (~p && ~q))

Relational Operators

You can use relational operators in actions, transitions, and assessments. In these
examples, x and y represent numeric-type variables.

Using == or ~= operators in a verify statement returns a warning when comparing
floating-point data. Consider the precision limitations associated with floating-point
numbers when implementing verify statements. See “Floating-Point Numbers”. If you
use floating-point data, consider defining a tolerance for the assessment. For example,
instead of verify(x == 5), verify x within a tolerance of 0.001:
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verify(abs(x-5) < 0.001)

Operator and Syntax Description Example

x > y Greater than verify(x > y)

x < y Less than verify(x < y)

x >= y Greater than or equal to verify(x >= y)

x <= y Less than or equal to verify(x <= y)

x == y Equal to verify(x == y)

x ~= y Not equal to verify(x ~= y)

See Also
“Syntax for Test Sequences and Assessments” on page 3-36 | Test Sequence

Related Examples
• “Test Sequence Action and Transition Operations” on page 3-11
• “Generate Function-Based Test Signals” on page 3-21
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Programmatically Create a Test Sequence

This example shows how to create a test sequence programmatically. You create a Test
Sequence block, and author a test sequence to verify two safety requirements of a cruise
control system.

Create a Test Harness Containing a Test Sequence Block

1. Open the cruise control project, and open the model. This creates a working copy of the
project in your MATLAB folder.

slVerificationCruiseStart;

open_system simulinkCruiseAddReqExample.slx

Initializing: Project Path

Identifying shadowed project files

2. Create and open the test harness.

sltest.harness.create('simulinkCruiseAddReqExample','Name','SafetyTestHarness',...

    'Source','Test Sequence')

sltest.harness.open('simulinkCruiseAddReqExample','SafetyTestHarness')

set_param('SafetyTestHarness','StopTime','15');
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Author the Test Sequence

1. Add a local variable endTest, which you use to transition between test steps.

a = sltest.testsequence.addSymbol('SafetyTestHarness/Test Sequence','endTest',...

    'Data','Local');

a.DataType = 'boolean';

2. Change the name of the step Run to Initialize1.

sltest.testsequence.editStep('SafetyTestHarness/Test Sequence','Run',...

    'Name','Initialize1');

3. Add a step BrakeTest to test that the cruise control disengages when the brake is
applied. Also add substeps defining the test scenario actions and verification.

sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...

    'BrakeTest','Initialize1','Label','endTest = false;')

    % Add a transition from |Initialize1| to |BrakeTest|.

    sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...

        'Initialize1','true','BrakeTest')

    % This sub-step enables the cruise control and sets the speed.
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    % |SetValuesActions| is the actions for BrakeTest.SetValues.

    setValuesActions = sprintf('CruiseOnOff = true;\nSpeed = single(50);');

    sltest.testsequence.addStep('SafetyTestHarness/Test Sequence',...

        'BrakeTest.SetValues','Label',setValuesActions)

    % This sub-step engages the cruise control.

    setCCActions = sprintf('CoastSetSw = true;');

    sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...

        'BrakeTest.Engage','BrakeTest.SetValues','Label',setCCActions)

    % This step applies the brake.

    brakeActions = sprintf('CoastSetSw = false;\nBrake = true;');

    sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...

        'BrakeTest.Brake','BrakeTest.Engage','Label',brakeActions)

    % This step verifies that the cruise control is off.

    brakeVerifyActions = sprintf('verify(engaged == false)\nendTest = true;');

    sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...

        'BrakeTest.Verify','BrakeTest.Brake','Label',brakeVerifyActions)

    % Add transitions between steps.

    sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...

        'BrakeTest.SetValues','true','BrakeTest.Engage')

    sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...

        'BrakeTest.Engage','after(2,sec)','BrakeTest.Brake')

    sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...

        'BrakeTest.Brake','true','BrakeTest.Verify')

4. Add a step Initialize2 to initialize component inputs again, and add a transition
from BrakeTest to Initialize2.

init2Actions = sprintf(['CruiseOnOff = false;\n'...

    'Brake = false;\n'...

    'Speed = single(0);\n'...

    'CoastSetSw = false;\n'...

    'AccelResSw = false;']);

sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...

    'Initialize2','BrakeTest','Label',init2Actions)

sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...

    'BrakeTest','endTest == true','Initialize2')

5. Add a step LimitTest to test cruise control disengagement when the vehicle speed
exceeds the high limit. Also, add a transition from the Initialize2 step, and add sub-
steps to define the scenario actions and verification.
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sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...

    'LimitTest','Initialize2')

sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...

    'Initialize2','true','LimitTest')

    % Add a step to enable cruise control and set the speed.

    setValuesActions2 = sprintf('CruiseOnOff = true;\nSpeed = 60;');

    sltest.testsequence.addStep('SafetyTestHarness/Test Sequence',...

        'LimitTest.SetValues','Label',setValuesActions2)

    % Add a step to engage the cruise control.

    setCCActions = sprintf('CoastSetSw = true;');

    sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...

        'LimitTest.Engage','LimitTest.SetValues','Label',setCCActions)

    % Add a step to ramp the vehicle speed.

    sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...

        'LimitTest.RampUp','LimitTest.Engage','Label','Speed = Speed + ramp(5*et);')

    % Add a step to verify that the cruise control is off.

    highLimVerifyActions = sprintf('verify(engaged == false)');

    sltest.testsequence.addStepAfter('SafetyTestHarness/Test Sequence',...

        'LimitTest.VerifyHigh','LimitTest.RampUp','Label',highLimVerifyActions)

    % Add transitions between steps. The speed ramp transitions when the

    % vehicle speed exceeds 90.

    sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...

        'LimitTest.SetValues','true','LimitTest.Engage')

    sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...

        'LimitTest.Engage','true','LimitTest.RampUp')

    sltest.testsequence.addTransition('SafetyTestHarness/Test Sequence',...

        'LimitTest.RampUp','Speed > 90','LimitTest.VerifyHigh')

Double-click the Test Sequence block to open the editor and view the created test
sequence.
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Close the Test Harness and Model

sltest.harness.close('simulinkCruiseAddReqExample','SafetyTestHarness');

close_system('simulinkCruiseAddReqExample.slx',0);
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Syntax for Test Sequences and Assessments

In this section...

“Assessment Statements” on page 3-28
“Temporal Operators” on page 3-13
“Transition Operators” on page 3-15
“Output Functions” on page 3-22
“Logical Operators” on page 3-29
“Relational Operators” on page 3-29

Test Sequence and Test Assessment blocks use MATLAB as the action language for step
actions, step transitions, and test assessments. Use keywords and operators to create
action, transition, and assessment statements. For example:

• Output a square wave with a period of 10 sec:

square(et/10)

• Transition when h changes to 0:

hasChangedTo(h,0)

• Verify that x is greater than y:

verify(x > y)

Assessment Statements

Use assessment statements to verify simulation, stop simulation, and return verification
results. The syntax uses these arguments.

expression

Logical statement assessed

Examples:

h > 0 && k == 0

identifier

Label applied to results in the Test Manager
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Value: String of the form aaa:bbb:...:zzz, with at least two colon-separated MATLAB
identifiers aaa, bbb, and zzz.

Examples:

'SimulinkTest:greaterThan'

errorMessage

Label applied to messages in the diagnostic viewer

Value: String

Examples:

'x and y values are %d, %d',x,y

Keyword Statement Syntax Description Example

verify verify(expression)

verify(expression,

errorMessage)

verify(expression,

identifier,

errorMessage)

Assesses a logical
expression. Optional
arguments label
results in the Test
Manager and
diagnostic viewer.

verify(x > y,...

'SimulinkTest:greaterThan',...

'x and y values are %d, %d',x,y)

assert assert(expression)

assert(expression,

errorMessage)

Evaluates a logical
expression. Failure
stops simulation and
returns an error.
Optional arguments
return an error
message.

assert(h == 0 && k == 0,...

'h and k must initialize to 0')

Temporal Operators

To create an expression that evaluates the simulation time, use temporal operators.
Variables used in signal conditions must be inputs, parameters, or constants in the Test
Sequence block. The table lists common temporal operators. Syntax in the table uses
these arguments:
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TimeUnits

The units of time

Value: sec|msec|usec

Examples:

msec

SignalCondition

Logical expression triggering the operator. Variables used in duration can be inputs,
parameters, or constants, with at most one local or output data.

Examples:

u > 0

x <= 1.56

Operator Syntax Description Example

et et(TimeUnits) The elapsed time of the
test step in TimeUnits.
Omitting TimeUnits
returns the value in
seconds.

The elapsed time of the test
sequence step in milliseconds:

et(msec)

t t(TimeUnits) The elapsed time of
the simulation in
TimeUnits. Omitting
TimeUnits returns the
value in seconds.

The elapsed time of the
simulation in microseconds:

t(usec)

after after(n,

TimeUnits)

Returns true if n
specified units of time
in TimeUnits elapse
since the beginning of the
current test step.

After 4 seconds:

after(4,sec)

before before(n,

TimeUnits)

Returns true until n
specified units of time
in TimeUnits elapse,

Before 4 seconds:

before(4,sec)
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Operator Syntax Description Example

beginning with the
current test step.

duration ElapsedTime =

duration(SignalCondition,

TimeUnits)

Returns ElapsedTime
in TimeUnits after
SignalCondition

becomes true, within the
statement test step.

Return true if the time in
milliseconds since Phi > 1 is
greater than 550:

duration(Phi > 1,msec) > 550

Transition Operators

To create expressions that evaluate signal events, use transition operators. Common
transition operators include:

Operator Syntax Description Example

hasChanged hasChanged(u) Returns true if u
changes in value
since the beginning
of the test step,
otherwise returns
false.

u must be an input
data symbol.

Transition when h
changes:

hasChanged(h)

hasChangedFrom hasChangedFrom(u,A)Returns true if u
changes from the
value A, otherwise
returns false.

u must be an input
data symbol.

Transition when h
changes from 1:

hasChangedFrom(h,1)

hasChangedTo hasChangedTo(u,B) Returns true if u
changes to the value
B, otherwise returns
false.

u must be an input
data symbol.

Transition when h
changes to 0:

hasChangedTo(h,0)

3-39



3 Test Sequences and Assessments

Output Functions

Generate test signals using output functions. The temporal operator et returns the
elapsed time of the test step in seconds.

Note: Function outputs are not constrained to provide a defined pattern. Scaling,
rounding, and other approximations of argument values can affect function outputs.

Common output functions include:

Function Syntax Description Example

square square(x) Represents a square
wave output with a
period of 1 and range –1
to 1.

Within the interval 0
<= x < 1, square(x)
returns the value 1 for 0
<= x < 0.5and –1 for
0.5 <= x < 1.

Output a square wave
with a period of 10 sec:

square(et/10)

sawtooth sawtooth(x) Represents a sawtooth
wave output with a
period of 1 and range –1
to 1.

Within the interval 0 <=
x < 1, sawtooth(x)
increases.

Output a sawtooth wave
with a period of 10 sec:

sawtooth(et/10)

triangle triangle(x) Represents a triangle
wave output with a
period of 1 and range –1
to 1.

Within the interval 0 <=
x < 0.5, triangle(x)
increases.

Output a triangle wave
with a period of 10 sec:

triangle(et/10)
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Function Syntax Description Example

ramp ramp(x) Represents a ramp signal
of slope 1, returning the
value of the ramp at time
x.

ramp(et) effectively
returns the elapsed time
of the test step.

Ramp one unit for every
5 seconds of test step
elapsed time:

ramp(et/5)

heaviside heaviside(x) Represents a heaviside
step signal, returning 0
for x < 0 and 1 for x >=
0.

Output a heaviside signal
after 5 seconds:

heaviside(et–5)

latch latch(x) Returns the current
value of x and holds that
value during the current
test step.

Latch b to the value of
torque:

b = latch(torque)

sin sin(x) Returns the sine of x,
where x is in radians.

A sine wave with a period
of 10 sec:

sin(et*2*pi/10)

cos cos(x) Returns the cosine of x,
where x is in radians.

A cosine wave with a
period of 10 sec:

cos(et*2*pi/10)

rand rand Uniformly distributed
pseudorandom number.

Generate values from the
uniform distribution on
the interval [a, b].

a + (b–a)*rand

randn randn Normally distributed
pseudorandom number.

Generate values from a
normal distribution with
mean 1 and standard
deviation 2.

1 + 2*randn(100,1)
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Function Syntax Description Example

exp exp(x) Returns the natural
exponential function, e

x .
An exponential signal
progressing at one tenth of
the test step elapsed time:

exp(et/10)

Logical Operators

You can use logical connectives in actions, transitions, and assessments. In these
examples, p and q represent Boolean signals or logical expressions.

Operation Syntax Description Example

Negation ~p not p verify(~p)

Conjunction p && q p and q verify(p && q)

Disjunction p || q p or q verify(p || q)

Implication ~p || q if p, q. Logically
equivalent to
implication p → q.

verify(~p || q)

Biconditional (p && q) || (~p

&& ~q)

p and q, or not p
and not q. Logically
equivalent to
biconditional p ↔ q.

verify((p && q)

|| (~p && ~q))

Relational Operators

You can use relational operators in actions, transitions, and assessments. In these
examples, x and y represent numeric-type variables.

Using == or ~= operators in a verify statement returns a warning when comparing
floating-point data. Consider the precision limitations associated with floating-point
numbers when implementing verify statements. See “Floating-Point Numbers”. If you
use floating-point data, consider defining a tolerance for the assessment. For example,
instead of verify(x == 5), verify x within a tolerance of 0.001:

verify(abs(x-5) < 0.001)
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Operator and Syntax Description Example

x > y Greater than verify(x > y)

x < y Less than verify(x < y)

x >= y Greater than or equal to verify(x >= y)

x <= y Less than or equal to verify(x <= y)

x == y Equal to verify(x == y)

x ~= y Not equal to verify(x ~= y)

Related Examples
• “Assess Simulation Using Logical Statements” on page 3-25
• “Test Sequence Action and Transition Operations” on page 3-11
• “Generate Function-Based Test Signals” on page 3-21
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Debug a Test Sequence

In this section...

“View Test Step Execution During Simulation” on page 3-44
“Set Breakpoints to Enable Debugging” on page 3-44
“View Data Values During Simulation” on page 3-45
“Step Through Simulation” on page 3-46

You can debug a test sequence using tools in the test sequence editor. Debugging involves
setting breakpoints to stop simulation, observing data and test sequence progression,
and manually stepping through test steps. You can try these features using the model
sltestTestSeqDebuggingExample. To open the model, enter

cd(fullfile(docroot,'toolbox','sltest','examples'))

open_system('sltestTestSeqDebuggingExample')

Save a copy of the model to a writable location on the MATLAB path. Double-click the
Test Sequence block to open the test sequence editor.

View Test Step Execution During Simulation

By default, simulation animates the test sequence by highlighting active steps and
transitions. Observing test step execution can help you debug, particularly when
manually stepping through the test sequence. Adjust the animation speed using the

Change Animation Speed button  in the toolbar.

Animation speed affects simulation speed. If you slow down animation speed for
debugging, return the speed to Fast or Lightning Fast when you finish debugging to
avoid slowing your simulation. If you do not need the test step highlights and want the
fastest simulation, choose None.

Set Breakpoints to Enable Debugging

You enable debugging for a test sequence by adding one or more breakpoints.
Breakpoints halt simulation every time the test step is evaluated. Therefore, breakpoints
on some test steps, such as When decomposition parent steps, halt simulation
repeatedly because the step is evaluated repeatedly. When simulation halts, you can view
data used in the test sequence to investigate the sequence simulation behavior.
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You can add breakpoints to test step actions or transitions:

• To add a breakpoint to a test step action, right-click the test step and select Break
while executing step.

• To add a breakpoint to a test step transition, right-click the test step transition and
select Break when transition taken.

The editor displays a breakpoint marker. After adding breakpoints, simulate the test
sequence by clicking Run.

View Data Values During Simulation

If the simulation pauses (for example, at a breakpoint), you can view the status of
data used in a test step by hovering over the test step. The data values at the current
simulation time display next to the test sequence cell.

Note: If you advance the simulation to another stop (for example, using the keyboard
shortcuts), the data display does not update. Move off the test step and then hover over
the step again to refresh the values.
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Step Through Simulation

When simulation halts, you can step through the test sequence using the toolbar buttons.
Also see “Debugging and Breakpoints Keyboard Shortcuts”.

Objective Details Toolbar Button

Simulate until
breakpoint

Simulation runs until
the next breakpoint

Step forward
through simulation
time

Simulation advances one
simulation step

Step forward
through test
step actions and
transitions

Simulation advances
by each step of a test
sequence, with pauses at
actions and transitions.
Does not step into a
function call.

Step in to a test
step group or called
function

Simulation advances
into the substeps of
a parent step and
executes each action and
transition. Steps into a
function call.

Step out of a test
step group or called
function

Simulation advances
through the remaining
substeps of a parent
step and then out to the
parent step hierarchy
level. Also finishes
execution of a function
call.

See Also
Test Sequence
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Test a Model Component Using Signal Functions

In this section...

“Create a Test Sequence” on page 3-47
“Simulate the Test Harness” on page 3-48

Using the Test Sequence block, you can define a set of input functions to test your
component, and conditionally switch the function based on component signals. See Test
Sequence for more information.

This example demonstrates building and simulating a test sequence using ramp and
square wave signals. The test initializes at constant temperature, ramps down to a limit,
and executes a square-wave temperature cycle.

Create a Test Sequence

1 Access the model. Enter

cd(fullfile(docroot,'toolbox','sltest','examples'))

2 Copy this model file and supporting files to a writable location on the MATLAB path:

sltestSignalFunctionExample.slx

sltestHeatpumpBusPostLoadFcn.mat

PumpDirection.m

3 Open the model, and open the harness.

open_system('sltestSignalFunctionExample');

sltest.harness.open('sltestSignalFunctionExample/Controller','RampSquareHarness')

4 Double-click the Test Sequence block to open the test sequence editor.
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5 Rename the first and second steps. Delete the default names and replace them with
const_90 and ramp_down.

6 Add a third step to the table. Right-click the ramp_down line, and select Add step
after. Name the third step temp_step.

7 Add output conditions and transition fields to the steps. Copy and paste the listings
from the table.

Step Transition Next step

const_90

Tset = 75;

Troom_in = 90;

after(120,sec) ramp_down

ramp_down

Tset = 75;

Troom_in = 90-ramp(et)/8;

Troom_in <= 60 temp_step

temp_step

Tset = 75;

Troom_in = 75+15*square(et/90);

   

Simulate the Test Harness

1 Set the simulation time to 720 sec.
2 Simulate the Test Harness. Observe the Troom_in signal in the scope.
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See Also

Blocks
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Test Downshift Points of a Transmission Controller

This example demonstrates how to test a transmission shift logic controller using test
sequences and test assessments.

The Model and Controller

This example uses a simplified drivetrain system arranged in a controller-plant
configuration. The objective of the example is to test the transmission controller in
isolation, ensuring that it downshifts correctly.

The Test

The controller should downshift between each of its gear ratios in response to a ramped
throttle application. The test inputs hold vehicle speed constant while ramping the
throttle. The Test Assessment block includes requirements-based assessments of the
controller performance.

path = fullfile(matlabroot,'examples','simulinktest');

mdl = 'TransmissionDownshiftTestSequence';

harness = 'controller_harness';

open_system(fullfile(path,mdl));
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Open the Test Harness

Click the badge on the subsystem shift_controller and open the test harness
controller_harness. shift_controller is connected to a Test Sequence block and a
Test Assessment block.

sltest.harness.open([mdl '/shift_controller'],harness)

The Test Sequence

Double-click the Test Sequence block to open the test sequence editor.

The test sequence begins by ramping speed to 75 to initialize the controller to fourth
gear. Throttle is then ramped at constant speed until a gear change. Subsequent
initialization and downshifts execute. After the change to first gear, the test sequence
stops.

open_system([harness '/Test Sequence']);
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Test Assessments for the Controller

Assume that the requirements for the shift controller include:

• Speed shall never be negative.
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• Gear shall always be positive.
• Throttle shall be between 0% and 100%.
• The controller shall not let the engine overspeed.

Open the Test Assessment block. These assertions in the block correspond to the first
three requirements. If the controller violates one of the assertions, the simulation fails.

assert(speed >= 0, 'speed must be >= 0');

assert(throttle >= 0, 'throttle must be >= 0 and <= 100');

assert(throttle <= 100, 'throttle must be >= 0 and <= 100');

assert(gear > 0,'gear must be > 0');

The last requirement has three sub-requirements. We assume that the engine cannot
overspeed in fourth (top) gear.

• The controller shall not let the vehicle speed exceed 90 in gear 3.
• The controller shall not let the vehicle speed exceed 50 in gear 2.
• The controller shall not let the vehicle speed exceed 30 in gear 1.

You can model these assessments with a When decomposition sequence. When
decomposition step selection is based on signal conditions defined in the Step column,
with each condition preceded by the when operator. The Transition and Next Step
columns do not affect the transition. The last step Else in the when decomposition covers
any undefined condition and does not use a when declaration.

To change a sequence to a When decomposition, right-click a step and select When
decomposition. Sub-steps of this step then operate using the when operator.

AssertConditions has sub-steps that assess the controller as follows:

OverSpeed3 when gear==3

assert(speed <= 90,'Engine overspeed in gear 3')

OverSpeed2 when gear==2

assert(speed <= 50,'Engine overspeed in gear 2')

OverSpeed1 when gear==1

assert(speed <= 30,'Engine overspeed in gear 1')
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Testing the Controller

Simulating the test harness demonstrates the progressive throttle ramp at each test
step, and the corresponding downshifts. The controller passes all of the assessments in
the Test Assessment block.

open_system([harness '/FloatingScope'])

sim(harness);
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close_system(mdl);
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Reuse Test Assessments
If one test assessment covers many test cases, consider reusing the assessment from
a single source such as a library. Reusing test assessments allows you to update and
manage the source rather than multiple copies of the same assessment. Often, such
assessments are associated with broad requirements such as:

• “The speed signal must never be negative.”
• “The cruise control must never be engaged while the brake is engaged.”
• “The heat pump must wait more than 5 seconds before switching from on to off or off

to on.”
• “The projector temperature must never exceed 65 degrees Celsius.”

Reuse Test Assessments Using a Library

This example shows how to reuse test assessments contained in a test sequence block
using a linked block from a library.

When you create a test harness, you can include a standalone Test Sequence block for
test assessments (a Test Assessment block). Often, assessments cover multiple test cases,
making it convenient to reuse the same Test Assessment block. Test assessment reuse
has these advantages:

• Assessments are stored in a single source. If the requirements change, you update
only the assessments in the library.

• You can link to test requirements from the source. Linking from the source reduces
the number of requirements links to manage.

To reuse a standalone Test Assessment block in multiple test harnesses, create the Test
Assessment block in a library, and reuse the Test Assessment block in multiple test
harnesses by way of linked blocks.

Consider using a library for high-level test assessments that correspond to multiple test
cases.

You can also create reusable assessments in a library using blocks from the Model
Verification library in Simulink.

Explore the Test Sequence Example Model

1. Open the model. At the command line, enter:
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sltestTestSequenceExample

2. Click the badge on the shift_controller subsystem and open the
controller_harness test harness.

The Test Assessment block contains four assertions that define the assessment criteria:
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assert(speed >= 0)

assert(throttle >= 0)

assert(throttle <= 100)

assert(gear > 0)

Create a Library for the Test Assessments

1 In the test harness, select File > New > Library.
2 Save the new library as AssessmentLibrary in a writable location on the

MATLAB® path.
3 Copy the Test Assessment block from the test harness to the library, and then delete

the Test Assessment block from the test harness.
4 Save the library.

Create a Linked Test Assessment Block in Test Harnesses

Copy the Test Assessment block from the library to the test harness to create a linked
block.

1 In the test harness, enable the library link display. Select Display > Library Links
> All.
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2 Copy the Test Assessment block from AssessmentLibrary into
controller_harness. The block displays a library link badge.

3 Connect the signal inputs to the Test Assessment block.

Edit the Assessment Block in the Library

1 Unlock the library. Select Diagram > Unlock Library.
2 Add a fifth assertion to the Test Sequence block: assert(gear < 5);
3 Save and close the library. Closing locks the library.
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View Graphical Results From Model Verification Library

Simulink® Test™ outputs graphical results of the Model Verification block library
so you can use the Test Manager or Simulation Data Inspector to see when your test
assessments pass and fail.

In addition to warnings or stop-simulation behavior, the graphical results show the
block evaluation results during simulation. Viewing Model Verification block results
graphically helps you to:

• Determine the time step when a failure occurs.
• Debug the model by comparing the verification result with relevant signals.
• Trace failures from the results to the model.

This example shows how to view outputs from Model Verification blocks in the Test
Manager or Simulation Data Inspector.

Open the Model

The model contains a verification subsystem Safety Properties that uses an
Assertion block to check whether the system disengages if the brake has been applied
for three time steps. The verification subsystem also uses Simulink® Design Verifier™
blocks.

open_system(fullfile(matlabroot,'examples','simulinktest',...

    'sltestCruiseControlDefective'))
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Simulate the Model and View Results in SDI

sim('sltestCruiseControlDefective')

After the simulation completes, open SDI. The results show that the assertion failed at
0.23 seconds.

Simulink.sdi.view
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Highlight Assertion Block in the Model

To find the assertion block in the model, right-click BrakeAssertion in SDI and select
Highlight in Model. The block is highlighted in the verification subsystem.
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SIL Verification for a Subsystem

In this section...

“Create a SIL Verification Harness for a Controller” on page 4-3
“Configure and Simulate a SIL Verification Harness” on page 4-5
“Compare the SIL Block and Model Controller Outputs” on page 4-5

This example shows subsystem verification by ensuring the output of software-in-the-
loop (SIL) code matches that of the model subsystem. You generate a SIL verification
harness, collect simulation results, and compare the results using the simulation data
inspector. You can apply a similar process for processor-in-the-loop (PIL) verification.

With SIL simulation, you can verify the behavior of production source code on your host
computer. Additionally, with PIL simulation, you can verify the compiled object code
that you intend to deploy in production. You can run the PIL object code on real target
hardware or on an instruction set simulator.

If you have an Embedded Coder license, you can create a test harness in SIL or PIL mode
for model verification. You can compare the SIL or PIL block results with the model
results and collect metrics, including execution time and code coverage. Using the test
harness to perform SIL and PIL verification, you can:

• Manage the harness with your model. Generating the test harness generates the SIL
block. The test harness is associated with the component under verification. You can
save the test harness with the main model.

• Use built-in tools for these test-design-test workflows:

• Checking the SIL or PIL block equivalence
• Updating the SIL or PIL block to the latest model design

• View and compare logged data and signals using the Test Manager and Simulation
Data Inspector.

For information about running multiple simulations with unchanged generated code, see
“Prevent Code Changes in Multiple Simulations”.

Also see “Code Generation of Subsystems” in the Simulink Coder™ documentation.

The example models a closed-loop controller-plant system. The controller regulates the
plant output.
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Create a SIL Verification Harness for a Controller

Create a SIL verification harness using data that you log from a controller subsystem
model simulation. You need an Embedded Coder license for this example.

1 Open the example model by entering

rtwdemo_sil_block

at the MATLAB command prompt,

2 Save a copy of the model using the name controller_model in a new folder, in a
writable location on the MATLAB path.

3 Enable signal logging for the model. At the command prompt, enter

set_param(bdroot,'SignalLogging','on','SignalLoggingName',...

'SIL_signals','SignalLoggingSaveFormat','Dataset')
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4 Right-click the signal into Controller port In1, and select Properties. In the Signal
Properties dialog box, for the Signal name, enter controller_model_input.
Select Log signal data and click OK.

5 Right-click the signal out of Controller port Out1, and select Properties.
In the Signal Properties dialog box, for the Signal name, enter
controller_model_output. Select Log signal data and click OK.

6 Simulate the model.
7 Get the logged signals from the simulation output into the workspace. At the

command prompt, enter

out_data = out.get('SIL_signals');

control_in1 = out_data.get('controller_model_input');

control_out1 = out_data.get('controller_model_output');

8 Create the software-in-the-loop test harness. Right-click the Controller subsystem
and select Test Harness > Create Test Harness (Controller).

9 Set the harness properties:

• Name: SIL_harness
• Sources and Sinks: Inport and Outport
• Initial harness configuration: Verification
• Verification Mode: Software-in-the-loop (SIL)
• Select Open harness after creation

Click OK. The resulting test harness has a SIL block.
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Configure and Simulate a SIL Verification Harness

Configure and simulate a SIL verification harness for a controller subsystem.

1 Configure the test harness to import the logged controller input values. From the top
level of the test harness, in the model Configuration Parameters dialog box, in
the Data Import/Export pane, select Input. Enter control_in1.Values as the
input and click OK.

2 Enable signal logging for the test harness. At the command prompt, enter

set_param('SIL_harness','SignalLogging','on','SignalLoggingName',...

'harness_signals','SignalLoggingSaveFormat','Dataset')

3 Right-click the output signal of the SIL block and select Properties. In the Signal
Properties dialog box, for the Signal name, enter SIL_block_out. Select Log
signal data and click OK.

4 Simulate the harness.

Compare the SIL Block and Model Controller Outputs

Compare the outputs for a verification harness and a controller subsystem.

1 In the test harness model, click the Simulation Data Inspector button  to open the
Simulation Data Inspector.

2 In the Simulation Data Inspector, click Import. In the Import dialog box.

• Set Import from to: Base workspace.
• Set Import to to: New Run.
• Under Data to import, select Signal Name to import data from all sources.

3 Click Import.
4 Select the SIL_block_out and controller_model_out signals in the Runs pane

of the data inspector window.

The chart displays the two signals, which overlap. This result suggests equivalence
for the SIL code. You can plot signal differences using the Compare tab in SDI, and
perform more detailed analyses for verification. For more information, see “Compare
Signal Data from Multiple Simulations” in the Simulink documentation.
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5 Close the test harness window. You return to the main model. The badge  on the
Controller block indicates that the SIL harness is associated with the subsystem.
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Introduction to the Test Manager

In this section...

“Test Manager Description” on page 5-2
“Test Creation and Hierarchy” on page 5-2
“Test Results” on page 5-3
“Share Results” on page 5-3

Test Manager Description

The Test Manager in Simulink Test enables you to automate Simulink model testing and
organize large sets of tests. A model test is performed using test cases where criteria are
specified to determine a pass-fail outcome. The test cases are run from the Test Manager.
At the end of a test, the test case results are organized and viewed in the Test Manager.

Test Creation and Hierarchy

Test cases are contained within a hierarchy of test files and test suites in the Test
Browser pane of the Test Manager. A test file can contain multiple test suites, and test
suites can contain multiple test cases.

There are three types of test case templates to choose from in the Test Manager. Each
test case uses a different set of criteria to determine the outcome of a test.
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• Baseline: compares signal outputs of a simulation to a baseline set of signals. The
comparison of the simulation output and the baseline must be within the absolute or
relative tolerances to pass the test, which is defined in the Baseline Criteria section
of the test case.

• Equivalence: compares signal outputs between two simulations. The comparison of
outputs must be within the absolute or relative tolerances to pass the test, which is
defined in the Equivalence Criteria section of the test case.

• Simulation: checks that a simulation runs without errors, which includes model
assertions.

Test Results

Results of a test are given using a pass-fail outcome. If all of the criteria defined in a
test case is satisfied, then a test passes. If any of the criteria are not satisfied, then the
test fails. Once the test has finished running, the results are viewed in the Results and
Artifacts pane. Each test result has a summary page that highlights the outcome of the
test: passed, failed, or incomplete. The simulation output of a model is also shown in the
results section. Signal data from the simulation output can be visually inspected using
the Simulation Data Inspector.

Share Results

Once you have completed the test execution and analyzed the results, you can share the
test results with others or archive them. If you want to share the results to be viewed
later in the Test Manager, then you can export the results to a file. To archive the results
in a document, you can generate a report, which can include the test outcome, test
summary, and any criteria used for test comparisons.

Related Examples
• “Test Model Output Against a Baseline” on page 6-9
• “Test Two Simulations for Equivalence”
• “Code Generation Verification Workflow with Simulink Test”
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• “Manage Test File Dependencies” on page 6-2
• “Test Model Output Against a Baseline” on page 6-9
• “Test a Simulation for Run-Time Errors” on page 6-13
• “Generate Test Cases from Model Components” on page 6-16
• “Use External Inputs in Test Cases” on page 6-24
• “Automate Tests Programmatically” on page 6-27
• “Run Multiple Combinations of Tests Using Iterations” on page 6-33
• “Collect Coverage in Tests” on page 6-41
• “Run Tests Using Parallel Execution” on page 6-47
• “How Tolerances Are Applied to Test Criteria” on page 6-49
• “Test Manager Limitations” on page 6-50
• “Test Sections” on page 6-52
• “Test Models Using Inputs Generated by Simulink Design Verifier” on page 6-60
• “Apply Custom Criteria to Test Cases” on page 6-63
• “Test Models Using MATLAB Unit Test” on page 6-74
• “Filter Test Execution and Results” on page 6-83
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Manage Test File Dependencies

In this section...

“Package a Test File Using Simulink Projects” on page 6-2
“Find Test File Dependencies and Impact” on page 6-4
“Share a Test File with Dependencies” on page 6-8

A test file can be simple and contain only a few test cases. For such a test file, the file
dependencies for models, test requirements, input files, callbacks, and baseline data can
be manageable. When test files become large and complex, it is difficult to track and
manage all the file dependencies. You can use Simulink projects to help manage these
dependencies. Projects are especially helpful if you want to package and share a test file.

Package a Test File Using Simulink Projects

1 In the Test Browser, right-click the test file.
2 Select Simulink Project > Create Project from Test File.

Simulink Projects opens and identifies the file dependencies of the test file. In this
example, the test file contains a test case with a requirements link, an input file, and
a baseline file.
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3 Specify project name, and verify the list of selected file dependencies.
4 Click Create.
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Find Test File Dependencies and Impact

If you have a test file saved in a Simulink project, then you can find the file
dependencies.

1 Right-click the test file. Select Simulink Project > Find Dependencies.
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Simulink Projects shows a graph of file dependencies.
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If you want to change a model or requirement, then you can find the impact that the
change could have on testing.

1 In the dependency graph, select the item that would want to assess the impact for.
2 In the Simulink Projects toolstrip, click Files > Files Impacted by Selection.
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If you want to run a test file again, then you can right-click the test file in the graph and
select Run. The Test Manager opens the test file and runs the test cases contained in it.
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Share a Test File with Dependencies

You can easily share test files that are already saved in a Simulink project. If you send
the project folder, then it contains the file dependencies for the test file.

Related Examples
• “What Are Simulink Projects?”
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Test Model Output Against a Baseline

To test the simulation output of a model against a defined baseline data set, use a
baseline test case. In this example, use the sldemo_absbrake model to compare the
simulation output to a baseline that is captured from an earlier state of the model.

Create the Test Case

1 Open the sldemo_absbrake model.
2 To open the Test Manager from the model, select Analysis > Test Manager.
3 From the Test Manager toolstrip, click New to create a test file. Name and save the

test file.

The new test file consists of a test suite that contains one baseline test case. They
appear in the Test Browser pane.

4 Right-click the baseline test case in the Test Browser pane, and select Rename.
Rename the test case to Slip Baseline Test.

5 Under System Under Test in the test case, click the Use current model button

 to load the sldemo_absbrake model into the test case.
6 Under the Baseline Criteria section, click Capture to record a baseline data set

from the model specified under System Under Test.

Save the baseline data set to a location. After you save the baseline MAT-file, the
model runs and the baseline criteria appear in the table.

7 Expand the baseline data set. Set the Absolute Tolerance of the first yout signal
to 15, which corresponds to the Ww signal.
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To add or remove columns in the baseline criteria table, click the column selector button
. For more information about tolerances and criteria, see “How Tolerances Are Applied

to Test Criteria” on page 6-49.

Run the Test Case and View Results

1 In the sldemo_absbrake model, set the Desired relative slip constant block to
0.22.

2 In the Test Manager, select the Slip Baseline Test case in the Test Browser pane.
3 On the Test Manager toolstrip, click Run to run the selected test case.

The Test Manager switches to the Results and Artifacts pane, and the new test
result appears at the top of the table.

4 Expand the results until you see the baseline criteria result.

The signal yout.Ww passes, but the overall baseline test fails because other signal
comparisons specified in the Baseline Criteria section of the test case were not
satisfied.

5 To view the yout.Ww signal comparison between the model and the baseline criteria,
expand Baseline Criteria Result and click the option button next to the
yout.Ww signal.
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The Comparison tab opens and shows the criteria comparisons for the yout.Ww
signal.
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6 You can also view signal data from the simulation. Expand Sim Output and select
the signals you want to plot.

The Visualize tab opens and plots the simulation output.

For information on how to export results and generate reports from results, see “Export
Test Results and Generate Reports” on page 7-9.
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Test a Simulation for Run-Time Errors

In this example, use a simulation test case with the sldemo_absbrake model to test for
simulation run-time errors. The pass-fail criteria used for a simulation test case is that
the simulation finishes without any errors.

Configure the Model

Configure the model to check if the stopping distance exceeds an upper bound.

1 Open the model sldemo_absbrake.
2 Add the Check Static Upper Bound block from the Model Verification library to the

model.
3 Connect the Check Static Upper Bound block to the Sd signal.
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4 In the Check Static Upper Bound block dialog box, and set Upper bound to 725.

Create the Test Case

1 To open the Test Manager, from the model, select Analysis > Test Manager.
2 To create a test file, click New. Name and save the test file.

The new test file consists of a test suite that contains one baseline test case. They
appear in the Test Browser pane.

3 Select New > Simulation Test.
4 Right-click the new simulation test case in the Test Browser pane, and select

Rename. Rename the test case to Upper Bound Test.
5 In the test case, under System Under Test, click the Use current model button

 to assign the sldemo_absbrake model to the test case.
6 Under Parameter Overrides, click Add to add a parameter set.
7

In the dialog box, click the Refresh button  to update the model parameter list.
8 Select the check box next to the workspace variable m. Click OK.
9 Double-click the Override Value and enter 55.

This value overrides the parameter value in the model when the simulation runs.

Note: To restore the default value of a parameter, clear the value in the Override
Value column and press Enter.

Run the Test Case

1 In the Test Browser pane, select the Upper Bound Test case.
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2 On the Test Manager toolstrip, click Run to run the selected test case.

The Test Manager switches to the Results and Artifacts pane, and the new test
result appears at the top of the table.

View Test Results

1 Expand the test results, and double-click Upper Bound Test.

A new tab opens that displays the outcome and results summary of the simulation
test.

2 The result shows a red X, which indicates a test failure. In this case, the model
stopping distance exceeded the upper bound of 725 and triggered an assertion from
the Check Static Upper Bound block.

Look under Errors for the details of the assertion failure.
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Generate Test Cases from Model Components

In this section...

“Generate the Test Cases” on page 6-16
“Synchronize Test Cases” on page 6-18
“Generate Test for a Subsystem” on page 6-20

The Test Manager can generate a list of test cases for you based on the components in
your model. Test cases can be generated from:

• Signal Builder block in the top model
• Test harnesses from the top model or any subsystem
• Signal Builder block at the top level of a test harness

If there are multiple Signal Builder blocks in the top model, then the Test Manager does
not create any test cases from Signal Builder blocks.

If you want to generate a test case for a model subsystem using a harness, see “Generate
Test for a Subsystem” on page 6-20.

Generate the Test Cases

1 In the Test Manager, click the New arrow and select Test File > Test File from
Model.

6-16



 Generate Test Cases from Model Components

2 In the New Test File dialog box, select the model and location. The model must be
on the MATLAB path.

3 Select the Test type to generate for all test cases.

4 Click Create.
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Synchronize Test Cases

If you add components to your model, such as Signal Builder groups or test harnesses,
you can synchronize tests by automatically creating test cases in the Test Manager.
Also, if you remove model components, then you can disable or delete test cases in the
Test Manager when you synchronize. In the Test Manager Test Browser pane, you can

synchronize your model and test file using the synchronization button  next to the test
file name.

For example, the sldemo_autotrans model has a Signal Builder block with four groups
by default. If you automatically create test cases from the model using New > Test File
> Test File from Model, then test cases are created using the Signal Builder groups.

If you add another Signal Builder group, New Signal Builder Group, and a test
harness, sldemo_autotrans_Harness1, then you can add test cases for these model
components. Synchronize the model and test file.

1 In the Test Manager, hover over the test file name that you want to synchronize.
2 Click the synchronization button  next to the test file name.
3 In the synchronization dialog box, add or remove any test cases, and select the test

case type.
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4 To complete the synchronization, click Update Test File.

In the Test Browser pane, the new test cases appear in the test file.

If you remove model components and synchronize the test file, then you can remove or
disable a test case using the Action menu. For example, if you remove New Signal

6-19



6 Test Manager Test Cases

Builder Group from the model, then the synchronization dialog box shows the deleted
Signal Builder group.

Generate Test for a Subsystem

If you want to isolate a subsystem and test it on its own, then you can create a test in
the Test Manager. If you create a test from a subsystem from the Test Manager, the
Test Manager creates a test case and a harness for the subsystem. It then assigns the
harness to the system under test. Finally, it simulates the model, records the inputs for
the harness, and assigns input and baseline data files to the test case.

To create a test from a subsystem:

1 Open a model that you want to create the test for the subsystem. In this example,
the model is sldemo_autotrans.

2 In the model, select the subsystem you want to test.
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3 In the Test Manager, from the toolstrip, click the New arrow and select Test for
Subsystem. A dialog box opens to help you create the test.

4 To use the selected subsystem in the model, in this case ShiftLogic, click the Use

currently selected subsystem button .
5 Select the test case type you want to use for this subsystem.
6 Specify the file name and path of the inputs file and baseline file, if applicable.
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7 Click Create. The Test Manager creates a test harness, logs the signals in the model
for the inputs, and simulates the model. When simulation is done, the inputs and
baseline sections of the test case are created for you.
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The Test for Subsystem feature has some limitations on logging certain Simulink
semantics and data types. The following are not supported:

• Function call
• State
• If-action
• Physical
• Merge
• Variable-size data type
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Use External Inputs in Test Cases

In this section...

“Use MAT-File for Inputs” on page 6-24
“Use Microsoft Excel File for Inputs” on page 6-24

If you have external model inputs from MAT-files or Microsoft® Excel file sheets, then
you can use these inputs in a test case. External inputs are mapped to the model using
root inport mapping under the Inputs section. You can import multiple external input
files to a test case, but you can select only one external input set to execute when the test
runs.

For more information about root inport mapping modes, supported data types or formats,
and mapping results, see “Map Root Inport Signal Data”.

Use MAT-File for Inputs

To add a MAT-file as an external input:

1 Expand the Inputs section in the test case.
2 Under the External Inputs table, click Add.
3 Specify a MAT-file.
4 Under Input Mapping, choose a mapping mode. For more information about

mapping modes, see “Map Root Inport Signal Data”.
5 Click Map Inputs. The Mapping Status table shows if the port and signals map

successfully.

For more information about troubleshooting the mapping status, see “Understand
Mapping Results”.

6 Click Apply.

Use Microsoft Excel File for Inputs

The Root Inport Mapping tool supports Microsoft Excel spreadsheets only for Windows®

systems. For Microsoft Excel spreadsheets:

• The tool interprets each worksheet as a Simulink.SimulationData.Dataset data set.
• Each worksheet name must be a valid MATLAB variable name.
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• The tool interprets the first row of a worksheet as signal names. If you do not specify
a signal name, the tool assigns a default one using the format Signal#.

• If all columns do not have signal names, the tool assigns signal names using the
format Signal#, where # increments with each additional signal.

• All signal-name columns must be filled in. If there are empty signals, the tool returns
an error at import.

• The tool interprets the first column as time. In this column, the time values must
increase.

• The tool interprets the remaining columns as signals.

To add a Microsoft Excel file as an external input:

1 Expand the Inputs section in the test case.
2 Under the External Inputs table, click Add.
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3 Specify a Microsoft Excel file.
4 Select the sheet that contains the input data.
5 If you want to use each sheet to create an input set in the table, select Create

scenarios from each sheet.
6 Under Input Mapping, choose a mapping mode. For more information about

mapping modes, see “Map Root Inport Signal Data”.
7 Click Map Inputs. The Mapping Status table shows if the port and signals map

successfully.

For more information about troubleshooting the mapping status, see “Understand
Mapping Results”.

8 Click Apply.
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Automate Tests Programmatically

In this section...

“List of Functions and Classes” on page 6-27
“Create and Run a Baseline Test Case” on page 6-28
“Create and Run an Equivalence Test Case” on page 6-29
“Run a Test Case and Collect Coverage” on page 6-30
“Create and Run Test Case Iterations” on page 6-31

List of Functions and Classes

Function Description

sltest.testmanager.view Open the Simulink Test Manager
sltest.testmanager.createTestsFromModelGenerate test cases from a model
sltest.import.sldvData Create test cases from Simulink Design

Verifier™ results
sltest.testmanager.load Load a test file in the Simulink Test

Manager
sltest.testmanager.run Run test in the Simulink Test Manager
sltest.testmanager.copyTests Copy test cases or test suites to another

location
sltest.testmanager.moveTests Move test cases or test suites to a new

location
sltest.testmanager.report Generate report of test results
sltest.testmanager.clear Clear all test files from the Simulink Test

Manager
sltest.testmanager.close Close the Simulink Test Manager
sltest.testmanager.clearResults Clear all results from the Simulink Test

Manager
sltest.testmanager.importResults Import Test Manager results file
sltest.testmanager.exportResults Export results set from Test Manager
sltest.testmanager.getResultSets Returns result set objects in Test Manager
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Class Description

sltest.testmanager.TestFile Create or modify test file
sltest.testmanager.TestSuite Create or modify test suite
sltest.testmanager.TestCase Create or modify test case
sltest.testmanager.TestIteration Create or modify test iteration
sltest.testmanager.ParameterSet Add or modify parameter set
sltest.testmanager.ParameterOverride Add or modify parameter override
sltest.testmanager.TestInput Add or modify test input
sltest.testmanager.CoverageSettings Modify coverage settings
sltest.testmanager.BaselineCriteria Add or modify baseline criteria
sltest.testmanager.EquivalenceCriteria Add or modify equivalence criteria
sltest.testmanager.SignalCriteria Add or modify signal criteria
sltest.testmanager.ResultSet Access results set data
sltest.testmanager.TestFileResult Access test file results data
sltest.testmanager.TestSuiteResult Access test suite results data
sltest.testmanager.TestCaseResult Access test case results data
sltest.testmanager.TestIterationResult Access test iteration result data
sltest.testmanager.TestResultReport Customize generated results report

Create and Run a Baseline Test Case

This example shows how to use the sltest.testmanager functions, classes, and
methods to automate tests and generate reports. You can create a test case, edit the
test case criteria, run the test case, and generate results reports programmatically. The
example compares the simulation output of the model to a baseline data set.

% Create the test file, test suite, and test case structure

tf = sltest.testmanager.TestFile('API Test File');

ts = createTestSuite(tf,'API Test Suite');

tc = createTestCase(ts,'baseline','Baseline API Test Case');

% Remove the default test suite

tsDel = getTestSuiteByName(tf,'New Test Suite 1');

remove(tsDel);
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% Assign the system under test to the test case

setProperty(tc,'Model','sldemo_absbrake');

% Capture the baseline criteria

baseline = captureBaselineCriteria(tc,'baseline_API.mat',true);

% Test a new model parameter by overriding it in the test case

% parameter set

ps = addParameterSet(tc,'Name','API Parameter Set');

po = addParameterOverride(ps,'m',55);

% Set the baseline criteria tolerance for one signal

sc = getSignalCriteria(baseline);

sc(1).AbsTol = 9;

% Run the test case and return an object with results data

ResultsObj = run(tc);

% Open the Test Manager so you can view the simulation

% output and comparison data

sltest.testmanager.view;

% Generate a report from the results data

filePath = 'test_report.pdf';

sltest.testmanager.report(ResultsObj,filePath,...

          'Author','Test Engineer',...

          'IncludeSimulationSignalPlots',true,...

          'IncludeComparisonSignalPlots',true);

The test case fails because only one of the signal comparisons between the simulation
output and the baseline criteria is within tolerance. The results report is a PDF
and opens when it is completed. For more report generation settings, see the
sltest.testmanager.report function reference page.

Create and Run an Equivalence Test Case

This example compares signal data between two simulations to test for equivalence.

% Create the test file, test suite, and test case structure

tf = sltest.testmanager.TestFile('API Test File');

ts = createTestSuite(tf,'API Test Suite');

tc = createTestCase(ts,'equivalence','Equivalence Test Case');
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% Remove the default test suite

tsDel = getTestSuiteByName(tf,'New Test Suite 1');

remove(tsDel);

% Assign the system under test to the test case

% for Simulation 1 and Simulation 2

setProperty(tc,'Model','sldemo_absbrake','SimulationIndex',1);

setProperty(tc,'Model','sldemo_absbrake','SimulationIndex',2);

% Add a parameter override to Simulation 1 and 2

ps1 = addParameterSet(tc,'Name','Parameter Set 1','SimulationIndex',1);

po1 = addParameterOverride(ps1,'Rr',1.20);

ps2 = addParameterSet(tc,'Name','Parameter Set 2','SimulationIndex',2);

po2 = addParameterOverride(ps2,'Rr',1.24);

% Capture equivalence criteria

eq = captureEquivalenceCriteria(tc);

% Set the equivalence criteria tolerance for one signal

sc = getSignalCriteria(eq);

sc(1).AbsTol = 2.2;

% Run the test case and return an object with results data

ResultsObj = run(tc);

% Open the Test Manager so you can view the simulation

% output and comparison data

sltest.testmanager.view;

In the Equivalence Criteria Result section of the Test Manager results, the yout.Ww
signal passes because of the tolerance value. The other signal comparisons do not pass,
and the overall test case fails.

Run a Test Case and Collect Coverage

This example shows how to use a simulation test case to collect coverage results. To
collect coverage, you need a Simulink Verification and Validation license.

% Create the test file, test suite, and test case structure

tf = sltest.testmanager.TestFile('API Test File');

ts = createTestSuite(tf,'API Test Suite');

tc = createTestCase(ts,'simulation','Coverage Test Case');
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% Remove the default test suite

tsDel = getTestSuiteByName(tf,'New Test Suite 1');

remove(tsDel);

% Assign the system under test to the test case

setProperty(tc,'Model','sldemo_autotrans');

% Turn on coverage settings at test-file level

cov = getCoverageSettings(tf);

cov.RecordCoverage = true;

% Enable MCDC and signal range coverage metrics

cov.MetricSettings = 'mr';

% Run the test case and return an object with results data

ro = run(tf);

% Get the coverage results

tfr = getTestFileResults(ro);

tsr = getTestSuiteResults(tfr);

tcs = getTestCaseResults(tsr);

cr = getCoverageResults(tcs);

% Open the Test Manager to view results

sltest.testmanager.view;

In the Results and Artifacts pane of the Test Manager, you can view the coverage
results in the test case result.

Create and Run Test Case Iterations

This example shows how to create test iterations. You can create table iterations
programmatically that appear in the Iterations section of a test case. The example
creates a simulation test case and assigns a Signal Builder group for each iteration.

% Create test file, test suite, and test case structure

tf = sltest.testmanager.TestFile('Iterations Test File');

ts = getTestSuites(tf);

tc = createTestCase(ts,'simulation','Simulation Iterations');

% Specify model as system under test

setProperty(tc,'Model','sldemo_autotrans');

 

% Set up table iteration
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% Create iteration object

testItr1 = sltestiteration;

% Set iteration settings

setTestParam(testItr1,'SignalBuilderGroup','Passing Maneuver');

% Add the iteration to test case

addIteration(tc,testItr1);

% Set up another table iteration

% Create iteration object

testItr2 = sltestiteration;

% Set iteration settings

setTestParam(testItr2,'SignalBuilderGroup','Coasting');

% Add the iteration to test case

addIteration(tc,testItr2);

% Run test case that contains iterations

results = run(tc);

% Get iteration results

tcResults = getTestCaseResults(results);

iterResults = getIterationResults(tcResults);

See Also
sltest.testmanager.report
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Run Multiple Combinations of Tests Using Iterations

In this section...

“Create Table Iterations” on page 6-33
“Create Scripted Iterations” on page 6-36
“Sweep Through a Set of Parameters” on page 6-39

Test Manager iterations facilitate test cases for multiple data sets. Use iterations to
test many different combinations of parameter sets, external inputs, configuration sets,
Signal Builder groups, or baseline data sets. The Iterations section of a test case enables
you to have many iterations in one centralized location.

There are two ways to set up iterations: tabled and scripted. You can use one or both
ways to create iterations in a test case. If you use iterations in a test case where you have
specified coverage settings, then the same coverage settings are applied to all iterations
in the test case.

Create Table Iterations

The Table Iterations section is a quick way to add iterations. The table makes the set of
iterations easy to view at a glance. To create iterations:

1 Add parameter sets, external inputs, configuration sets, Signal Builder groups, or
baselines to a test case if they are applicable to your tests.

2 To add an iteration to the table manually, click Add.
3 By default, the Parameter Set and External Input columns are visible in the

table. To add or remove columns, click the  button, and select a column from the
list.

4 In the iteration row, select the column cell you want to use to change the test setting.
For example, if you want to have an iteration with a parameter set, click the cell
below Parameter Set, and select the parameter set from the drop-down list.
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Auto-generated iteration combinations are ordered in lockstep. Lockstep means that
each iteration is formed using sequential pairings of test case settings. For example,
the model sldemo_autotrans has a Signal Builder block with four signal groups,
labeled in the figure as S1, S2, S3, and S4. If you use this model in a test case with
three parameter sets, labeled as P1, P2, and P3, then the Test Manager generates three
iterations. There are three iterations because generated iterations are limited to the
minimum number settings between Signal Builder groups and parameter sets, which
is three. Each iteration, labeled as I1, I2, and I3, contains one Signal Builder group
with the corresponding parameter set. The Signal Builder group and parameter set are
matched in the order that they are listed in the Signal Builder block or parameter set
section, respectively.
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In the table iterations, Default [None] means that the iteration does not change the
test case setting. The test iteration setting is the same as what is specified in the test
case.

View the Table Iterations That Will Run

To see a list of all the iterations from the table iterations section, click Show Iterations.
The list includes table iterations and scripted iterations.

Generate Table Iterations

If you have test case settings that you want to transform into test iterations, then you
can use the Auto Generate button. You can choose to generate iterations for different
test case sections. If you select multiple sections in the dialog box, then the Test Manager
combines iterations and lockstep ordering applies.

Section Option Purpose

Signal Builder Group Applies to the Inputs section of a
simulation, baseline, or equivalence test
case, for the specified Signal Builder
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Section Option Purpose

Group. Each Signal Builder group is used
to generate an iteration.

Parameter Set Applies to the Parameter Overrides
section of a simulation, baseline, or
equivalence test case. Each parameter
override set is used to generate an
iteration.

External Input Applies to the Inputs section of a
simulation, baseline, or equivalence test
case, for the specified External Inputs
data sets. Each external input set is used to
generate an iteration.

Configuration Set Applies to the Configuration Setting
Overrides section of a simulation,
baseline, or equivalence test case. Each
iteration uses the configuration setting
specified.

Baseline Applies only to baseline test case types,
specifically to the Baseline Criteria
section of a baseline test case. Each
baseline criteria data set is used to
generate an iteration.

Simulation 1 or 2 Applies only to equivalence test case
types. At the top of the Auto Generate
Reports dialog box, there is a menu for
Simulation 1 or Simulation 2. These
sections correspond to the two simulation
sections within the equivalence test case.

Create Scripted Iterations

In the scripted iterations section of the test case, you can customize your own set of
iterations using a programmatic workflow. You can define your own parameter sets,
customize the order of the iterations, create your own Monte Carlo script, and more.
Scripted iterations are generated at run time when a test executes. Enter the script into
the Scripted Iterations section text box.
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Iteration Script Components

An iteration script must have certain components to execute the tests. The basic iteration
script contains three elements: an iteration object, an iteration setting, and the iteration
registration. This script iterates over a single signal builder groups. This example is not
practical, but it is meant to illustrate the anatomy of an iteration script.

%% Iterate Using a Signal Builder Group

 

% Set up a new iteration object

testItr = sltestiteration;

% Set iteration setting using Signal Builder group

setTestParam(testItr,'SignalBuilderGroup',sltest_signalBuilderGroups{1});

% Add the iteration to run in this test case

% The predefined sltest_testCase variable is used here

addIteration(sltest_testCase,testItr);

For more information about the test iteration class, see sltest.testmanager.TestIteration.
In practice, you iterate over numerous settings, such as multiple Signal Builder groups.
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If you take the stripped-down iteration script and put it into a loop, you can iterate over
all Signal Builder groups in the test case.

%% Iterate Over All Signal Builder Groups

 

% Determine the number of possible iterations

numSteps = length(sltest_signalBuilderGroups);

 

% Create each iteration

for k = 1 : numSteps

    % Set up a new iteration object

    testItr = sltestiteration;

 

    % Set iteration settings

    setTestParam(testItr,'SignalBuilderGroup',sltest_signalBuilderGroups{k});

 

    % Add the iteration to run in this test case

    % You can pass in an optional iteration name

    addIteration(sltest_testCase,testItr);

end

Predefined Variables

You can use predefined variables to write iterations scripts. To see the list of predefined
variables in the Test Manager, expand the Help on creating test iterations section.
You write the iterations script in the script box within the Scripted Iterations section.
The script box is a functional workspace, which means the MATLAB base workspace
cannot access information from the script box. If you define variables in the script box,
then other workspaces cannot use the variable.

The predefined variables are:

• sltest_bdroot — Model simulated by the test case, defined as a string
• sltest_sut — The System Under Test, defined as a string
• sltest_isharness — true if sltest_bdroot is a harness model, defined as a

logical
• sltest_externalInputs — Name of external inputs, defined as a cell array of

strings
• sltest_parameterSets — Name of parameter override sets, defined as a cell array

of strings
• sltest_configSets — Name of configuration settings, defined as a cell array of

strings
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• sltest_tableIterations — Iteration objects created in the iterations table,
defined as a cell array of sltest.testmanager.TestIteration objects

• sltest_testCase — Current test case object, defined as an
sltest.testmanager.TestCase object

Scripted Iteration Templates

You can quickly generate iterations for your test case using templates for Signal Builder
groups, parameter sets, external inputs, configuration sets, and baseline sets, if you
are using a baseline test case. Scripted iteration templates follow lockstep ordering and
pairing of test settings. For more information about lockstep ordering, see “Create Table
Iterations” on page 6-33.

For example, if you want to run all signal builder groups in a scripted iteration:

1 Click Iteration Templates.
2 Select the test case settings you want to iterate through. Click OK.

The script is generated and added to the script box below any existing scripts.
3 To generate a table that gives a preview of all the iterations that execute when you

run the test case, click Show Iterations.

Sweep Through a Set of Parameters

Scripted iterations can be used to test a model by sweeping through a set of parameters.
In this example of a parameter sweep, the number of Signal Builder groups and
parameter values is the same. Each iteration has one Signal Builder group and one
parameter value for a total of four iterations.

%% Iterate over all Signal Builder Groups and Parameters

 

% Determine the number of possible iterations

numSteps = length(sltest_signalBuilderGroups);

% Set up the parameter values to sweep over

IeiValues = [0.021,0.022,0.022,0.023];

% Create each iteration

for k = 1 : numSteps

    % Set up a new iteration object

    testItr = sltestiteration;
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    % Set Signal Builder iteration setting

    setTestParam(testItr,'SignalBuilderGroup',sltest_signalBuilderGroups{k});

    

    % Set value of lei (parameter in model workspace)

    setVariable(testItr,'Name','Iei','Source','model workspace',...

                'Value',IeiValues(k));

 

    % Add the iteration to run in this test case

    addIteration(sltest_testCase,testItr); 

end

See Also
sltest.testmanager.TestIteration

Related Examples
• “Automate Tests Programmatically” on page 6-27
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Collect Coverage in Tests

If you use Simulink Verification and Validation to generate model and code coverage,
then you can also apply coverage collection to your test cases. If you turn on coverage
collection in a test file, test suite, or test case, then the test case runs in the Test
Manager, collects coverage, and generates an aggregated report of the coverage in the
test results.

For example, to test a model for coverage, turn on coverage at the test-file, test-suite,
or the individual test-case level. If you set coverage settings at the test-file level, then
the test suite and test cases in the test file inherit the coverage settings. At the test case
and test-suite level, you can turn coverage collection on or off, but you cannot adjust the
coverage metrics if they are specified at the test-file level.

To turn on and collect coverage at a test-file level:

1 Select the test file in the Test Browser pane.

2 Expand the Coverage Settings section in the test file and select Record coverage
for system under test. If you have referenced model that you want to collect
coverage for, then select Record coverage for referenced models.
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3 Select the coverage metrics you want to collect when the test cases in the test file
execute. For more information about the types of model coverage, see “Types of
Model Coverage”.

4 Run the test file.
5 To view the collected coverage results, select a test case result in the Results and

Artifacts pane.

In this example, there is a test case that contains iterations for a Signal Builder
block. Each iteration has coverage results.
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6 To view the coverage data, expand the Coverage Results section of the test case
result.

7 Select the result to view the aggregated coverage for a test case, test suite, or test
file.
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8 To view the coverage data, expand the Aggregated Coverage Results section of
the test file result. At the test suite and test file result level, the coverage is grouped
and aggregated by model.

9 To view the coverage results graphically in the model, select the model name link in
the coverage results table.
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Once the model opens, you can select parts of the model to see the coverage data.

To view the coverage results programmatically, see “Automate Tests Programmatically”
on page 6-27 and the sltest.testmanager.CoverageSettings class.
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See Also
“Specify Model Coverage Options”
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Run Tests Using Parallel Execution
In this section...

“Use Parallel Execution” on page 6-47
“When Will Tests Benefit from Using Parallel Execution?” on page 6-47

If you have a license to Parallel Computing Toolbox, then you can execute tests in
parallel using a parallel pool (parpool). Running tests in parallel can speed up execution
and decrease the amount of time it takes to get test results.

Use Parallel Execution

To run a test file using parallel execution:

1 The Test Manager uses the default Parallel Computing Toolbox cluster. For
information about where to specify or change the cluster, see “Clusters and Cluster
Profiles”.

2 On the Test Manager toolstrip, click the Parallel button.

3 Run a test file. The test file executes using parallel pool.
4 To turn off parallel execution, click the Parallel button to toggle it off.

Starting a parallel pool can take time, which would slow down test execution. To reduce
time:

• Make sure that the parallel pool is already running before you run a test. By default,
the parallel pool shuts down after being idle for a specified number of minutes. To
change the setting, see “Specify Your Parallel Preferences”.

• Load Simulink on all the parallel pool workers.

When Will Tests Benefit from Using Parallel Execution?

In general, parallel execution can help reduce test execution time if you have
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• A complex Simulink model that takes a long time to simulate.
• A large number of long-running tests, such as iterations.

See Also
sltest.testmanager.run

Related Examples
• “Clusters and Clouds”
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How Tolerances Are Applied to Test Criteria

Tolerances can be specified in the Baseline Criteria or Equivalence Criteria sections
of test cases. The default value for the relative tolerance and absolute tolerance for a
signal comparison is zero. If you specify tolerances, then the test calculates the tolerances
as follows:

tolerance = max(absoluteTolerance,relativeTolerance*abs(baselineData));

The more lenient tolerance is used to determine the pass-fail outcome of the criteria
comparison.

Modify Criteria Tolerances

You can change the criteria tolerances in the Baseline Criteria or Equivalence
Criteria sections of baseline or equivalence test cases, respectively. To modify a
tolerance, select the signal name in the criteria table and double-click the tolerance
value.

If you modify a tolerance after a test case has been run, then rerun the test case to apply
the new tolerance value to the pass-fail results.
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Test Manager Limitations

In this section...

“Simulation Mode” on page 6-50
“Callback Scripts” on page 6-50
“Protected Models” on page 6-50
“Parameter Overrides” on page 6-51
“Breakpoints” on page 6-51
“Highlight in Model” on page 6-51

Simulation Mode

There are some limitations for the simulation mode in test cases:

• The System Under Test cannot be in fast restart or external mode for test execution.
• A test that is running with the System Under Test simulation mode set to Rapid

Accelerator cannot be stopped using Stop on the Test Manager toolstrip. To stop the
test, enter Ctrl+c in the MATLAB command prompt.

• If you run a test using parallel execution in rapid accelerator mode, streamed signals
do not show up in the Test Manager.

Callback Scripts

The test case callback scripts are not stored with the model and do not override Simulink
model callbacks. Test case callback scripts have some limitations:

• The Test Manager cannot stop the execution of an infinite loop inside a callback
script. To stop execution of an infinite loop from a callback script, press Ctrl+c in the
MATLAB command prompt.

• sltest.testmanager functions are not supported.

Protected Models

You cannot specify a protected model as the model used for a test case in the System
Under Test section.
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Parameter Overrides

The Test Manager displays only top-level system parameters from the system under test.

Breakpoints

Breakpoints in Simulink and Stateflow are not supported and interrupt test execution
without warning.

Highlight in Model

If you use parallel test execution to run your tests, then you cannot use the Highlight in
Model button for verify signals.
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Test Sections

In this section...

“Tags” on page 6-53
“Description” on page 6-53
“Requirements” on page 6-54
“System Under Test” on page 6-54
“Parameter Overrides” on page 6-55
“Callbacks” on page 6-56
“Inputs” on page 6-57
“Outputs” on page 6-57
“Configuration Settings” on page 6-57
“Simulation 1 and Simulation 2” on page 6-57
“Equivalence Criteria” on page 6-58
“Baseline Criteria” on page 6-58
“Custom Criteria” on page 6-59
“Iterations” on page 6-59
“Coverage Settings” on page 6-59

Information about the test case sections is outlined here. Double-click a test case in the
Test Browser pane to open a tab and view all the test case sections. A baseline test
case is shown as an example. For more information on which test case to use for your
application, see “Introduction to the Test Manager” on page 5-2.
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If a box or list in the test case shows a warning icon , then it is a required field in
order for the test case to run.

Tags

Tag your tests with useful categorizations, such as safety, logged-data, or burn-
in. Filter tests using these tags when executing tests or viewing results. See “Filter Test
Execution and Results” on page 6-83.

Description

To add descriptive text to your test case, test suite, or test file, expand the section and
double-click the text box below Description.
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Requirements

You can create, edit, and delete requirements traceability links for a test case, test
suite, or test file in the Requirements section if you have a Simulink Verification and
Validation license. To add requirements links:

1
Click the Add button .

2 In the Link Editor dialog box, click New to add a requirement link to the list.
3 Type the name of the requirement link in the Description box.
4 Click Browse and locate the requirement file. Click Open. For more information on

supported requirements document types, see “Supported Requirements Document
Types”.

5 Click OK. The requirement link appears in the Requirements list if a document is
specified in the Link Editor.

If you have a section of a document open and ready to add as a requirement, then you
can add it quickly. Highlight the section you want to add as a requirement, click the Add
button arrow, and select the section type.

For more information about the Link Editor, see “Requirements Traceability Link
Editor”.

System Under Test

Specify the model you want to test in the System Under Test section. To use the

current model that is in focus, click the Use current model button .

Note: The model must be available on the path to run the test case. You can set the path
programmatically using the pre-load callback. See “Callbacks” on page 6-56.

Specifying a new model in the System Under Test section can cause the model
information to be obsolete. To update the model test harnesses,Signal Builder groups,

and available configuration sets, click the Refresh button .
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Test Harness

If you have a test harness in your system under test, then you can select the test harness
to be used for the test case. If a test harness has been added or removed from a model,

click the Refresh button  to view the updated test harness list.

For more information about using test harnesses, see “Refine, Test, and Debug a
Subsystem” on page 2-15.

Simulation Settings

You can override the System Under Test simulation settings such as the simulation
mode, start time, stop time, and initial state.

Parameter Overrides

You can specify parameter values in the test case to override the parameter values in
the model workspace, data dictionary, or base workspace in the Parameter Overrides
section. Parameters are grouped into sets. Parameter sets and individual parameters
overrides can be turned on or off by selecting or clearing the check box next to the set or
parameter. To add a parameter override:

1 Click Add.

A dialog box opens with a list of parameters. If the list of parameters is not current,

press the Refresh button  in the dialog box to update the list.
2 Select the parameter you want to override.
3 Click OK to add the parameter to the parameter set.
4 Enter the override value in the parameter Override Value column.

To restore the default value of a parameter, clear the value in the Override Value
column and press Enter.

You can also add a set of parameter overrides from a MAT-file. Click the Add arrow and
select Add File to create a parameter set from a MAT-file.

For an example about parameter overrides, see “Overriding Model Parameters in a Test
Case”.
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Callbacks

Test-File Level Callbacks

There are two callback scripts available in each test suite that execute at different times
during a test:

• Setup: runs before test file executes.
• Cleanup: runs after test file executes.

Test-Suite Level Callbacks

There are two callback scripts available in each test suite that execute at different times
during a test:

• Setup: runs before the test suite executes.
• Cleanup: runs after the test suite executes.

Test-Case Level Callbacks

There are three callback scripts available in each test case that execute at different times
during a test:

• Pre-load: runs before the model loads and any model callbacks.
• Post-load: runs after the model loads and the PostLoadFcn model callback.
• Cleanup: runs after simulations and all model callbacks.

Click the Run button  next to Pre-Load, Post-Load, or Cleanup to run only that
callback script.

See “Test Manager Limitations” on page 6-50 for the limitations of callback scripts inside
test cases. For information on Simulink model callbacks, see “Model Callbacks”.

There are predefined variables available to you in the test case callbacks:

• sltest_bdroot available in Post-Load: The model simulated by the test case. The
model can be a harness model.

• sltest_sut available in Post-Load: The system under test. For a harness, it is the
component under test.
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• sltest_isharness available in Post-Load: Returns true if sltest_bdroot is a
harness model.

• sltest_simout available in Cleanup: Simulation output produced by simulation.
• sltest_iterationName available in Pre-Load, Post-Load, and Cleanup: Name

of the currently executing test iteration.

Inputs

You can override inputs to your System Under Test. You can use inputs from signal
builder groups in the model, or you can use external inputs from MAT-files or Microsoft
Excel files. You can use only one external input set in the External Inputs table to run
when the test case executes. External inputs are mapped using root inport mapping. See
“Identify Signal Data to Import and Map” for more information on supported file formats.

For an example of how to use external inputs, see “Use External Inputs in Test Cases” on
page 6-24. For more information on the Root Inport Mapping tool, see “Map Root Inport
Signal Data”.

If you use Microsoft Excel files for inport mapping, then the Root Inport Mapping tool can
map only double-precision scalar values from the file.

Outputs

You can override model output settings. These settings are the same settings found in
the Data Import/Export pane of the Model Configuration Parameters.

Configuration Settings

You can override the System Under Test configuration settings.

Note: If you have selected Override model settings in the Outputs section, then these
settings override the output settings in the configuration settings.

Simulation 1 and Simulation 2

The Simulation 1 and Simulation 2 sections in the equivalence test case are the same
templates. The system under test from Simulation 1 and Simulation 2 are compared to
each other using the signal data defined under Equivalence Criteria.
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Equivalence Criteria

This test case section is only contained in an equivalence test case. The equivalence
criteria is a set of signal data that is compared between Simulation 1 and Simulation
2 in an equivalence test case. You can specify both absolute and relative tolerances for
individual signals or the entire criteria set. Tolerances can be specified in this section to
regulate pass-fail criteria of the test.

Click Capture to run the system under test in Simulation 1 and identify signals
for equivalence criteria. Signals in the model marked for streaming and logging are
captured.

Note: If you stream the same signal in the system under test of Simulation 1 and
Simulation 2, and do not capture any equivalence criteria, then the streamed signals
are compared in the equivalence criteria result. However, if you do capture equivalence
criteria and no signals are selected, then nothing is compared when the test case
executes.

For an example about how to use an equivalence test case and criteria, see “Test Two
Simulations for Equivalence”.

Baseline Criteria

This test case section is only contained in a baseline test case. You can use signal
data from a MAT-file or Microsoft Excel file. Microsoft Excel files must use the same
formatting as specified by the Root Inport Mapping tool. For more information, see
“Map Root Inport Signal Data”. Only the first sheet of the Microsoft Excel file is read for
baseline criteria.

To capture streamed and logged signal data from the System Under Test, click
Capture to compile and run the system. You are asked to save the signal data to a MAT-
file.

Tolerances can be specified in this section to determine the pass-fail criteria of the test
case. You can specify both absolute and relative tolerances for individual signals or the
entire baseline criteria set. When the baseline test case executes, signals in the model
marked for streaming and logging are captured and compared to the baseline criteria. To
see tolerances used in an example for baseline criteria, see “Test Model Output Against a
Baseline” on page 6-9.
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Custom Criteria

This section provides an embedded MATLAB editor to define custom pass/fail criteria
for your test. Select function customCriteria(test) to enable the criteria script in
the editor. Custom criteria operate outside of model run time; the script evaluates after
model simulation.

Common uses of custom criteria include verifying signal characteristics or verifying
conditions that ensure your test is valid. MATLAB Unit Test qualifications provide a
framework for verification criteria. For example, this custom criteria script gets the last
value of the signal PhiRef and verifies that it equals 0:

% Get the last value of PhiRef from the dataset Signals_Req1_3

lastValue = test.sltest_simout.get('Signals_Req1_3').get('PhiRef').Values.Data(end);

% Verify that the last value equals 0

test.verifyEqual(lastValue,0);

See “Apply Custom Criteria to Test Cases” on page 6-63. For a list of MATLAB Unit
Test qualifications, see “Types of Qualifications”.

Iterations

This test case section is used to generate test iterations for multiple combinations of
test settings. Iterations are helpful for Monte Carlo or parameter sweep tests. For
more information about test iterations, see “Run Multiple Combinations of Tests Using
Iterations” on page 6-33.

Coverage Settings

This test section lets you configure coverage collection for test files, test suites, and test
cases. For more information about collecting coverage in your test, see “Collect Coverage
in Tests” on page 6-41.
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Test Models Using Inputs Generated by Simulink Design Verifier

In this section...

“Overall Workflow” on page 6-60
“Test Case Generation Example” on page 6-60

Using Simulink Design Verifier, you can generate tests that replicate design errors,
achieve test objectives, or exercise your model to meet coverage criteria. Over the course
of developing your model and generating code, you repeatedly exercise your model and
code with these test inputs. You can simplify repeated testing using Simulink Test to
automatically create test cases that use inputs generated using Simulink Design Verifier
analysis.

Overall Workflow

Test case generation follows this workflow.

1 Choose an existing Simulink Design Verifier results file, or generate new results by
analyzing your model.

• If you use an existing results file, you can load results by either:

• Using the Simulink Test command sltest.import.sldvData.
• Using Simulink Design Verifier menu items. In the model, select Analysis

> Design Verifier > Results > Load. Select the MAT file with the analysis
results.

• If you run a model analysis, the Design Verifier Results Summary window
appears after the analysis completes.

2 In the results summary window, click Export test cases to Simulink Test.
3 Select an existing test harness, or create a test harness.
4 Simulink Test generates the test file and test harness. In the Test Manager, expand

the new test file in the Test Browser to see the individual test cases.

Test Case Generation Example

This example shows how to generate test cases to achieve coverage objectives for a
controller subsystem. It also shows how to add functional test cases from test harnesses
in the model. The example requires a Simulink Design Verifier license.
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The model is a closed-loop heat pump system. The controller accepts the measured room
temperature and set temperature inputs. The controller outputs a bus of three signals
controlling the fan, heat pump, and the direction of the heat pump (heat or cool). The
model contains a harness that tests heating and cooling scenarios.

1 Open the model.

open_system(fullfile(docroot,'toolbox','sltest','examples',...

'sltestTestCaseFromDVExample.slx'));

2 Set the current working folder to a writable folder.
3 In the model, generate tests for the Controller subsystem. Right-click the Controller

block and select Design Verifier > Generate Tests for Subsystem.

Simulink Design Verifier generates tests for the component.
4 In the Results Summary window, click Export test cases to Simulink Test.
5 In the Harness Selection dialog box, select New Harness. Click OK.

The Test Manager displays a new test case with several iterations.

6 Click the harness badge to preview the new test harness.
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7 Add a test case to the Requirement2 test harness in the model. In the Test
Manager, hover over the new test file name and click the Synchronize Test File

button .
8 The Test Manager prompts you to add tests for the Requirement2 test harness.

Select Simulation for the test type, and click Update Test File.

The Test Manager adds the Requirement2 test case to the test file.

See Also
sltest.import.sldvData
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Apply Custom Criteria to Test Cases

In this section...

“MATLAB Testing Framework” on page 6-63
“Define a Custom Criteria Script” on page 6-64
“Reuse Custom Criteria and Debug Using Breakpoints” on page 6-64
“Assess the Damping Ratio of a Flutter Suppression System” on page 6-67
“Custom Criteria Programmatic Interface Example” on page 6-72

Testing your model often requires assessing conditions that ensure a test is valid, in
addition to verifying model behavior. MATLAB Unit Test provides a framework for
such assessments. In Simulink Test, you can use the test case custom criteria to author
specific assessments, and include MATLAB Unit Test qualifications in your script.

Custom criteria apply as post-simulation criteria to the simulation output. If you require
run-time verifications, use a verify() statement in a Test Assessment or Test Sequence
block. See “Assess Simulation Using Logical Statements” on page 3-25.

MATLAB Testing Framework

A custom criteria script is a method of test, which is a matlab.unittest test case
object. To enable the function, in the test case Custom Criteria section of the Test
Manager, select function customCriteria(test). Inside the function, enter the custom
criteria script in the embedded MATLAB editor.

The embedded MATLAB editor lists properties of test. Create test assessments using
MATLAB Unit Test qualifications. Custom criteria supports verification and assertion
type qualifications. See “Types of Qualifications”. Verifications and assertions operate
differently when custom criteria are evaluated:

• Verifications – Failures appear in the test results and other assessments are
evaluated. Use verifications for general assessments, such as checking simulation
against expected outputs.

Example: test.verifyEqual(lastValue,0)
• Assertions – Use assertions for conditions that render the criteria invalid. Failures

appear in the test results and the custom criteria script evaluation exits.

Example: test.assertEqual(lastValue,0).
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Define a Custom Criteria Script

This example shows how to create a custom criteria script for an autopilot test case.

1 Open the test file.

open AutopilotTestFile.mldatx

2 In the Test Browser, select AutopilotTestFile > Basic Design Test Cases >
Requirement 1.3 Test. In the test case, expand the Custom Criteria section.

3 Enable the custom criteria script by selecting function customCriteria(test).
4 In the embedded MATLAB editor, enter the following script. The script gets the final

value of the signals Phi and APEng, and verifies that the final values equal 0.

% Get the last values

lastPhi = test.sltest_simout.get('Signals_Req1_3').get('Phi').Values.Data(end);

lastAPEng = test.sltest_simout.get('Signals_Req1_3').get('APEng').Values.Data(end);

% Verify the last values equal 0

test.verifyEqual(lastPhi,0,['Final Phi value: ',num2str(lastPhi),'.']);

test.verifyEqual(lastAPEng,false,['Final APEng value: ',num2str(lastAPEng),'.']);

5 Run the test case.
6 In the Results and Artifacts pane, expand the Custom Criteria Result. Both

criteria pass.

Reuse Custom Criteria and Debug Using Breakpoints

In addition to authoring criteria scripts in the embedded MATLAB editor, you can author
custom criteria in a standalone function, and call the function from the test case. Using a
standalone function allows you
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• To reuse the custom criteria in multiple test cases.
• To set breakpoints in the criteria script for debugging.
• To investigate the simulation output using the command line.

In this example, you add a breakpoint to a custom criteria script. You run the test case,
list the properties of the test object at the command line, and call the custom criteria
from the test case.

Call Custom Criteria Script from the Test Case

1 Navigate to the folder containing the criteria function.

cd(fullfile(docroot,'toolbox','sltest','examples'))

2 Open the custom criteria script

open('sltestCheckFinalRollRefValues.m')

% This is a custom criteria function for a Smiulink Test test case.

% The function gets the last values of Phi and APEng from the 

% Requirements 1.3 test case in the test file AutopilotTestFile.

function sltestCheckFinalRollRefValues(test)

% Get the last values

lastPhi = test.sltest_simout.get('Signals_Req1_3').get('Phi').Values.Data(end)

lastAPEng = test.sltest_simout.get('Signals_Req1_3').get('APEng').Values.Data(end)

% Verify the last values equal 0

test.verifyEqual(lastPhi,0,['Final Phi value: ',num2str(lastPhi),'.']);

test.verifyEqual(lastAPEng,false,['Final APEng value: ',num2str(lastAPEng),'.']);

3 Open the test file

open AutopilotTestFile.mldatx

4 In the embedded MATLAB editor under Custom Criteria, enter the function call to
the custom criteria:

sltestCheckFinalRollRefValues(test)

Set Breakpoints and List test Properties

1 On line 8 of sltestCheckFinalRollRefValues.m, set a breakpoint by clicking the
dash to the right of the line number.
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2 In the Test Manager, run the test case.

The command window displays a debugging prompt.
3 Enter test at the command prompt to display the properties of the

STMCustomCriteria object. The properties contain characteristics and simulation
data output of the test case.

test = 

  STMCustomCriteria with properties:

              TestResult: [1×1 sltest.testmanager.TestCaseResult]

                  sltest_simout: [1×1 Simulink.SimulationOutput]

         sltest_testCase: [1×1 sltest.testmanager.TestCase]

           sltest_bdroot: {'RollReference_Requirement1_3'}

              sltest_sut: {'RollAutopilotMdlRef/Roll Reference'}

        sltest_isharness: 1

    sltest_iterationName: ''

The property sltest_simout contains the simulation data. To view the data
PhiRef, enter

test.sltest_simout.get('Signals_Req1_3').get('PhiRef')

ans = 

  Simulink.SimulationData.Signal

  Package: Simulink.SimulationData

  Properties:

  struct with fields:

              Name: 'PhiRef'

    PropagatedName: ''

         BlockPath: [1×1 Simulink.SimulationData.BlockPath]

          PortType: 'outport'

         PortIndex: 1

            Values: [1×1 timeseries]

4 In the MATLAB editor, click Continue to continue running the custom criteria
script.

5 In the Results and Artifacts pane, expand the Custom Criteria Result. Both
criteria pass.
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6 To reuse the script in another test case, call the function from the test case custom
criteria.

Assess the Damping Ratio of a Flutter Suppression System

Use a custom criteria script to verify the damping ratio in a test case that simulates the
flutter suppression system of a wing.

The Simulation and Model

The model uses Simscape™ to simulate a Benchmark Active Controls Technology
(BACT) / Pitch and Plunge Apparatus (PAPA) setup. It uses Aerospace Blockset™ to
simulate arodynamic forces on the wing.

The test iterates over 16 combinations of Mach and Altitude. The test case uses custom
criteria with Curve Fitting Toolbox™ to find the peaks of the wing pitch, and determine
the damping ratio. If the damping ratio is not greater than zero, the assessment fails.

Running this test case requires

• Simulink® Test™
• Simscape Multibody™
• Aerospace Blockset™
• Curve Fitting Toolbox™

Open the model and the test file.

open_system(fullfile(matlabroot,'examples','simulinktest',...

    'sltestFlutterSuppressionSystemExample.slx'))
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open(fullfile(matlabroot,'examples','simulinktest',...

    'sltestFlutterCriteriaTest.mldatx'))

Custom Criteria Script

The test case custom criteria uses this script to verify that the damping ratio is greater
than zero.

% Get time and data for pitch

Time = test.SimOut.get('sigsOut').get('pitch').Values.Time(1:15000);

Data = test.SimOut.get('sigsOut').get('pitch').Values.Data(1:15000);

% Find peaks

[~, peakIds] = findpeaks(Data,'minpeakheight', 0.002, 'minpeakdistance', 50);

peakTime= Time(peakIds);

peakPos = Data(peakIds);

rn = peakPos(1)./peakPos(2:end);

L = 1:length(rn);

% Do curve fitting
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fittedModel = exponentialFitAndPlot(L, rn);

delta = fittedModel.d;

% Find damping ratio

dRatio = delta/sqrt((2*pi)^2+delta^2);

% Make sure damping ratio is greater than 0

test.verifyGreaterThan(dRatio,0,'Damping ratio must be greater than 0');

Test Results

Running the test case returns two conditions in which the damping ratio is greater than
zero.

results = sltest.testmanager.run

results = 

  ResultSet with properties:

                   Name: 'Results: 2016-Aug-30 14:28:04'

              NumPassed: 14

              NumFailed: 2

            NumDisabled: 0

          NumIncomplete: 0

               NumTotal: 16

     NumTestCaseResults: 0

    NumTestSuiteResults: 0

     NumTestFileResults: 1

                Outcome: Failed

              StartTime: '2016-Aug-30 14:28:04'

               StopTime: '2016-Aug-30 14:30:14'

               Duration: 130

        CoverageResults: []
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The wing pitch plots from iteration 12 and 13 show the difference between a positive
damping ratio (iteration 12) and a negative damping ratio (iteration 13).
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sltest.testmanager.close
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close_system('sltestFlutterSuppressionSystemExample.slx',0)

Custom Criteria Programmatic Interface Example

This example shows how to set and get custom criteria using the programmatic interface.

Before running this example, temporarily disable warnings that result from verification
failures.

warning off Stateflow:Runtime:TestVerificationFailed;

warning off Stateflow:cdr:VerifyDangerousComparison;

Load a Test File and Get Test Case Object

tf = sltest.testmanager.load('AutopilotTestFile.mldatx');

ts = getTestSuiteByName(tf,'Basic Design Test Cases');

tc = getTestCaseByName(ts,'Requirement 1.3 Test');

Create the Custom Criteria Object and Set Criteria

Create the custom criteria object.

tcCriteria = getCustomCriteria(tc)

tcCriteria = 

  CustomCriteria with properties:

     Enabled: 0

    Callback: '% test: An object of type matlab.unittest.TestCase...'

Create the custom criteria expression. This script gets the last value of the signal Phi
and verifies that it equals 0.

criteria = ...

    sprintf(['lastPhi = test.sltest_simout.get(''Signals_Req1_3'')',...

 '.get(''Phi'').Values.Data(end);\n',...

 'test.verifyEqual(lastPhi,0,[''Final: '',num2str(lastPhi),''.'']);'])
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criteria =

lastPhi = test.sltest_simout.get('Signals_Req1_3').get('Phi').Values.Data(end);

test.verifyEqual(lastPhi,0,['Final: ',num2str(lastPhi),'.']);

Set and enable the criteria.

tcCriteria.Callback = criteria;

tcCriteria.Enabled = true;

Run the Test Case and Get the Results

Run the test case.

tcResultSet = run(tc);

Get the test case results.

tcResult = getTestCaseResults(tcResultSet);

Get the custom criteria result.

ccResult = getCustomCriteriaResult(tcResult)

ccResult = 

  CustomCriteriaResult with properties:

             Outcome: Passed

    DiagnosticRecord: [1×1 sltest.testmanager.DiagnosticRecord]

Restore warnings from verification failures.

warning on Stateflow:Runtime:TestVerificationFailed;

warning on Stateflow:cdr:VerifyDangerousComparison;

sltest.testmanager.clearResults

sltest.testmanager.clear

sltest.testmanager.close

Related Examples
• “Test Models Using MATLAB Unit Test” on page 6-74
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Test Models Using MATLAB Unit Test

You can use the MATLAB Unit Test framework to run tests authored in Simulink Test.
Using the MATLAB Unit Test framework:

• Allows you to execute model tests together with MATLAB Unit Test scripts, functions,
and classes.

• Enables model and code testing using the same framework.
• Enables integration with continuous integration (CI) systems, such as Jenkins™.

To use MATLAB Unit Test, create a TestSuite from the Simulink Test file. To customize
the test execution, such as for CI, create a TestRunner. Running the test produces a
TestResult object. For CI, running the test can also stream results to a file.

In this section...

“Considerations” on page 6-74
“Basic Workflow Using MATLAB® Unit Test” on page 6-74
“Comparison of Test Nomenclature” on page 6-76
“Test a Model for Continuous Integration Systems” on page 6-77

Considerations

When running tests using MATLAB Unit Test, consider the following:

• Test hierarchy from Simulink Test is not converted by MATLAB Unit Test. All tests
in a TestSuite are contained in a flat hierarchy.

• If you disable a test in the Test Manager, the test is filtered using MATLAB Unit
Test, and the result reflects a failed assumption.

• Fast restart is not supported for the MATLAB Unit Test framework.

Basic Workflow Using MATLAB® Unit Test

This example shows how to create and run a basic MATLAB® Unit Test for a test file
created in Simulink® Test™. You create a test suite, run the test, and display the
diagnostic report.
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1. Author a test file in the Test Manager, or start with a preexisting test file. For this
example, AutopilotTestFile tests a component of an autopilot system against several
requirements, using verify statements.

2. Create a TestSuite from the test file.

apsuite = testsuite('AutopilotTestFile.mldatx');

apsuite

apsuite = 

  Test with properties:

                  Name: 'AutopilotTestFile > Basic Design Test Cases/Requi...'

            BaseFolder: 'T:\37\jdirner.Blcmdacore.j411809\matlab\toolbox\s...'

      Parameterization: [0×0 matlab.unittest.parameters.EmptyParameter]

    SharedTestFixtures: [0×0 matlab.unittest.fixtures.EmptyFixture]

                  Tags: {1×0 cell}

Tests Include:

   0 Parameterizations, 0 Shared Test Fixture Classes, 0 Tags.

3. Run the test, creating a TestResult object. The command window returns warnings
from the verify statement failures.

apresults = run(apsuite);

Running AutopilotTestFile > Basic Design Test Cases

================================================================================

Verification failed in AutopilotTestFile > Basic Design Test Cases/Requirement 1.3 Test.

    ---------------------

    Framework Diagnostic:

    ---------------------

    Failed criteria: Baseline, Verification

================================================================================

.

Done AutopilotTestFile > Basic Design Test Cases

__________

Failure Summary:

6-75



6 Test Manager Test Cases

     Name                                                              Failed  Incomplete  Reason(s)

    ===============================================================================================================

     AutopilotTestFile > Basic Design Test Cases/Requirement 1.3 Test    X                 Failed by verification.

    

4. To view the details of the test, display the Report property of the DiagnosticRecord
object. The record shows that a verification failed during the test.

apresults.Details.DiagnosticRecord.Report

ans =

================================================================================

Verification failed in AutopilotTestFile > Basic Design Test Cases/Requirement 1.3 Test.

    ---------------------

    Framework Diagnostic:

    ---------------------

    Failed criteria: Baseline, Verification

================================================================================

Comparison of Test Nomenclature

MATLAB Unit Test has analogous properties to the functionality in Simulink Test. For
example,

• If the test case contains iterations, the MATLAB Unit Test contains
parameterizations.

• If the test file or test suite contains callbacks, the MATLAB Unit Test contains one or
more callbacks fixtures.

Test Case Iterations and MATLAB Unit Test Parameterizations

Parameterization details correspond to properties of the iteration.

Simulink Test MATLAB Unit Test

Iteration type: Scripted Parameterization property:
ScriptedIteration
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Simulink Test MATLAB Unit Test

Iteration type: Table Parameterization property:
TabledIteration

Iteration name Parameterization Name
Test case iteration object Parameterization Value

Test Callbacks and MATLAB Unit Test Fixtures

Fixtures depend on callbacks contained in the test file. Fixtures do not include test case
callbacks, which are executed with the test case itself.

Callbacks in Simulink Test Fixtures in MATLAB Unit Test

Test file callbacks FileCallbacksFixture

Test suite callbacks SuiteCallbacksFixture

File and suite callbacks Heterogeneous CallbacksFixture,
containing FileCallbacksFixture and
SuiteCallbacksFixture

No callbacks No fixture

Test a Model for Continuous Integration Systems

This example shows how to use MATLAB® Unit Test to test a model, and use the
TAPPlugin to create TAP results. You can use TAP with CI systems. The model is a
controller-plant system of a flight controller, aircraft model, and environment model.

Create a test suite and a test runner, and customize the runner with the plugin that
creates the TAP file. When you run the test, it fails on several iterations. The results are
written to the TAP file.

Before performing this example, set the working directory to a writable location on the
path.

1. Open the Model

open_system(fullfile(matlabroot,'examples','simulinktest','sltestF14ParameterSweep.slx'))
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2. Open the Test File

The test case creates a square wave input to the controller, and sweeps through 25
iterations of the parameters a and b. It compares the alpha output to a baseline with a
tolerance of 0.0046 and fails any output which exceeds this tolerance.

sltest.testmanager.view;

sltest.testmanager.load(fullfile(matlabroot,'examples','simulinktest',...

    'f14ParameterSweepTest.mldatx'));

3. Import the TestRunner, TestSuite, TAPPlugin, and ToFile classes.

import matlab.unittest.TestRunner

import matlab.unittest.TestSuite

import matlab.unittest.plugins.TAPPlugin

import matlab.unittest.plugins.ToFile

4. Create the test suite object.

suite = testsuite(fullfile(matlabroot,'examples','simulinktest',...

    'f14ParameterSweepTest.mldatx'))
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suite = 

  1×25 Test array with properties:

    Name

    BaseFolder

    Parameterization

    SharedTestFixtures

    Tags

Tests Include:

   25 Unique Parameterizations, 0 Shared Test Fixture Classes, 0 Tags.

5. Create the test runner object, and set it to display output to the command window.

f14runner = TestRunner.withTextOutput;

6. Create a TAP plugin that sends output to the file F14TapOutput.tap.

tapFile = 'F14TapOutput.tap';

plugin = TAPPlugin.producingVersion13(ToFile(tapFile));

7. Add the plugin to the test runner.

addPlugin(f14runner,plugin)

8. Run the test. The test fails several iterations in which the delta between the signal
output and the baseline exceeds the tolerance.

result = run(f14runner,suite);

Running f14ParameterSweepTest > New Test Suite 1

..........

........

================================================================================

Verification failed in f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration19).

    ---------------------

    Framework Diagnostic:

    ---------------------

    Failed criteria: Baseline

    --> Logs:

            Inputs may not be compatible for simulation. Test results might not be accurate. Click <a href="matlab:stm.internal.util.launchHelp('sltest_external_inputs_help')">here</a> for more information on external input mapping.

================================================================================

..
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...

================================================================================

Verification failed in f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration24).

    ---------------------

    Framework Diagnostic:

    ---------------------

    Failed criteria: Baseline

    --> Logs:

            Inputs may not be compatible for simulation. Test results might not be accurate. Click <a href="matlab:stm.internal.util.launchHelp('sltest_external_inputs_help')">here</a> for more information on external input mapping.

================================================================================

.

================================================================================

Verification failed in f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration25).

    ---------------------

    Framework Diagnostic:

    ---------------------

    Failed criteria: Baseline

    --> Logs:

            Inputs may not be compatible for simulation. Test results might not be accurate. Click <a href="matlab:stm.internal.util.launchHelp('sltest_external_inputs_help')">here</a> for more information on external input mapping.

================================================================================

.

Done f14ParameterSweepTest > New Test Suite 1

__________

Failure Summary:

     Name                                                                                                         Failed  Incomplete  Reason(s)

    ==========================================================================================================================================================

     f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration19)    X                 Failed by verification.

    ----------------------------------------------------------------------------------------------------------------------------------------------------------

     f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration24)    X                 Failed by verification.

    ----------------------------------------------------------------------------------------------------------------------------------------------------------

     f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration25)    X                 Failed by verification.

    

9. Display the results from the TAP file.

disp(fileread(tapFile))

TAP version 13

1..25

ok 1 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration1)

ok 2 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration2)
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ok 3 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration3)

ok 4 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration4)

ok 5 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration5)

ok 6 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration6)

ok 7 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration7)

ok 8 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration8)

ok 9 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration9)

ok 10 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration10)

ok 11 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration11)

ok 12 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration12)

ok 13 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration13)

ok 14 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration14)

ok 15 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration15)

ok 16 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration16)

ok 17 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration17)

ok 18 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration18)

not ok 19 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration19)

    ---

    Event:

        Event Name: 'VerificationFailed'

        Scope: 'f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration19)'

        Framework Diagnostic: |

            Failed criteria: Baseline

            --> Logs:

                    Inputs may not be compatible for simulation. Test results might not be accurate. Click <a href="matlab:stm.internal.util.launchHelp('sltest_external_inputs_help')">here</a> for more information on external input mapping.

    ...

ok 20 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration20)

ok 21 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration21)

ok 22 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration22)

ok 23 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration23)

not ok 24 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration24)

    ---

    Event:

        Event Name: 'VerificationFailed'

        Scope: 'f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration24)'

        Framework Diagnostic: |

            Failed criteria: Baseline

            --> Logs:

                    Inputs may not be compatible for simulation. Test results might not be accurate. Click <a href="matlab:stm.internal.util.launchHelp('sltest_external_inputs_help')">here</a> for more information on external input mapping.

    ...

not ok 25 - f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration25)

    ---

    Event:

        Event Name: 'VerificationFailed'
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        Scope: 'f14ParameterSweepTest > New Test Suite 1/Iterations Parameter Sweep(ScriptedIteration=Scripted_Iteration25)'

        Framework Diagnostic: |

            Failed criteria: Baseline

            --> Logs:

                    Inputs may not be compatible for simulation. Test results might not be accurate. Click <a href="matlab:stm.internal.util.launchHelp('sltest_external_inputs_help')">here</a> for more information on external input mapping.

    ...

sltest.testmanager.clearResults

sltest.testmanager.clear

sltest.testmanager.close

close_system('sltestF14ParameterSweep',0)

See Also
matlab.unittest.plugins.TAPPlugin | Test | TestResult | TestRunner | TestSuite

Related Examples
• “Run Tests for Various Workflows”
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Filter Test Execution and Results

In this section...

“Add Tags” on page 6-83
“Filter Tests and Results” on page 6-83
“Run Filtered Tests” on page 6-83

You can run a subset of tests or view a subset of test results by filtering test tags. Tags
are a property of the test case, test suite, or test file.

Add Tags

Add comma-separated tags to the Tags section in the Test Browser. Tags cannot contain
spaces; spaces are corrected to commas.

Filter Tests and Results

In the text box at the top of the Test Browser or Results and Artifacts pane, filter
tests by entering tag: id1, id2, ... where id1 and id2 are example test tags.
Entering multiple tags returns tests that contain any of the tags.

Run Filtered Tests

To run a subset of tests
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1 Filter the tests using tags.
2 In the toolstrip, click the down arrow below Run and select Run Filtered.
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• “View Test Case Results” on page 7-2
• “Export Test Results and Generate Reports” on page 7-9
• “Customize Generated Reports” on page 7-14
• “Results Sections” on page 7-20
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View Test Case Results

In this section...

“View Results Summary” on page 7-2
“Visualize Test Case Simulation Output and Criteria” on page 7-4

After a test case has finished running in the Test Manager, the test case result becomes
available in the Results and Artifacts pane. Test results are organized in the same
hierarchy as the test file, test suite, and test cases that were run from the Test Browser
pane. In addition, the Results and Artifacts pane shows the criteria results and
simulation output, if applicable to the test case.

View Results Summary

The test case results tab gives a high-level summary and other information about an
individual test case result. To open the test case results tab:

1 Select the Results and Artifacts pane.

2 Double-click a test case result.
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A tab opens containing the test case results information.
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Visualize Test Case Simulation Output and Criteria

You can view signal data from simulation output or comparisons of signal data used in
baseline or equivalence criteria.

To view simulation output from a test case:
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1 Select the Results and Artifacts pane.
2 Expand the Sim Output section of the test case result.
3 Select the check box of signals you want to plot.

The Visualize tab appears and plots the signals.
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To view equivalence or baseline criteria comparisons:

1 Select the Results and Artifacts pane.
2 Expand the Baseline Criteria Result or Equivalence Criteria Result section of

the test case result.
3 Select the option button of the signal comparison you want to plot.
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The Comparison tab appears and plots the signal comparison.
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To see an example of creating a test case and viewing the results, see “Test Model Output
Against a Baseline” on page 6-9.
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Export Test Results and Generate Reports

In this section...

“Export Results” on page 7-9
“Create a Test Results Report” on page 7-10
“Generate Reports Using Templates” on page 7-10

Once you have run test cases and generated test results, you can export results and
generate reports. Test case results appear in the Results and Artifacts pane.

Export Results

Test results are saved separately from the test file. To save results, select the result in
the Results and Artifacts pane, and click Export on the toolstrip.

• Select complete result sets to export to a MATLAB data export file (.mldatx).

• Select criteria comparisons or simulation output to export signal data to the base
workspace or to a MAT-file.
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Create a Test Results Report

Result reports contain report overview information, the test environment, results
summaries with test outcomes, comparison criteria plots, and simulation output plots.
You can customize what information is included in the report, and it can be saved in
three different file formats: ZIP (HTML), DOCX, and PDF.

To generate a report:

1 Select the Results and Artifacts pane.
2 Select results for a test file, test suite, or test case in the Results and Artifacts

pane.

Note: You can create a report from multiple result sets, but you cannot create a
report from multiple test files, test suites, or test cases within results sets.

3 From the toolstrip, click Report.
4 Choose the options of what to include in the report.
5 Select the report File Format.
6 Click Create.

Generate Reports Using Templates

Microsoft Word Format

If you have a MATLAB Report Generator™ license, you can create reports from a
Microsoft Word template. The report can be a Microsoft Word or PDF document.

The report generator in Simulink Test fills information into rich text content controls
in your Microsoft Word template document. For more information on how to use rich
text content controls or customize part templates, see the MATLAB Report Generator
documentation, such as “Add Holes in a Microsoft Word Template”.

For a sample template, go to the path:

cd(matlabroot);

cd('help\toolbox\sltest\examples');

In the examples folder, open the file Template.dotx.
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In the Microsoft Word template, you can add rich text content controls. Each Simulink
Test report section can be inserted into the rich text content controls. The control names
are:

• ChapterTitle — report title
• ChapterTestPlatform — version of MATLAB used to execute tests
• ChapterTOC — test results table of contents
• ChapterBody — test results

For example, the chapter title rich text content control appears in the Microsoft Word
template as:

To change the control name, right-click the rich text content control and select
Properties. Specify the control name, ChapterTitle or any other name, in the Title
and Tag field.
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To generate a report from the Test Manager using a Microsoft Word template:

1 In the Test Manager, select the Results and Artifacts pane.
2 Select results for a test file, test suite, or test case in the Results and Artifacts

pane.
3 From the toolstrip, click Report.
4 Select the report options.
5 Select DOCX or PDF for the File Format.
6 Specify the full path and file name of your Microsoft Word template.
7 Click Create.

PDF or HTML Formats

If you have a MATLAB Report Generator license, you can create reports from a PDF
or HTML template, using a PDFTX or HTMTX file. To generate a report from the Test
Manager using a PDF or HTML template:
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1 In the Test Manager, select the Results and Artifacts pane.
2 Select results for a test file, test suite, or test case in the Results and Artifacts

pane.
3 From the toolstrip, click Report.
4 Select the report options.
5 Select ZIP or PDF for the File Format. Selecting ZIP generates an HTML report.
6 Specify the full path and file name of your template. For PDF, use a PDFTX file. For

HTML, use an HTMTX file. For more information on creating templates, see “Create
Report Templates”.

7 Click Create.
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Customize Generated Reports

In this section...

“Inherit the Report Class” on page 7-14
“Method Hierarchy” on page 7-14
“Modify the Class” on page 7-16
“Generate a Report Using the Custom Class” on page 7-18

You can choose how to format and aggregate test results by customizing reports. Use
the sltest.testmanager.TestResultReport class to create a subclass and then use the
properties and methods to customize how the Test Manager generates the results report.
You can change font styles, add plots, organize results into tables, include model images,
and more. Using the custom class, requires a MATLAB Report Generator license.

Inherit the Report Class

To customize the generated report, you must inherit from the
sltest.testmanager.TestResultReport class. After you inherit from the class, you can
modify the properties and methods. To inherit the class, add the class definition section
to a new or existing MATLAB script. The subclass is your custom class name, and
the superclass that you inherit from is sltest.testmanager.TestResultReport.
For more information about creating subclasses, see “Define Subclasses — Syntax
and Techniques”. Then, add code to the inherited class or methods to create your
customizations.

% class definition

classdef CustomReport < sltest.testmanager.TestResultReport

    %

    % Report customization code here

    %

end

Method Hierarchy

When you create the subclass, the derived class inherits methods from the
sltest.testmanager.TestResultReport class. The body of the report is separated
into three main groups: the result set block, the test suite result block, and the test case
result block.

7-14



 Customize Generated Reports

The result set block contains the result set table, the coverage table, and links to the
table of contents.

The test suite result block contains the test suite results table, the coverage table,
requirements links, and links to the table of contents.

The test case result block contains the test case and test iterations results table, the
coverage table, requirements links, signal output plots, comparison plots, test case
settings, and links to the table of contents.
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Modify the Class

To insert your own report content or change the layout of the generated report, modify
the inherited class methods. For general information about modifying methods, see
“Modify Superclass Methods”.

A simple modification to the generated report could be to add some text to the title page.
The method used here is addTitlePage.

% class definition

classdef CustomReport < sltest.testmanager.TestResultReport

    methods

        function this = CustomReport(resultObjects, reportFilePath)

            this@sltest.testmanager.TestResultReport(resultObjects, reportFilePath);

        end

    end

    

    methods(Access=protected)

        function addTitlePage(obj)

            import mlreportgen.dom.*;

            

            % Add a custom message

            label = Text('Some custom content can be added here');

            append(obj.TitlePart,label);

            

            % Call the superclass method to get the default behavior

            addTitlePage@sltest.testmanager.TestResultReport(obj);

        end

    end

end

Click here for a code file of this example.

A more complex modification of the generated report is to include a snapshot of the model
that was tested.

% class definition

classdef CustomReport < sltest.testmanager.TestResultReport

    methods

        function this = CustomReport(resultObjects,reportFilePath)

            this@sltest.testmanager.TestResultReport(resultObjects,reportFilePath);

        end

    end

    

    methods(Access=protected)
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        % Method to customize test case/iteration result section in the report

        function docPart = genTestCaseResultBlock(obj,result)

            % result: A structure containing test case or iteration result

            import mlreportgen.dom.*;

            

            % Call the superclass method to get the default behavior

            docPart = genTestCaseResultBlock@sltest.testmanager.TestResultReport(...

                                                                      obj,result);

            

            % Get the test case result data for putting in the report

            tcrObj = result.Data;

            

            % Insert model screenshot at the test case result level

            if isa(tcrObj, 'sltest.testmanager.TestCaseResult')

                

                % Initialize model name

                modelName = '';

                

                % Check in the test case result if it has model information. If

                % not, it means there were iterations in the test case or there

                % was no model used

                testSimMetaData = tcrObj.SimulationMetaData;

                

                if (~isempty(testSimMetaData))

                    modelName = testSimMetaData.modelName;

                end

                

                % Get all iteration results

                iterResults = getIterationResults(tcrObj);

                

                % Get the model name in case test case had iterations

                if (~isempty(iterResults))

                    modelName = iterResults(1).SimulationMetaData.modelName;

                end

                

                % Insert model snapshot. This will not work for harnesses. With

                % minimal changes we can also open the harness used for

                % testing.

                if (~isempty(modelName))

                    try

                        open_system(modelName);

                        snapObj = SLPrint.Snapshot;

                        snapObj.Target = modelName;

                        snapObj.Format = 'png';
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                        snapObj.FileName = fullfile(tempdir,modelName);

                        if exist(snapObj.FileName, 'file')

                            delete( snapObj.FileName );

                        end

                        snapObj.snap;

                        outputFileName = snapObj.FileName;

                        outputFileName =  [outputFileName '.png'];

                        para = sltest.testmanager.ReportUtility.genImageParagraph(...

                            outputFileName,...

                            '5.2in','3.7in');

                        append(docPart,para);

                    catch

                    end

                end

            end

        end

    end

end

Click here for a code file of this example.

Generate a Report Using the Custom Class

After you customize the class and methods, use the sltest.testmanager.report to
generate the report. You must use the 'CustomReportClass' name-value pair for the
custom class, specified as a string. For example:

% Generate the result set from imported data

result = sltest.testmanager.importResults('demoResults.mldatx');

% Specify the report file name and path

filePath = 'testreport.zip';

% Generate the report using the custom class

sltest.testmanager.report(result,filePath, ...

            'Author','MathWorks',...

            'Title','Test',...

            'IncludeMLVersion',true,...

            'IncludeTestResults',int32(0),...

            'CustomReportClass', 'CustomReport',...

            'LaunchReport', true);

Alternatively, you can create your custom report using the Test Manager report dialog
box. Select a test result, click the Report button on the toolstrip, and specify the custom
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report class in the Create Test Result Report dialog box. For the Test Manager to be able
to use the custom report class, the class must be on the MATLAB path.

See Also
sltest.testmanager.TestResultReport | sltest.testmanager.report

Related Examples
• “Define Subclasses — Syntax and Techniques”

7-19



7 Test Manager Results and Reports

Results Sections

In this section...

“Summary” on page 7-21
“Test Requirements” on page 7-21
“Iteration Settings” on page 7-22
“Errors” on page 7-22
“Logs” on page 7-22
“Description” on page 7-22
“Parameter Overrides” on page 7-22
“Coverage Results” on page 7-22

Double-click a test case results in the Results and Artifacts pane to open a results
tab and view all the test case result sections. A baseline test case result is shown as an
example.
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Summary

The Summary section includes the basic test information and the test outcome. For
more information about the simulation, toggle the Simulation Metadata arrow to expand
the section.

Test Requirements

A list of any test requirements linked to the test case. See “Requirements” on page 6-54
for more information on linking requirements to test cases.
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Iteration Settings

If you are using iterations to run test cases, then this section appears in the results. For
more information about test iterations, see “Run Multiple Combinations of Tests Using
Iterations” on page 6-33.

Errors

This section displays simulation errors captured from the Simulink Diagnostic Viewer.
Errors from incorrect information defined in the test case and callback scripts are also
shown here.

Logs

This section displays simulation warnings captured from the Simulink Diagnostic
Viewer.

Description

You can include any notes about the test results here. These notes are saved with the
results.

Parameter Overrides

A list of any parameter overrides specified in the test case under Parameter Overrides.
If there are no parameter overrides specified, then this section is not shown in the results
summary.

Coverage Results

If you collect coverage in your test, then the coverage results appear in this section.
Coverage results are aggregated at the test file, test suite, and test file level. For more
information about coverage, see “Collect Coverage in Tests” on page 6-41.
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Test Models in Real Time

In this section...

“Overall Workflow” on page 8-2
“Real-Time Testing Considerations” on page 8-3
“Complete Basic Model Testing” on page 8-3
“Set up the Target Computer” on page 8-3
“Configure the Model or Test Harness” on page 8-4
“Add Test Cases for Real-Time Testing” on page 8-6
“Assess Real-Time Execution Using verify Statements” on page 8-11

You can test your system in environments that resemble your application. You begin
with model simulation on a development computer, then use software-in-the-loop (SIL)
and processor-in-the-loop (PIL) simulations. Real-time testing executes an application
on a standalone target computer that can connect to a physical system. Real-time
testing can include effects of timing, signal interfaces, system response, and production
hardware.

Real-time testing includes:

• Rapid prototyping, which tests a system on a standalone target connected to plant
hardware. You verify the real-time tests against requirements and model results.
Using rapid prototyping results, you can change your model and update your
requirements, after which you retest on the standalone target.

• Hardware-in-the-loop (HIL), which tests a system that has passed several stages of
verification, typically SIL and PIL simulations.

Overall Workflow

This example workflow describes the major steps of creating and executing a real-time
test:

1 Create test cases that verify the model against requirements. Run the model
simulation tests and save the baseline data.

2 Set up the real-time target computer.
3 Create test harnesses for real-time testing, or reuse model simulation test harnesses.

In Test Sequence or Test Assessment blocks, verify statements assess the real-time
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execution. In the test harnesses, use target and host scopes to display signals during
execution.

4 In the Test Manager, create real-time test cases.
5 For the real-time test cases, configure target settings, inputs, callbacks, and

iterations. Add baseline or equivalence criteria.
6 Execute the real-time tests.
7 Analyze the results in the Test Manager. Report the results.

Real-Time Testing Considerations

• If real-time test data returned from the target computer is shifted in time or is
missing data points, baseline or equivalence results can consequently display a test
failure. When investigating real-time test failures, look for time shifts or missing data
points.

• You cannot override the real-time execution sample time for applications built from
models containing a Test Sequence block. The code generated for the Test Sequence
block contains a hard-coded sample time. Overriding the target computer sample time
can produce unexpected results.

• Your target computer must have a file system to use verify statements and test case
logging.

Complete Basic Model Testing

Real-time testing often takes longer than comparative model testing, especially if you
execute a suite of real-time tests that cover several scenarios. Before executing real-time
tests, complete requirements-based testing using desktop simulation. Using the desktop
simulation results:

• Debug your model or make design changes that meet requirements.
• Debug your test sequence. Use the debugging features in the test sequence editor. See

“Debug a Test Sequence” on page 3-44.
• Update your requirements and add corresponding test cases.

Set up the Target Computer

Real-time testing requires a standalone target computer. Simulink Test only supports
target computers running Simulink Real-Time™. For more information, see:
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• “Setup and Configuration”
• “Troubleshooting in Simulink Real-Time”

Configure the Model or Test Harness

Real-time applications require specific configuration parameters and signal properties.

Code Generation

A real-time test case requires a real-time system target file. In the model or harness
configuration parameters, in the Code Generation pane, set the System target file to:

• slrt.tlc to generate system target code.
• slrtert.tlc to generate system target code using Embedded Coder.

If your model requires a different system target file, you can set the parameter using
a test case or test suite callback. After the real-time test executes, set the parameter
to its original setting with a cleanup callback. For example, this callback opens
the model and sets the system target file parameter to slrt.tlc for the model
sltestProjectorController.

open_system(fullfile(matlabroot,'toolbox','simulinktest',...

'simulinktestdemos','sltestProjectorController'));

set_param('sltestProjectorController','SystemTargetFile','slrt.tlc');

Data Import/Export Format

Models must use a data format other than dataset. To set the data format:

1 Open the configuration parameters.
2 Select the All Parameters tab and the Data Import/Export pane.
3 Select the Format.

Log Signals from Real-Time Execution

To configure your signals of interest for real-time testing:

• Enable signal logging in the Configuration Parameters, in the Data Import/Export
pane.
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• Connect signals to Scope blocks from the Simulink Real-Time block library. Set the
Scope type property to File.

• Name each signal of interest using the signal properties.

Signal naming is particularly important if you perform baseline or equivalence testing,
because unnamed signals can be assigned a default name, which likely does not match
the name of the baseline or equivalence signal. This test harness demonstrates four
signals configured for real-time testing, using file scopes to return signal data to the Test
Manager, and target scopes to display data on the target computer during execution.

View Signals During Real-Time Execution

To display signals on the target computer during real-time execution, add target scopes
to your test harness. To display signals in the Simulink Real-Time Explorer, add host
scopes. This test harness includes both target and host scopes for signal visualization.
See Scope.
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Add Test Cases for Real-Time Testing

Use the Test Manager to create real-time test cases. In the toolstrip, click New > Real-
Time Test.

Test Type

You can select a baseline, equivalence, or simulation real-time test. For simulation test
types, verify statements serve as pass/fail criteria in the test results. For equivalence
and baseline test types, the equivalence or baseline criteria also serve as pass/fail
criteria.

• Baseline — Compares the signal data returned from the target computer to
the baseline in the test case. To compare a real-time execution result to a model
simulation result, add the model baseline result to the real-time test case and apply
optional tolerances to the signals.

• Equivalence — Compares signal data from a simulation and a real-time test, or two
real-time tests. To run a real-time test on the target computer, then compare results
to a model simulation:

• Select Simulation 1 on target.
• Clear Simulation 2 on target.
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The test case displays two simulation sections, Simulation 1 and Simulation 2.

Comparing two real-time tests is similar, except that you select both simulations on
target. In the Equivalence Criteria section, you can capture logged signals from the
simulation and apply tolerances for pass/fail analysis.

• Simulation: Assesses the test result using only verify statements and real-time
execution. If no verify statements fail, and the real-time test executes, the test case
passes.

Load Application From

Using this option, specify how you want to load the real-time application. The real-
time application is a DLM file built from your model or test harness. You can load the
application from:

• Model — Choose Model if you are running the real-time test for the first time, or
your model changed since the last real-time execution. Model typically takes the
longest because it includes model build and download. Model loads the application
from the model, builds the real-time application, downloads it to the target computer,
and executes it on the target computer.

• Target Application — Choose Target Application to send the target
application from the host to a target computer, and execute the application. Target
Application can be useful if you want to load an already-built application on
multiple targets.

• Target Computer — This option executes an application that is already loaded on
the real-time target computer. You can update the parameters in the test case and
execute using Target Computer.

This table summarizes which steps and callbacks execute for each option.

Load Application FromTest Case Execution
Step (first to last) Model Target Application Target Computer

Executes pre-load
callback

Yes Yes Yes

Loads Simulink
model

Yes No No

Executes post-load
callback

Yes No No
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Load Application FromTest Case Execution
Step (first to last) Model Target Application Target Computer

Sets Signal Builder
group

Yes No No

Builds DLM from
model

Yes No No

Downloads DLM to
target computer

Yes Yes No

Sets runtime
parameters

Yes Yes Yes

Executes pre-start
real-time callback

Yes Yes Yes

Executes real-time
application

Yes Yes Yes

Executes cleanup
callback

Yes Yes Yes

Model

Select the model from which to generate the real-time application.

Test Harness

If you use a test harness to generate the real-time application, select the test harness.

Simulation Settings Overrides

For real-time tests, you can override the simulation stop time, which can be useful in
debugging a real-time test failure. Consider a 60-second test that returns a verify
statement failure at 15 seconds due to a bug in the model. After debugging your model,
you execute the real-time test to verify the fix. You can override the stop time to
terminate the execution at 20 seconds, which reduces the time it takes to verify the fix.

Callbacks

Real-time tests offer a Pre-start real-time application callback which executes
commands just before the application executes on the target computer. Real-time test
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callbacks execute in a sequence along with the model load, build, download, and execute
steps. Callbacks and step execution depends on how the test case loads the application.

Sequence
Load application from:

Model

Load application from:

Target application

Load application from:

Target computer

Executes first Preload callback Preload callback Preload callback
  Post-load callback — —
  Pre-start real-time

callback
Pre-start real-time
callback

Pre-start real-time
callback

Executes last Cleanup callback Cleanup callback Cleanup callback

Iterations

You can execute iterations in real-time tests. Iterations are convenient for executing real-
time tests that sweep through parameter values or Signal Builder groups. Results appear
grouped by iteration. For more information on setting up iterations, see “Run Multiple
Combinations of Tests Using Iterations” on page 6-33. You can create:

• Tabled iterations from a parameter set — Define several parameter sets in the
Parameter Overrides section of the test case. Under Iterations > Table
Iterations, click Auto Generate and select Parameter Set.

• Tabled iterations from signal builder groups — If your model or test harness uses a
signal builder input, under Iterations > Table Iterations, click Auto Generate
and select Signal Builder Group. If you use a signal builder group, load the
application from the model.

• Scripted iterations — Use scripts to iterate using model variables or parameters.
For example, in the model sltestRealTimeOscillatorTestExample, the
SettlingTest harness uses a Test Sequence block to create a square wave test
signal for the oscillator system using the parameter frequency.
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In the test file SettlingTestCases, the real-time test scripted iterations cover a
frequency sweep from 5 Hz to 35 Hz. The script iterates the value of frequency in
the Test Sequence block.

%% Iterate over frequencies to determine best oscillator settings

% Create parameter sets

freq = 5.0:1.0:35.0;

for i_iter = 1:length(freq)

    % Create iteration object

    testItr = sltestiteration();

    

    % Set parameters

    setVariable(testItr,'Name','frequency','Source','Test Sequence',...

    'Value',freq(i_iter));

    

    % Register iteration

    addIteration(sltest_testCase, testItr);

end

Assess Real-Time Execution Using verify Statements

In addition to baseline and equivalence signal comparisons, you can assess real-time test
execution using verify statements. A verify statement assesses a logical expression
and returns results to the Test Manager. Use verify inside a Test Sequence or Test
Assessment block. See “Assess Simulation Using Logical Statements” on page 3-25.
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Related Examples
• “Test Real-Time Application”
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Verification and Validation

• “Test Model Against Requirements and Report Results” on page 9-2
• “Analyze a Model for Standards Compliance and Design Errors” on page 9-6
• “Perform Functional Testing and Analyze Test Coverage” on page 9-9
• “Analyze Code and Test Software-in-the-Loop” on page 9-16
• “Module Verification and Testing Processor-in-the-Loop” on page 9-25
• “Test a Model in Real Time” on page 9-26



9 Verification and Validation

Test Model Against Requirements and Report Results

Requirements Overview

Requirements are the basis for your system architecture, algorithm, and test plan.
Traceability between requirements documents, model, code, and tests helps you
document relationships, manage design changes, and interpret test results. Required
model properties and test objectives enable targeted design analysis and test case
generation for specific scenarios. You can evaluate your design and identify incomplete
or missing requirements with ad-hoc testing, using simulated user interfaces for your
model. Also, you can use rapid prototyping to validate requirements, and connect to
physical or simulated environments to test your algorithm. Update the design, adding
requirements and requirements links as necessary.

Test a Cruise Control Safety Requirement

This example shows a requirements-based testing workflow for a cruise control model.
You start with a model that has traceability to an external requirements document.
You add a test to evaluate two safety requirements, checking that the cruise control
disengages when the system reaches certain conditions. You add traceability to this test,
run the test, and report the results.

1 Create a copy of the project in a working folder. Enter

slVerificationCruiseStart
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2 Open the model and the test harness. On the command line, enter

open_system simulinkCruiseAddReqExample

sltest.harness.open('simulinkCruiseAddReqExample','SafetyTest_Harness1')

3 Open the Test Sequence block.

• The BrakeTest sequence tests that the system disengages when the brake pedal
is pressed. It includes a verify statement

verify(engaged == false,...

    'verify:brake',...

    'system must disengage when brake applied')

• The LimitTest sequence tests that the system disengages when the speed
exceeds a limit. It includes a verify statement

verify(engaged == false,...

    'verify:limit',...

    'system must disengage when limit exceeded')

4 Open the requirements document. In the Simulink Project window, expand the
documents folder and open simulinkCruiseChartReqs.docx.

5 Add links between the test steps and the requirements document.

1 In the requirements document, highlight item 3.1, “Vehicle braking will
transition system to disengaged (inactive) when engaged (active)”

2 With item 3.1 highlighted, in the test sequence, right-click the BrakeTest step.
Select Requirements traceability > Link to Selection in Word.

3 In the requirements document, highlight item 3.4, “Transition to disengaged
(inactive) when vehicle speed is outside the limits of 20 mph to 90 mph”

4 With item 3.4 highlighted, in the test sequence, right-click the LimitTest step.
Select Requirements traceability > Link to Selection in Word.

5 Save the requirements document and the model.
6 Create a test case in the Test Manager, and link the test case to the requirements

section.

1 Open the Test Manager. In the Simulink menu, select Analysis > Test
Manager.

2 In the Test Manager toolstrip, click New > Test File. Select the tests folder in
the project, and enter a name for the test file. Click Save.

A new baseline test is created.

9-3



9 Verification and Validation

3 Under System Under Test, in the Model field, click the button  to use the
current model. The field displays the model name.

4 Expand the Test Harness section. From the drop-down menu, select the test
harness name.

5 In the requirements document, highlight section 3.1.
6 In the test case, expand the Requirements section. Click the arrow next to the

Add button and select Link to Selection in Word.
7 Use the same process to link the test case to section 3.4 in the requirements

document.
7 Highlight the test case. In the Test Manager toolstrip, click Run.
8 When the test finishes, expand the Verify Statements results. The results

show that both assessments pass, and the plot shows the detailed results of each
statement.

9 Create a report using a custom Microsoft Word template.

1 In the Test Manager, right-click the test case name. Select Results: > Create
Report.

2 In the Create Test Result Report dialog box, set the options:

• Title: SafetyTest
• Results for: All Tests
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• File Format: DOCX
• For the other options, keep the default selections.

3 For the Template File, select the ReportTemplate.dotx file in the
documents project folder.

4 Enter a file name and select a location for the report.
5 Click Create.

10 Review the report.

1 In the Test Case Requirements section, click the link to trace to the
requirements document.

2 The Verify Result section contains details of the two assessments in the test,
and links to the simulation output.

Related Examples
• “Link to Requirements Modeled in Simulink”
• “Link Tests to Requirements” on page 1-2
• “Validate Requirements Links in a Model”
• “Create Requirements Traceability Report for Model”
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Analyze a Model for Standards Compliance and Design Errors

Standards and Analysis Overview

During model development, check and analyze your model to increase confidence in
its quality. Check your model against standards such as MAAB style guidelines and
high-integrity system design guidelines such as DO-178 and ISO 26262. Analyze your
model for errors, dead logic, and conditions that violate required properties. Using the
analysis results, update your model and document exceptions. Report the results using
customizable templates.

Check Model for Style Guideline Violations and Design Errors

This example shows how to use the Model Advisor to check a cruise control model for
MathWorks® Automotive Advisory Board (MAAB) style guideline violations and design
errors. Select checks and run the analysis on the model. Iteratively debug issues using
the Model Advisor and rerun checks to verify that it is in compliance. After passing your
selected checks, report results.

Check Model for MAAB Style Guideline Violations

In Model Advisor, you can check that your model complies with MAAB modeling
guidelines.
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1 Create a copy of the project in a working folder. On the command line, enter

slVerificationCruiseStart

2 Open the model. On the command line, enter

open_system simulinkCruiseErrorAndStandardsExample

3 In the model window, select Analysis > Model Advisor > Model Advisor.
4 Click OK to choose simulinkCruiseErrorAndStandardsExample from the

System Hierarchy.
5 Check your model for MAAB style guideline violations using Simulink Verification

and Validation.

a In the left pane, in the By Product > Simulink Verification and Validation
> Modeling Standards > MathWorks Automotive Advisory Board Checks
folder, select:

• Check for indexing in blocks
• Check for prohibited blocks in discrete controllers
• Check model diagnostic parameters

b Right-click the MathWorks Automotive Advisory Board Checks node, and
then select Run Selected Checks.

c Click Check model diagnostic parameters to review the configuration
parameter settings that violate MAAB style guidelines.

d In the right pane, click the parameter links to update the values in the
Configuration Parameters dialog box.

e To verify that your model passes, rerun the check. Repeat steps c and d, if
necessary, to reach compliance.

f To generate a results report of the Simulink Verification and Validation checks,
select the MathWorks Automotive Advisory Board Checks node, and then,
in the right pane click Generate Report....

Check Model for Design Errors

While in Model Advisor, you can also check your model for hidden design errors using
Simulink Design Verifier.

1 In the left pane, in the By Product > Simulink Design Verifier folder, select
Design Error Detection.
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2 In the right pane, click Run Selected Checks.
3 After the analysis is complete, expand the Design Error Detection folder, then

select checks to review warnings or errors.
4 In the right pane, click Simulink Design Verifier Results Summary. The dialog

box provides tools to help you diagnose errors and warnings in your model.

a Review the results on the model. Click Highlight analysis results on model.
Click the Compute target speed subsystem, outlined in red. The Simulink
Design Verifier Results Inspector window provides derived ranges that can help
you understand the source of an error by identifying the possible signal values.

b Review the harness model. The Simulink Design Verifier Results Inspector
window displays information that an overflow error occurred. To see the test
cases that demonstrate the errors, click View test case.

c Review the analysis report. In the Simulink Design Verifier Results Inspector
window, click Back to summary. To see a detailed analysis report, click HTML
or PDF.

Related Examples
• “Check for Compliance in Model and Subsystems”
• “Run Checks for Model Metrics”
• “Run a Design Error Detection Analysis”
• “Prove Properties in a Model”
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Perform Functional Testing and Analyze Test Coverage

Functional Testing and Coverage Analysis Overview

Functional testing starts with building test cases based on requirements. These tests
can cover key aspects of your design and verify that individual model components meet
requirements. Test cases include inputs, expected outputs, and acceptance criteria.

By collecting individual test cases within test suites, you can run functional tests
systematically. To check for regression, add baseline criteria to the test cases and test
the model regularly. Coverage measurement reflects the extent to which these tests
have fully exercised the model. Coverage measurement also helps you to add tests and
requirements to meet coverage targets.

Incrementally Increase Test Coverage Using Test Case Generation

This example shows a functional testing-based testing workflow for a cruise control
model. You start with a model that has tests linked to an external requirements
document, analyze the model for coverage in Simulink Verification and Validation,
incrementally increase coverage with Simulink Design Verifier, and report the results.
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Explore the Test Harness and the Model

1 Create a copy of the project in a working folder. At the command line, enter:

slVerificationCruiseStart

2 Open the model and the test harness. At the command line, enter:

open_system simulinkCruiseAddReqExample

sltest.harness.open('simulinkCruiseAddReqExample','SafetyTest_Harness1')

3 Load the test suite from “Test Model Against Requirements and Report Results” on
page 9-2. At the command line, enter:

open slReqTests.mldatx

4 Open the test sequence block. The sequence tests:

• That the system disengages when the brake pedal is pressed
• That the system disengages when the speed exceeds a limit

Some test sequence steps are linked to a requirements document
simulinkCruiseChartReqs.docx.

Measure Model Coverage and Save Coverage Results

1 In the test manager, enable coverage collection for the test case.

a Open the test manager. In the Simulink menu, click Analysis > Test Manager.
b In the Test Browser, click the slReqTests test file.
c Expand Coverage Settings.
d Under COVERAGE TO COLLECT, select Record coverage for referenced

models.
e Under COVERAGE METRICS, select Decision, Condition, and MCDC.
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2 Run the test. On the test manager toolstrip, click Run.
3 When the test finishes, in the Test Manager, navigate to the test case. The example

model achieves 50% decision coverage, 41% condition coverage, and 25% MCDC
coverage.

9-11



9 Verification and Validation

4 In the coverage results, right-click the simulinkCruiseAddReqExample row and
click Export

5 Select Export to CVT-file and export the coverage results to a folder in your
working folder.

Generate Tests to Increase Model Coverage

1 Generate additional tests for the referenced model. Specify that the analysis ignore
satisfied coverage data from the coverage results recorded in the previous steps.

a Open the simulinkCruiseAddReqExample model Configuration Parameters

.
b In the Design Verifier > Test Generation pane, select Ignore objectives

satisfied in existing coverage data
c Click Browse, select the Coverage data file that you exported in the previous

section, and click Open.

2 To apply the settings and close the Configuration Parameters dialog box, click OK.
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3 In the simulinkCruiseAddReqExample model, right-click the Compute target
speed subsystem and click Design Verifier > Generate Tests for Subsystem.
The test case generation is executed.

The Simulink Design Verifier Results Summary window opens with the test case
generation report.
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4 In the Simulink Design Verifier Results Summary window, click  Simulate tests
and produce a model coverage report.

The example model now achieves 89% decision coverage, 88% condition coverage,
and 88% MCDC coverage.

Export the Test Cases to the Test Manager

To export the test cases that Simulink Design Verifier generates into the Test Manager,
first close the existing Simulink Test test harness.

1 Close the SafetyTest_Harness1 test harness.
2 In the Simulink Design Verifier Results Summary window, click Export test cases

to Simulink Test.
3 Select the simulinkCruiseAddReqExample_sldvharness test harness and click

OK.
4 In the test manager, a new test file simulinkCruiseAddReqExample_test

appears. The test file contains a new test case that uses the inputs generated by
Simulink Design Verifier for model coverage.

5 Right-click the new test case in the simulinkCruiseAddReqExample_test test
file and select Copy.

6 In the original slReqTests test file, right-click the test suite and select Paste.
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The test suite in the slReqTests test file now contains the original test case and the
test cases generated by Simulink Design Verifier.

7 Run the test suite again. Highlight the slReqTests Test Suite 1 test suite. On
the test manager toolstrip, click Run.

The test results include coverage for the combined test case inputs.
8 Close the test harness and the model.

Related Examples
• “Link Tests to Requirements” on page 1-2
• “Assess Simulation Using Logical Statements” on page 3-25
• “Test Model Output Against a Baseline” on page 6-9
• “Highlight Functional Dependencies”
• “Generate Test Cases for Model Decision Coverage”
• “Extend Model Coverage of a Test Suite”
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Analyze Code and Test Software-in-the-Loop

Code Analysis and Testing Software-in-the-Loop Overview

Analyze code to detect errors, check standards compliance, and evaluate key metrics
such as length and cyclomatic complexity. Typically for handwritten code, you check
for run-time errors with static code analysis and run test cases that evaluate the code
against requirements and evaluate code coverage. Based on the results, refine the code
and add tests. For generated code, demonstrate that code execution produces equivalent
results to the model by using the same test cases and baseline results. Compare the code
coverage to the model coverage. Based on test results, add tests and modify the model to
regenerate code.

Analyze Code for Defects, Metrics, and MISRA C:2012

This workflow describes how to check if your model produces MISRA® C:2012 compliant
code and how to check your generated code for code metrics, code defects, and MISRA
compliance. To produce more MISRA compliant code from your model, you use the code
generation and model advisors. To check whether the code is MISRA compliant, you
use the Polyspace MISRA C:2012 checker and report generation capabilities. For this
example, you use the model simulinkCruiseErrorAndStandardsExample. To open
the model:

1 Open the Simulink project:

9-16



 Analyze Code and Test Software-in-the-Loop

slVerificationCruiseStart

2 From the Simulink project, open the model
simulinkCruiseErrorAndStandardsExample.

Run Code Generator Checks

Before you generate code from your model, there are steps that you can take to generate
code more compliant with MISRA C and more compatible with Polyspace. This example
shows how to use the Code Generation Advisor to check your model before generating
code.

1 Right-click Compute target speed and select C/C++ > Code Generation Advisor.
2 Select the Code Generation Advisor folder. Add the Polyspace objective. The MISRA

C:2012 guidelines objective is already selected.
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3 Click Run Selected Checks.

The Code Generation Advisor checks whether there are any blocks or configuration
settings that are not recommended for MISRA C:2012 compliance and Polyspace
code analysis. For this mode, the check for incompatible blocks passes, but there
are some configuration settings that are incompatible with MISRA compliance and
Polyspace checking.

4 Click on check that was not passed. Accept the parameter changes by selecting
Modify Parameters.

5 Rerun the check by selecting Run This Check.

For your own model, you might not want to use all the recommended configuration
settings. Using nonrecommended settings can generate less MISRA compliant code.
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Run Model Advisor Checks

Before you generate code from your model, there are steps you can take to generate code
more compliant with MISRA C and more compatible with Polyspace. This example shows
you how to use the Model Advisor to check your model further before generating code.

For more checking before generating code, you can also run the Modeling Guidelines for
MISRA C:2012.

1 At the bottom of the Code Generation Advisor window, select Model Advisor.
2 Under the By Task folder, select the Modeling Guidelines for MISRA C:2012

advisor checks.

3 Click Run Selected Checks and review the results.
4 If any of the tasks fail, make the suggested modifications and rerun the checks until

the MISRA modeling guidelines pass.
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For your own model, you might not want to use all the recommendations. Using
nonrecommended settings or blocks can generate less MISRA compliant code.

Generate and Analyze Code

After you have done the model compliance checking, you can now generate code. With
Polyspace, you can check your code for compliance with MISRA C:2012 and generate
reports to demonstrate compliance with MISRA C:2012.

1 In the Simulink editor, right-click Compute target speed and select C/C++ > Build
This Subsystem.

2 Use the default settings for the tunable parameters and select Build.
3 After the code is generated, right-click Compute target speed and select Polyspace

> Options.
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4 Click the Configure button. This option allows you to choose more advanced
Polyspace analysis options in the Polyspace configuration window.

5 On the same pane, select Calculate Code Metrics. This option turns on code metric
calculations for your generated code.

6 Save and close the Polyspace configuration window.
7 From your model, right-click Compute target speed and select Polyspace > Verify

Code Generated For > Selected Subsystem.

Polyspace Bug Finder analyzes the generated code for a subset of MISRA checks and
defect checks. You can see the progress of the analysis in the MATLAB Command
Window. Once the analysis is finished, the Polyspace environment opens.
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Review Results

After you run a Polyspace analysis of your generated code, the Polyspace environment
shows you the results of the static code analysis. There are 50 MISRA C:2012 coding rule
violations in your generated code.

1 Expand the tree for rule 8.7 and click through the different results.

Rule 8.7 states that functions and objects should not be global if the function or
object is local. As you click through the 8.7 violations, you can see that these results
refer to variables that other components also use, such as CruiseOnOff. You can
annotate your code or your model to justify every result. But, because this model is
a unit in a larger program, you can also change the configuration of the analysis to
check only a subset of MISRA rules.

2 In your model, right-click Compute target speed and select Polyspace > Options.
3 Set the Settings from option to Project configuration. This option allow you

to choose a subset of MISRA rules in the Polyspace configuration.
4 Click the Configure button.
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5 In the Polyspace Configuration window, on the Coding Rules & Code Metrics
pane, select the check box Check MISRA C:2012 and from the drop-down list, select
single-unit-rules. Now, Polyspace checks only the MISRA C:2012 rules that are
applicable to a single unit.

6 Save and close the Polyspace configuration window.
7 Rerun the analysis with the new configuration.

When the Polyspace environment reopens, there are no MISRA results, only code
metric results. The rules Polyspace showed previously were found because the model
was analyzed by itself. When you limited the rules Polyspace checked to the single-
unit subset, no violations were found.
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When this model is integrated with its parent model, you can add the rest of the MISRA
C:2012 rules.

Generate Report

To demonstrate compliance with MISRA C:2012 and report on your generated code
metrics, you must export your results. This section shows you how to generate a report
after the analysis. If you want to generate a report every time you run an analysis, see
Generate report.

1 If they are not open already, open your results in the Polyspace environment.
2 From the toolbar, select Reporting > Run Report.
3 Select BugFinderSummary as your report type.
4 Click Run Report.

The report is saved in the same folder as your results.
5 To open the report, select Reporting > Open Report.

Related Examples
• “Generate and Analyze Code”
• “Test Two Simulations for Equivalence”
• “Export Test Results and Generate Reports” on page 7-9
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Module Verification and Testing Processor-in-the-Loop

Module Verification and Testing Processor-in-the-Loop Overview

Module verification involves testing and analyzing code at a system level, integrating
generated code from your model, handwritten code, and legacy code. Module verification
often includes generating code that executes on a target object, rather than the desktop
environment. Analyze the code to resolve errors and evaluate key metrics. Test the
integrated system using new requirements-based tests and system-level tests from your
model. Collect coverage on these tests and add tests to meet coverage targets.

Related Examples
• “Test Two Simulations for Equivalence”
• “Generate and Analyze Code”
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Test a Model in Real Time

Real-Time Testing and Testing Production Models Overview

Real-time testing assesses the system while including the effects of timers, physical
signals, and target hardware. Sweep through parameter values on the target,
verify system operation during execution, and verify expected results in the desktop
environment. Systems that have been verified on target hardware often exist in a
change-controlled state. You can test these systems without modifying them by using
isolated simulation and analysis environments.

Related Examples
• “Create and Run Real-Time Application from Simulink Model”
• “Test Models in Real Time” on page 8-2
• “Assess Simulation Using Logical Statements” on page 3-25
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